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Chapter 1:
Installation and Configuration

Files and Directories
File Naming Conventions
The following file naming conventions have been adopted for the various files distributed with and used by Dyalog APL/W.
Extension

Description

.DWS

Dyalog APL Workspace

.DSE

Dyalog APL Session

.DCF1

Dyalog APL Component File

.DXV

Dyalog APL External Variable

.DIN

Dyalog APL Input Table

.DOT

Dyalog APL Output Table

.DFT

Dyalog APL Format File

.DXF

Dyalog APL Transfer File

.DLF

Dyalog APL Session Log File

.dyalog

Dyalog APL SALT file

.dyapp

Dyalog APL SALT application file

1Note that DCF has become associated with a certain type of media file and is recognised as such

by Windows.

1

Chapter 1: Installation and Configuration

Unicode and Classic Editions
Dyalog APL continues to be available in two separate editions; Unicode and
Classic.
l

l

The Unicode edition is intended for users who need to develop Unicode
applications now, and are prepared to make the necessary (usually small)
changes to existing applications in order to support new Unicode character
types.
The Classic edition is intended for customers who want to take advantage
of other product enhancements, but do not wish to use Unicode at this time.

The two different editions are maintained from the same source code, and every effort
will be made to ensure that they are identical except for the handling of character
arrays, and the transfer of data into and out of the workspace.

2
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APL Fonts
Unicode Edition
The default font for the Unicode Edition is APL385 Unicode1 which is a TrueType
font and is installed as part of Dyalog APL. APL385 Unicode is the font used to print
APL characters in this manual. In principle, you may use any other Unicode font that
includes the APL symbols, such as Arial Unicode MS (available from Microsoft).

Classic Edition
In the Classic Edition, there are two types of APL font provided; bitmap (screen) and
TrueType. There are also two different layouts, which referred to as Std and Alt.
The bitmap fonts are designed for the screen alone and are named Dyalog Std and
Dyalog Alt. The TrueType fonts have a traditional 2741-style italic appearance and
are named Dyalog Std TT and Dyalog Alt TT1 .
The Std layout, which was the standard layout for Versions of Dyalog APL up to Version 10.1 contains the APL underscored alphabet Ⓐ-Ⓩ. The underscored alphabet is
a deprecated feature and is only supported in this Version of Dyalog APL for backwards compatibility.
The Alt layout, which replaced the Std layout as the standard layout for Version 12.0
Classic Edition onwards, does not have the underscored alphabet, but contains additional National Language characters in their place. Note that the extra National Language symbols share the same ⎕AV positions with the underscored alphabet. If, for
example, you switch from the Std font layout to the alternative one, you will see the
symbol Á (A-acute) instead of the symbol Ⓐ (A-underscore).
You may use either a bitmap font or a TrueType font in your APL session (see "Session Operations " on page 124 for details). You MUST use a TrueType font for printing APL functions.

1The Dyalog Std TT, Dyalog Alt TT, and APL385 Unicode fonts are the copyright of

Adrian Smith.
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Interoperability
Introduction
Workspaces and component files are stored on disk in a binary format (illegible to
text editors). This format differs between machine architectures and among versions
of Dyalog. For example a file component written by a PC may well have an internal
format that is different from one written by a UNIX machine. Similarly, a workspace
saved from Dyalog Version 13.2 will differ internally from one saved by a previous
version of Dyalog APL.
It is convenient for versions of Dyalog APL running on different platforms to be able
to interoperate by sharing workspaces and component files. From Version 11.0, component files and workspaces can generally be shared between Dyalog interpreters running on different platforms. However, this is not always possible, for example:
l

l

Component files created by Version 10.1 can often not be shared across platforms, even when used by later versions.
Small-span (32-bit) component files become read-only when opened on a
different architecture from that on which they were created.

Note however that the system function ⎕FCOPY can be used to make a logically identical copy of an old file, which is fully inter-operable.
The following sections describe other limitations in inter-operability:

Code
Code which is saved in workspaces, or embedded within ⎕ORs stored in component
files, can generally only be read by the version which saved them and later versions
of the interpreter. In the case of workspaces, a load (or copy) into an older version
would fail with the message:
this WS requires a later version of the interpreter.
Every time a ⎕OR object is read by a Version later than that which created it, time
may be spent in converting the internal representation into the latest form. Dyalog
recommends that ⎕OR should not be used as a mechanism for sharing code or objects
between different versions of APL

"Ordinary" Arrays
With the exception of the Unicode restrictions described in the following paragraphs, Dyalog APL provides inter-operability for arrays which only contain
(nested) character and numeric data. Such arrays can be stored in component files - or
transmitted using TCPSocket objects and Conga connections, and shared between
all versions and across all platforms.
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As mentioned in the introduction, full cross-platform interoperability of component
files is only available for large-span component files (see the following section), and
for small-span component files created by Version 11.0 or later.

32 vs. 64-bit Component Files
Large-span (64-bit-addressing) component files are inaccessible to versions of the
interpreter that pre-dated their introduction (versions earlier than 10.1).
The second item in the right argument of ⎕FCREATE determines the addressing type
of the file.
'small'⎕fcreate 1 32 ⍝ create small-span file.
'large'⎕fcreate 1 64 ⍝ create large-span file.
If the second item is missing, the file type defaults to 64-bit-addressing. In versions
prior to 12.0, the default was 32-bit-addressing.
Note that small-span (32-bit-addressing) component files cannot contain Unicode
data. Unicode editions of Dyalog APL can only write character data which would be
readable by a Classic edition (consisting of elements of ⎕AV).

External Variables
External variables are implemented as small-span (32-bit-addressing) component
files, and subject to the same restrictions as these files. External variables are unlikely
to be developed further; Dyalog recommends that applications which use them
should switch to using mapped files or traditional component files. Please contact
Dyalog if you need further advice on this topic.

32 vs. 64-bit Interpreters
From Dyalog APL Version 11.0 onwards, there are two separate versions of programs
for 32-bit and 64-bit machine architectures (the 32-bit versions will also run on 64bit machines running 64-bit operating systems). There is complete inter-operability
between 32- and 64-bit interpreters, except that 32-bit interpreters are unable to work
with arrays or workspaces greater than 2GB in size.

Unicode vs. Classic Editions
From Version 12.0 onwards, a Unicode edition is available, which is able to work
with the entire Unicode character set. Classic editions (a term which includes versions prior to 12.0) are limited to the 256 characters defined in the atomic vector,
⎕AV).

5
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Component files have a Unicode property. When this is enabled, all characters will
be written as Unicode data to the file. The Unicode property is always off for smallspan (32-bit addressing) files, which may not contain Unicode data. For large-span
(64-bit addressing) component files, the Unicode property is set on by Unicode Editions and off by Classic Editions, by default. The Unicode property can subsequently
be toggled on and off using ⎕FPROPS.
When a Unicode edition writes to a component file which may not contain Unicode
data, character data is mapped using ⎕AVU, and can therefore be read without problems by Classic editions.
A TRANSLATION ERROR will occur if a Unicode edition writes to a non-Unicode
component (that is either a 32-bit file, or a 64-bit file when the Unicode property is
currently off) if the data being written contains characters which are not in ⎕AVU.
Likewise, a Classic edition (Version 12.0 or later) will issue a TRANSLATION
ERROR if it attempts to read a component containing Unicode data not in ⎕AVU from
a component file. Version 11.0 cannot read components containing Unicode data
and issues a NONCE ERROR.
A TRANSLATION ERROR will also be issued when a Classic edition )LOADs or )
COPYs a workspace containing Unicode data which cannot be mapped to ⎕AV using
the ⎕AVU in the recipient workspace.
TCPSocket objects have an APL property which corresponds to the Unicode property of a file, if this is set to Classic (the default) the data in the socket will be
restricted to ⎕AV, if Unicode it will contain Unicode character data. As a result,
TRANSLATION ERRORs can occur on transmission or reception in the same way as
when updating or reading a file component.

AVU changes
The implementation of the function Right in Version 13.0 led to the discovery that
⎕AVU incorrectly defined ⎕AV[59+⎕IO] as ¤ (⎕UCS 164) rather than ⊢ (Right
Tack, ⎕UCS 8866). This error has been corrected in the default ⎕AVU and in workspace AVU.dws. If you are operating in a mixed Unicode/Classic environment, this
error will have caused earlier Classic editions to map ⎕AV[59+⎕IO] to the wrong
Unicode character (¤). This may cause TRANSLATION ERRORs when a Version
13.0 Classic system attempts to read the data, as it will not be able to represent ¤ in
the Atomic Vector.

6
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DECFs and Complex numbers
Version 13.0 introduced two new data types; DECFs and Complex numbers.
Attempts to read components of these types in earlier interpreters will result in a
DOMAIN ERROR.

Very large array components
The maximum size (in bytes) of a component written by Version 12.1 and prior is
2GB. This is the size of the component as held on disk which may be different than
the size reported by ⎕SIZE. In Version 13.0 the maximum size of a component
written by a 64-bit interpreter is 4GB. From Version 13.2 onwards, the limit on the
size of arrays or components is so large that for most practical purposes, there is effectively no limit.
An attempt to read a component greater than 2GB in 32-bit interpreters will result in
a WS FULL. An attempt to read such a component in 64-bit Versions 12.0 and 12.1
patched after 1st April 2011 will result in a NONCE ERROR; earlier patches generate
a FILE COMPONENT DAMAGED error.

File Journaling
Version 12.0 introduced File Journaling (level 1), and 12.1 added journaling levels 2
and 3 and checksumming. Versions earlier than 12.0 cannot tie files which have any
form of journaling or checksumming enabled. Version 12.0 cannot tie files with journaling levels greater than 1, or checksumming enabled. Attempting to tie such files
will result in a FILE NAME ERROR. Files can be shared with earlier versions by
using ⎕FPROPS to amend the journaling and checksumming levels.

TCPSockets
TCPSockets used to communicate between differing versions of Dyalog APL are subject to similar limitations to those described above for component files. In particular
TCPSockets with 'Style' 'APL' will only be able to pass arrays that are supported by both versions.

Auxiliary Processors
A Dyalog APL process is restricted to starting an AP of exactly the same architecture.
In other words, the AP must share the same word-width and byte-ordering as its interpreter process.

Session Files
Session (.dse) files may only be used on the platform on which they were created and
saved.

7
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The APL Command Line
The command line for Dyalog APL is as follows:
dyalog [ options ] [ debug ] [ file ] [param] [param] [param]...
where:
[options]
-x
-a
-b
-Fxx
-s
-q
-c

No ⎕LX execution on workspace loads.
Start in USER mode.
Suppress the banner in the Session..
Default to creating xx-bit files (where xx is 32 or 64).
Disable the Session. This option is ignored in Windows
versions.
Don't quit APL on error (used when piping input into
APL).
Signifies a command-line comment. All characters to the
right are ignored.

[debug]
-Dc
-Dw
-DW
-DK

Check workspace integrity after every callback function.
Check workspace integrity on return to session input.
Check workspace integrity after every line of APL
(application will run slowly as a result)
Log session keystrokes in (binary) file APLLOG.

[file]
The name of a Dyalog APL workspace to be loaded. Unless
specified, the file extension .DWS is assumed.
[param]
A parameter name followed by an equals sign (=) and a value.
Note that the parameter name may be one of the standard APL
parameters described below, or a name and value of your own
choosing (see Object Reference, GetEnvironment method).

Examples:
c:\program files\…\dyalog.exe myapp maxws=64000
c:\program files\…\dyalog.exe session_file=special.dse
c:\program files\…\dyalog.exe myapp aplt=mytrans.dot myparam=42

8

Chapter 1: Installation and Configuration

9

APL Exit Codes
When APL or a bound .EXE terminates, it returns an exit code to the calling environment. If APL is started from a desktop icon, the return code is ignored. However, if
APL is started from a script (UNIX) or a command processor, the exit code is available and may be used to determine whether or not to continue with other processing
tasks. The return codes are:
0

successful ⎕OFF, )OFF, )CONTINUE, graphical exit from GUI

1

APL failed tostart. This will occur if there was a failure to read a
translate file, there is insufficient memory, or a critical parameter is
incorrectly specified or missing.

2

APL was terminated by SIGHUP or SIGTERM (UNIX) or in response
to a QUIT WINDOWS request. APL has done a clean exit.

3

APL issued a syserror.

4

Runtime violation. This occurs if a runtime application attempts to
read input from the Session. Only a development version has a
Session.

Notes:
Under UNIX exit codes greater than 127 indicates (127+signal number) of the
untrapped signal which caused the process to terminate.
APL applications can generate a custom return code by specifying an integer value to
the right of ⎕OFF. Dyalog recommends using values greater than 10 for this purpose.

Configuration Parameters
Introduction
Dyalog APL/W is customised using a set of configuration parameters which are
defined in a registry folder.
In addition, parameters may be specified as environment variables or may be specified on the APL command line.
Furthermore, you are not limited to the set of parameters employed by APL itself as
you may add parameters of your own choosing.
Although for clarity parameter names are given here in mixed case, they are case-independent under Windows. Under Unix and Linux, Dyalog parameters must be specified as environment variables and must be named entirely in upper-case.
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Setting Parameter Values
You can change the parameters in 4 ways:
l

l

l
l

Using the Configuration dialog box that is obtained by selecting Configure
from the Options menu on the Dyalog APL/W session. See "The Configuration Dialog Box" on page 127 for details.
By directly editing the Windows Registry using REGEDIT.EXE or
REGEDIT32.EXE.
By defining the parameters as environment variables.
By defining the parameters on the APL command line.

This scheme provides a great deal of flexibility, and a system whereby you can override one setting with another. For example, you can define your normal workspace
size (maxws) in your .INI file or Registry, but override it with a new value specified
on the APL command line. The way this is done is described in the following section.

How APL Obtains Parameter Values
When Dyalog APL/W requires the value of a parameter, it uses the following rules.
1. If the parameter is defined on the APL command line, this value is used.
2. Otherwise, APL looks for an environment variable of the same name and
uses this value.
3. Otherwise, if the parameter in question is inifile, the default value of
Software\Dyalog\Dyalog APL/W 13.0 Unicode (Unicode Edition) or Software\Dyalog\Dyalog APL/W 13.0 Classic (Classic
Edition) is assumed.
4. Otherwise, if the parameter in question is dyalog, the name of the directory
from which the Dyalog APL program was loaded is assumed.
5. The value of any other parameter is obtained from the registry folder defined
by the value of inifile.
Note that the value of a parameter obtained by the GetEnvironment method (see
Object Reference) uses exactly the same set of rules.
The following section details those parameters that are implemented by Registry
Values in the top-level folder identified by inifile. Values that are implemented in
sub-folders are mainly internal and are not described in detail here. However, any
Value that is maintained via a configuration dialog box will be named and
described in the documentation for that dialog box in Chapter 2.
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APL_CODE_E_MAGNITUDE
Version 13.0 introduced decimal floating point numbers which have greater precision than IEEE floating point numbers. This increased the maximum allowable
print precision from 17 to 34 and this had the side effect of changing the way
numbers in function bodies are descanned1. For example, the number one sextillion
(1021 ) in a function is descanned by Version 12.1 as 1E21 and by Version 13.0 as
1000000000000000000000.
Note that only numbers X in the range (10*17) ≤ X <(10*34) are affected.
Whilst this change has no other deleterious effect, it means that code that contains
such numbers is harder to read, and the result of ⎕CR (and other character representations) of the same function may have changed between Version 12.1 and Version 13.0 causing undesired affects in code management systems.
The APL_CODE_E_MAGNITUDE parameter allows the user to choose between
current (Version 13.0 and onwards) and earlier behaviour.
If the APL_CODE_E_MAGNITUDE parameter is undefined or set to 0 (the
default), numbers are descanned and displayed as normal.
If APL_CODE_E_MAGNITUDE is ¯1, numbers greater than or equal to 1017 will
be displayed using exponential format, as in Version 12.1.
The effect of setting this parameter to any other value is undefined.

1Descanning refers to the internal process used to convert the internal representation of APL code

into a character array. For numbers in function statements, this process uses the maximum value of
Print Precision.
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APL_COMPLEX_AS_V12
Support for Complex Numbers means that some functions produce different results
from previous Versions of Dyalog APL. If APL_COMPLEX_AS_V12 is set to 1 the
behaviour of code developed using Version 12.1 or earlier will be unchanged; in particular:
l

l
l

Power (*) and logarithm (⍟) do not produce Complex Numbers as results
from non-complex arguments.
⎕VFI will not honour "J" or "j" as part of a number.
¯4○Y will be evaluated as (̄1+Y*2)*0.5, which is positive for negative
real arguments.

If APL_COMPLEX_AS_V12 is set to any other value or is not set at all then code
developed using version 12.1 or earlier may now generate Complex Numbers.
Note that this feature is provided to simplify the transition of older code to Version
13.0. It does not prevent the generation and use of Complex Numbers using features
new to 13.0 (such as explicitly specifying a Complex Number literal), and it will be
removed in a future release of Dyalog APL.

APL_FCREATE_PROPS_C
This parameter specifies the default chksum level for newly-created component files.
If unspecified, the default checksum level is 1.

APL_FCREATE_PROPS_J
This parameter specifies the default journaling level for newly-created component
files. If unspecified, the default journaling level is 1.

Chapter 1: Installation and Configuration

13

APL_FAST_FCHK
This parameter specifies whether Dyalog APL should optimise ⎕FCHK by allowing it
to reliably determine whether a component file had been properly untied and therefore does not need to be checked (this is overridable using the ⎕FCHK option 'force').
Optimising ⎕FCHK in this way has a performance impact on ⎕FUNTIE and it is recommended this optimisation is switched off if your application frequently ties and
unties files.
Note: this only affects component files with journaling enabled.
The values of the parameter are:
0

Do not optimise ⎕FCHK (optimise ⎕FUNTIE instead)

1

Optimise ⎕FCHK

The default values of the parameter reflect the existing behaviour in Version 12.1: 0
on Windows and 1 on Linux / AIX. On Windows, setting the value 1 has no effect.

APL_EXTERN_DECF
By default, arrays of type DECF (128-bit decimal) will be passed unchanged to Auxiliary Processors, and to DLLs using A or Z argument types. However, if APL_
EXTERN_DECF is set to 0, DECF arrays will be converted to DOUBLE before
they are passed to AP's and DLL's. This will allow user-written Auxiliary Processors
and DLLs to continue to work at least temporarily while users determine how to
change their code to cater for the new data type. This parameter will not be supported
beyond Version 13.0.
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AplCoreName
This parameter may be a string or a Boolean value. If it is a string, it specifies the
directory and name of the file in which the aplcore should be saved. The optional
wild-card character (*) is replaced by a unique string when the file is written. For
example:
APLCORENAME=C:\mycores\aplcore*.dat
If AplCoreName is set to Boolean 0, the generation of an aplcore file is suppressed
and the application simply terminates with an exit code of 3.

aplk

(Classic Edition Only)
This parameter specifies the name of your Input Translate Table, which defines your
keyboard layout. The keyboard combo in the Configure dialog box displays all the
files with the .DIN extension in the APLKEYS sub-directory. You may choose any
one of the supplied tables, and you may add your own to the directory. Note that the
FILE.DIN table is intended for input from file, and should not normally be chosen as
a keyboard table. Classic Edition only

aplkeys

(Classic Edition Only)
This parameter specifies a search path for the Input Translate Table and is useful for
configuring a run-time application. It consists of a string of directories separated by
the semicolon (;) character. Its default value is the APLKEYS sub-directory of the
directory in which Dyalog APL/W is installed (defined by dyalog)

aplnid
Under Windows, this parameter specifies the user number that is used by the component file system to control file sharing and security. If you wish to share component files and/or external variables in a network it is essential that each user has a
unique aplnid parameter. It may be any integer in the range 0 to 65535. Note that an
aplnid value of 0 causes the user to bypass APL’s access control matrix mechanism.
Under UNIX, the user number is obtained from the Operating System (UID) and
aplnid is not used. If the user is "root", APL's access control mechanism is ignored.
When a user creates a component file, his user number is recorded in the file to identify him as its owner.

14
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aplt
This parameter specifies the name of the Output Translate Table. The default is
WIN.DOT and there is rarely a need to alter it.

apltrans
This parameter specifies a search path for the Output Translate Table and is useful for
configuring a run-time application. It consists of a string of directories separated by
the semicolon (;) character. Its default value is the sub-directory APLTRANS in the
directory in which Dyalog APL/W is installed.

auto_pw
This parameter specifies whether or not the value of ⎕PW is derived automatically
from the current width of the Session Window. If auto_pw is 1, the value of ⎕PW
changes whenever the Session Window is resized and reflects the number of characters that can be displayed on a single line. If auto_pw is 0 (the default) ⎕PW is independent of the Session Window size.

AutoFormat
This parameter specifies whether or not you want automatic formatting of Control
Structures in functions. The default value is 1 which means that formatting is done
automatically for you when a function is opened for editing or converted to text by
⎕CR, ⎕NR and ⎕VR. Automatic formatting first discards all leading spaces in the function body. It then prefixes all lines with a single space except those beginning with a
label or a comment symbol (this has the effect of making labels and comments stand
out). The third step is to indent Control Structures. The size of the indent depends
upon the TabStops parameter. To turn off automatic formatting, set AutoFormat to
0.

AutoIndent
This parameter specifies whether or not you want semi-automatic indenting during
editing. The default value is 1. This means that when you enter a new line in a function, it is automatically indented by the same amount as the previous line. This
option simplifies the entry of indented Control Structures.
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ClassicMode
This parameter specifies whether or not the Session operates in Dyalog Classic mode.
The default is 0. If this parameter is set to 1, the Editor and Tracer behave in a manner
that is consistent with previous versions of Dyalog APL.

CMD_PREFIX and CMD_POSTFIX
These parameters defines strings within which operating system commands specified
as the arguments to ⎕CMD and ⎕SH, and )CMD and )SH, are wrapped. Its purpose is
to run the command arguments under a non-standard command shell.
See Language Reference for implementation details.

confirm_abort
This parameter specifies whether or not you will be prompted for confirmation when
you attempt to abort an edit session after making changes to the object being edited.
Its value is either 1 (confirmation is required) or 0. The default is 0.

confirm_close
This parameter specifies whether or not you will be prompted for confirmation when
you close an edit window after making changes to the object being edited. Its value
is either 1 (confirmation is required) or 0. The default is 0.

confirm_fix
This parameter specifies whether or not you will be prompted for confirmation when
you attempt to fix an object in the workspace after making changes in the editor. Its
value is either 1 (confirmation is required) or 0. The default is 0.

confirm_session_delete
This parameter specifies whether or not you will be prompted for confirmation when
you attempt to delete lines from the Session Log. Its value is either 1 (confirmation is
required) or 0. The default is 1.
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CreateAplCoreOnSyserror
This parameter specifies whether or not an aplcore file is generated when APL exits
with a system error.

default_div
This parameter specifies the value of ⎕DIV in a clear workspace. Its default value is
0.

DefaultHelpCollection
If UseDefaultHelpCollection is 1, Dyalog attempts to use the Microsoft Document
Explorer and online help, for example from Visual Studio (if installed), to display
help for external objects, such as .Net Types. In most cases the default settings of "mshelp://ms.mscc.v80" will be sufficient. On some configurations it may be necessary
to change this. See " UseDefaultHelpCollection" on page 28

default_io
This parameter specifies the value of ⎕IO in a clear workspace. Its default value is 1.

default_ml
This parameter specifies the value of ⎕ML in a clear workspace. Its default value is 0.

default_pp
This parameter specifies the value of ⎕PP in a clear workspace. Its default value is 10.
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default_pw
This parameter specifies the value of ⎕PW in a clear workspace. Its default value is 76.
Note that ⎕PW is a property of the Session and the value of default_pw is overridden
when a Session file is loaded.

default_rl
This parameter specifies the value of ⎕RL in a clear workspace. It must be a scalar and
its default value is 16807.

default_rtl
This parameter specifies the value of ⎕RTL in a clear workspace. Its default value is
0.

default_wx
This parameter specifies the value of ⎕WX in a clear workspace. This in turn determines whether or not the names of properties, methods and events of GUI objects are
exposed. If set (⎕WX is 1), you may query/set properties and invoke methods directly
as if they were variables and functions respectively. As a consequence, these names
may not be used for global variables in GUI objects.

DMXOUTPUTONERROR
This parameter specifies in which windows DMX error messages are displayed. It is
an integer whose value is the sum of the sspecified windows where 1 = Status Window and 2 = Session Window.

DockableEditWindows
This parameter specifies whether or not individual edit windows can be undocked
from (and docked back into) the (MDI) Editor window. Its default value is 0. This
parameter does not apply if ClassicMode is set to 1.

DoubleClickEdit
This parameter specifies whether or not double-clicking over a name invokes the
editor. Its default is 1. If DoubleClickEdit is set to 0, double-clicking selects a word
and triple-clicking selects the entire line.
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dyalog
This parameter specifies the name of the directory in which Dyalog APL/W is
installed.

DyalogEmailAddress
This parameter specifies the contact email address for Dyalog Limited.

DyalogHelpDir
This parameter specifies the full pathname of the directory that contains the Dyalog
APL help file (dyalog.chm).

DyalogInstallDir
This parameter specifies the full pathname of the directory in which Dyalog APL is
installed.

DyalogWebSite
This parameter specifies the URL for the Dyalog web site.

edit_cols, edit_rows
These parameters specify the initial size of an edit window in character units.

edit_first_x, edit_first_y
These parameters specify the initial position on the screen of the first edit window in
character units. Subsequent edit windows will be staggered. These parameters only
apply if ClassicMode is 1.
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edit_offset_x, edit_offset_y
These parameters specify the amount by which an edit window is staggered from the
previous one.

ErrorOnExternalException
This is a Boolean parameter that specifies the behaviour when a System Exception
occurs in an external DLL. If this parameter is set to 1, and an exception occurs in a
call on an external DLL. APL generates an EXTERNAL DLL EXCEPTION error
(91), instead of terminating with a System Error. This error may be trapped.

EditorState
This is an internal parameter that remembers the state of the last edit window (normal
or maximised). This is used to create the next edit window in the appropriate state.

greet_bitmap
This parameter specifies the filename of a bitmap to be displayed during initialisation
of the Dyalog APL application. It is used typically to display a product logo from a
runtime application. The bitmap will remain until either an error occurs, or it is
removed using the GreetBitmap method of the Root object.
greet_bitmap=c:\myapp\logo.bmp

history_size
This parameter specifies the size of the buffer in Kb used to store previously entered
(input) lines in the Session.
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inifile
This parameter specifies the name of the Windows Registry folder that contains the
configuration parameters described in this section. For example,
INIFILE=Software\Dyalog\mysettings

If the parameter is not defined, inifile defaults to the current directory.

InitialKeyboardLayout

(Unicode Edition Only)

This parameter specifies the name of the keyboard to be selected on startup. When
you start an APL session, this layout will automatically be selected as the current keyboard layout if the value of InitialKeyboardLayoutInUse is 1.

InitialKeyboardLayoutInUse

(Unicode Edition Only)

This Boolean parameter specifies whether or not the keyboard specified by InitialKeyboardLayout is selected as the current keyboard layout when you start an APL
session.

InitialKeyboardLayoutShowAll

(Unicode Edition Only)

This Boolean parameter specifies whether or not all installed keyboards are listed in
the choice of keyboards in the Configuration dialog box (Unicode Input tab) .

input_size
This parameter specifies the size of the buffer in Kb used to store marked lines (lines
awaiting execution) in the Session.
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KeyboardInputDelay
This parameter specifies the delay (in milliseconds) before the system reacts to a user
keystroke by:
l

l

updating the name of the Current Object in the Session statusbar. See "The
Current Object" on page 65
offering a list of names for auto-completion. See "Auto Complete Tab" on
page 149

lines_on_functions
This parameter specifies whether or not line numbers are displayed in edit and trace
windows. It is either 0 (the default) or 1.
Note that this parameter determines your overall preference for line numbering, and
this setting persists between APL sessions. You can however still toggle line numbering on and off dynamically as required by clicking Line Numbers in the Options
menu on the Session Window. These temporary settings are not saved between APL
sessions

localdyalogdir
This parameter specifies the name of the directory in which Dyalog APL/W is
installed on the client, in a client/server installation

log_file
This parameter specifies the full pathname of the Session log file.

log_file_inuse
This parameter specifies whether or not the Session log is saved in a session log file.

log_size
This parameter specifies the size of the Session log buffer in Kb.
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(Classic Edition Only)
In previous versions of Dyalog APL, certain pairs of characters in ⎕AV were mapped
to a single font glyph through the output translate table. For example, the ASCII pipe
¦ and the APL style | were both mapped to the APL style |. From Version 7.0
onwards, it has been a requirement that the mapping between ⎕AV and the font is
strictly one-to-one (this is a consequence of the new native file system). Originally,
the mapping of the ASCII pipe and the APL style, the APL and ASCII quotes, and the
ASCII ^ and the APL ^ were hard-coded. The mapping is defined by the mapchars
parameter.
mapchars is a string containing pairs of hexadecimal values which refer to 0-origin
indices in ⎕AV. The first character in each pair is mapped to the second on output.
The default value of mapchars is DB0DEBA7EEC00BE0 which defines the following mappings.
From

To

Hex

Decimal

Symbol

Hex

Decimal

Symbol

DB

219

‘

0D

13

'

EB

235

^

A7

167

^

EE

238

⌷

C0

192

|

0B

11

.

E0

224

.

To clear all mappings, set MAPCHARS=0000.

maxws
This parameter determines your workspace size in kilobytes and is the amount of
Windows memory allocated to the workspace at APL start-up. MAXWS is specified
as an integer number followed optionally by the letter k, m or g (in upper or lower
case) to indicate kilobytes, megabytes or gigabytes. If omitted, the default is kilobytes.
The default value is 16384 (16 Mb). If you want a larger (or smaller) workspace you
must change this value. For example, to get a 64 MB workspace:
MAXWS=64m
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Dyalog APL places no implicit restriction on workspace size, and the virtual memory
capability of MS-Windows allows you to access more memory than you have physically installed. However if you use a workspace that greatly exceeds your physical
memory you will encounter excessive paging and your APL programs will run
slowly.
Note that the memory used for the workspace must be contiguous memory, and,
under Windows, this is typically limited to a maximum of 1.6GB. This is a Windows
restriction, and not one that is imposed by Dyalog APL.

OverstrikesPopup

(Unicode Edition Only)

This is a Boolean parameter that specifies whether or not the Overstrikes popup is
enabled.

PassExceptionsToOpSys
This is a Boolean parameter that specifies the default state of the Pass Exception
check box in the System Error dialog box.

pfkey_size
This parameter specifies the size of the buffer in Kb that is used to store programmable function key definitions. See ⎕PFKEY.

ProgramFolder
This parameter specifies the name of the folder in which the Dyalog APL program
icons are installed.

PropertyExposeRoot
This parameter specifies whether or the names of properties, methods and events of
the Root object are exposed. If set, you may query/set the properties of Root and
invoke the Root methods directly as if they were variables and functions respectively. As a consequence, these names may not be used for global variables in your
workspace.
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PropertyExposeSE
This parameter specifies whether or the names of properties, methods and events of
the Session object are exposed. If set, you may query/set the properties of ⎕SE and
invoke ⎕SE methods directly as if they were variables and functions respectively. As
a consequence, these names may not be used for global variables in the ⎕SE namespace.

qcmd_timeout
This parameter specifies the length of time in milliseconds that APL will wait for the
execution of a Windows command to start. Its default value is 5000 milliseconds.

ResolveOverstrikes

(Unicode Edition Only)

Specifies whether or not the user may enter an APL composite symbol using overstrikes.

RunAsService
When RunAsService is set to 1 (the default is 0) Dyalog APL will not prompt for confirmation when the user logs off, and the interpreter will continue to run across the
logoff logon process

SaveContinueOnExit
Specifies whether or not your current workspace is saved as CONTINUE.DWS before
APL terminates.

SaveLogOnExit
Specifies whether or not your Session log is saved before APL terminates.

SaveSessionOnExit
Specifies whether or not your current Session is saved in your Session file before APL
terminates.
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Serial
Specifies your Dyalog APL/W Serial Number.

session_file
This parameter specifies the name of the file from which the APL session (⎕SE) is to
be loaded when APL starts. If not specified, a .DSE extension is assumed. This session file contains the ⎕SE object that was last saved in it. This object defines the
appearance and behaviour of the Session menu bar, tool bar(s) and status bar, together
with any functions and variables stored in the ⎕SE namespace.

SessionOnTop
Specifies whether or not the Session may appear on top of Edit and Trace Windows
in Classic Dyalog mode. See " ClassicMode" on page 16.

ShowStatusOnError
Specifies whether or not the Status window is automatically displayed (if required)
when APL attempts to write output to it.

SingleTrace
Specifies whether there is a single Trace window, or one Trace window per function.
This applies only if ClassicMode is 1.

StatusOnEdit
Specifies whether or not a status bar is displayed at the bottom of an Edit window.

sm_cols, sm_rows
These parameters specify the size of the window used to display ⎕SM when it is used
stand-alone. They are not used if the window is specified using the SM object.

TabStops
This parameter specifies the number of spaces inserted by pressing the Tab key in the
editor. Its default value is 4.
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trace_cols, trace_rows
These parameters specify the initial size of a trace window in character units.

trace_first_x, trace_first_y
These parameters specify the initial position on the screen of the first trace window
in character units. Subsequent trace windows will be staggered. This applies only if
ClassicMode is 1.

trace_offset_x, trace_offset_y
These parameters specify the amount by which a trace window is staggered from the
previous one. These apply only if ClassicMode is 1 and SingleTrace is 0.

Trace_level_warn
This parameter specifies the maximum number of Trace windows that will be displayed when an error occurs and Trace_on_error is set to 1. If there are a large
number of functions in the state indicator, the display of their Trace windows may
take several seconds. This parameter allows you to restrict the potential delay to a reasonable value and its default is 16. If the number of Trace windows would exceed
this number, the system instead displays a warning message box. This parameter is
ignored if you invoke the Tracer explicitly. This parameter applies only if ClassicMode is 1 and SingleTrace is 0.

Trace_on_error
This parameter is either 0 (the default) or 1. If set to 1, Trace_on_error specifies that
the Tracer is automatically deployed when execution of a defined function halts with
an error. A stack of Trace windows is immediately displayed, with the top Trace window receiving the input focus.
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TraceStopMonitor
This parameter specifies which of the ⎕TRACE (1), ⎕STOP (2) and ⎕MONITOR (4) columns are displayed in Trace and Edit windows. Its value is the sum of the corresponding values.

UnicodeToClipboard
This parameter specifies whether or not text that is transferred to and from the Windows clipboard is treated as Unicode text. If UnicodeToClipboard is 0 (the default),
the symbols in ⎕AV are mapped to ASCII text (0-255). In particular, the APL symbols
are mapped to ASCII symbols according to their positions in the Dyalog APL font. If
UnicodeToClipboard is 1, the symbols in ⎕AV are mapped to Unicode text and the
APL symbols are mapped to their genuine Unicode equivalent values.

UseDefaultHelpCollection
This parameter specifies whether or not Dyalog attempts to use the Microsoft Document Explorer and online help to display help for external objects, such as .Net
Types. See "DefaultHelpCollection " on page 17.

WantsSpecialKeys

(Unicode Edition Only)

This parameter specifies a list of applications (e.g. "putty.exe") that use the command
strings in the Input Translate Tables.

wspath
This parameter defines the workspace path. This is a list of directories that are
searched in the order specified when you )LOAD or )COPY a workspace and when
you start an Auxiliary Processor. The directory paths are specified using Operating
System specific conventions and separated by ";" (Windows) or ":" (UNIX).
The following Windows example causes )COPY, )LOAD and )LIB to look first in
the current directory, then in D:\MYWS, and then in the (normal) installation workspace directory.
wspath=.;D:\MYWS;C:\Program Files\Dyalog\Dyalog APL 13.2
Unicode\ws

XPLookAndFeel
This parameter specifies whether or not Native Look and Feel is used. This affects the
appearance of user-interface controls such as Buttons. The default is 1. See "The Configuration Dialog Box" on page 127.
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XPLookAndFeelDocker
This parameter specifies whether or not the title bars in docked windows honour
Native Look and Feel, if this is enabled at the Windows level. If unspecified, the
default is 0.

yy_window
This parameter defines how Dyalog APL is to interpret a 2-digit year number. If yy_
window is not set (the default) then under Windows, Version 13.2 onwards will
adhere to the rules specified in the Windows Region and Language 2-digit year settings.
Dyalog allows a choice of input date formats for ⎕SM and GUI edit fields. If you have
chosen a 2-digit year format such as MM/DD/YY, then an input of 02/01/00 will by
default be interpreted as 1st February 1900 - not 1st February 2000.
If your application uses a 4-digit year format such as YYYY-MM-DD, the problem
will not arise.
You can use the yy_window parameter to cause your application to interpret 2-digit
dates in as required without changing any APL code.

Sliding versus Fixed Window
Two schemes are in common use within the industry: Sliding or Fixed date windows.
Use a Fixed window if there is a specific year, for example 1970, before which, dates
are meaningless to your application. Note that with a fixed window, this date (say
1970) will still be the limit if your application is running in a hundred years time.
Use a Sliding window if there is a time period, for example 30 years, before which
dates are considered too old for your application. With a sliding window, you will
always be able to enter dates up to (say) 30 years old, but after a while, specific years
in the past (for example 1970) will become inaccessible.

Setting a Fixed Window
To make a fixed window, set parameter yy_window to the 4-DIGIT year which is
the earliest acceptable date. For example:
YY_WINDOW=1970
This will cause the interpreter to convert any 2-digit input date into a year in the
range 1970, 1971 ... 2069
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Setting a Sliding Window
To make a sliding window, set parameter yy_window to the 1- or 2-DIGIT year
which determines the oldest acceptable date. This will typically be negative.
YY_WINDOW=-30
Conversion of dates now depends on the current year:
If the current year is 1999, the earliest accepted date is 1999-30 = 1969.
This will cause the interpreter to convert any 2-digit input date into a year in the
range 1969, 1970 ... 2068.
However if your application is still running in the year 2010, the earliest accepted
date then will be 2010-30 = 1980. So in the year 2010, a 2-digit year will be interpreted in the range 1980, 1981 ... 2079.

Advanced Settings
You can further restrict date windows by setting an upper as well as lower year limit.
YY_WINDOW=1970,1999
This causes 2-digit years to be converted only into the range 1970, 1971 ... 1999.
Any 2-digit year (for example, 54) not convertible to a year in this range will cause a
DOMAIN ERROR.
The sliding window equivalent is:
YY_WINDOW=-10,10
This would establish a valid date window, ten years either side of the current year.
For example, if the current year is 1998, the valid range would be (1998-10) –
(1998+10), in other words: 1988, 1989, → 2008.
One way of looking at the yy_window variable is that it specifies a 2-element vector.
If you supply only the first element, the second one defaults to the first element + 99.
Note that the system uses only the number of digits in the year specification to determine whether it refers to a fixed (4-digits) or sliding (1-, or 2-digits) window. In fact
you can have a fixed lower limit and a sliding upper limit, or vice versa.
YY_WINDOW=1990,10
Allows dates as early as 1990, but not more than 10 years hence.
YY_WINDOW=0,1999
Allows dates from the current year to the end of the century.

Chapter 1: Installation and Configuration

31

If the second date is before, or more that 99 years after the first date, then any date conversion will result in a DOMAIN ERROR. This might be useful in an application
where the end-user has control over the input date format and you want to disallow
any 2-digit date input.
YY_WINDOW=1,0

Registry Sub-Folders
A large amount of configuration information is maintained in the Windows Registry
in sub-folders of the main folder identified by inifile.
Many of these values are dynamic, for example the position of the various Session
windows, is maintained in a Registry sub-folder so that their appearance is maintained from one invocation of APL to the next. These type of Registry values are considered to be internal and are therefore not described herein.
However, and Registry Value that is maintained via a configuration dialog box will
be named and described in the documentation for that dialog box in Chapter 2.

AutoComplete
This contains registry entries that describe your personal AutoComplete options. See
"Auto Complete Tab" on page 149.

Charts
This contains entries that control the way charts are produced and displayed when
you click one of the chart buttons. See " Object Operations" on page 122.

Colours
This contains entries that describe the colour schemes you have and your personal
preferences. See "Colour Selection Dialog" on page 157.

Event Viewer
This contains entries that describe your settings for the Event Viewer. See "The Event
Viewer" on page 258.

Explorer
This contains entries that describe your settings for the Workspace Explorer. See
"The Workspace Explorer Tool" on page 168.

files
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This contains the size of your recently used file list (see "General Tab" on page 127)
and the list of your most recently loaded workspaces.
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KeyboardShortcuts
This contains the definitions of your Keyboard Shortcuts (Unicode Edition only).
See "Keyboard Shortcuts Tab" on page 135.

LanguageBar
This contains the definitions of the symbols, tips, and help for the symbols in the LanguageBar.

Printing
This contains the entries for your Printer Setup options. See "Print Configuration
Dialog Box" on page 160.

SALT
This contains entries for SALT. See "SALT" on page 151.

Search
This contains dynamic entries for the Find Objects Tool. See "Find Objects Tool" on
page 202.

Threads
This contains entries to remember your preferences for Threads. See "The Threads
Menu" on page 116.

UnicodeIME
This contains entries for the Dyalog Unicode IME.

ValueTips
This contains entries for your Value Tips preferences. See "Value Tips" on page 93.

WindowRects
This contains entries to maintain the position of various Session tool windows so
that they remain consistent between successive invocations of APL.

Array Editor
The Array Editor stores its settings in the following registry sub-folder:
HKEY_CURRENT_USER\Software\DavidLiebtag.com\Array
Editor\1.1\Options
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Workspace Management
Workspace Size and Compaction
The maximum amount of memory allocated to a Dyalog APL workspace is defined
by the maxws parameter.
Upon )LOAD and )CLEAR, APL allocates an amount of memory corresponding to
the size of the workspace being loaded (which is zero for a clear ws) plus the workspace delta.
The workspace delta is 1/16th of maxws, except if there is less than 1/16th of maxws
in use, delta is 1/64th of maxws. This may also be expressed as follows:
delta←maxws{⌈⍺÷⊃(⍵>⍺÷16)⌽64 16}ws
where maxws is the value of the maxws parameter and ws is the currently allocated
amount of workspace. If maxws is 16384KB, the workspace delta is either 256KB or
1024 KB, and when you start with a clear ws the workspace occupies 256KB.
When you erase objects or release symbols, areas of memory become free. APL manages these free areas, and tries to reuse them for new objects. If an operation requires a
contiguous amount of workspace larger than any of the available free areas, APL reorganises the workspace and amalgamates all the free areas into one contiguous block
as follows:
1. Any un-referenced memory is discarded. This process, known as garbage
collection, is required because whole cycles of refs can become un-referenced.
2. Numeric arrays are demoted to their tightest form. For example, a simple
numeric array that happens to contain only values 0 or 1, is demoted or
squeezed to have a ⎕DR type of 11 (Boolean).
3. All remaining used memory blocks are copied to the low-address end of the
workspace, leaving a single free block at the high-address end. This process
is known as compaction.
4. In addition to any extra memory required to satisfy the original request, an
additional amount of memory, equal to the workspace delta, is allocated.
This will always cause the process size to increase (up to the maxws limit)
but means that an application will typically achieve its working process
size with at most 4+15 memory reorganisations.
5. However, if after compaction, the amount of used workspace is less than
1/16 of the Maximum workspace size (maxws), the amount reserved for
working memory is reduced to 1/64th maxws. This means that workspaces
that are operating within 1/16th of maxws will be more frugal with memory
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Note that if you try to create an object which is larger than free space, APL reports WS
FULL.
The following system function and commands force a workspace reorganisation as
described above:
⎕WA, )RESET, )SAVE, )LOAD, )CLEAR
However, in contrast to the above, any spare workspace above the workspace delta
is returned to the Operating System. On a Windows system, you can see the process
size changing by using Task Manager.
The system function ⎕WA may therefore be used judiciously (workspace reorganisation takes time) to reduce the process size after a particularly memory-hungry
operation.
Note that in Dyalog APL, the SYMBOL TABLE is entirely dynamic and grows and
shrinks in size automatically. There is no SYMBOL TABLE FULL condition.

Interface with Windows
Windows Command Processor commands may be executed directly from APL using
the system command )CMD or the system function ⎕CMD. This system function is also
used to start other Windows programs. For further details, see the appropriate sections
in Language Reference.

Auxiliary Processors
Introduction
Auxiliary Processors (APs) are non-APL programs which provide Dyalog APL users
with additional facilities. They run under the control of Dyalog APL.
Typically, APs are used where speed of execution is critical, for utility libraries, or as
interfaces to other products. APs may be written in any compiled language, although
C is preferred and is directly supported.
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Starting an AP
An Auxiliary Processor is invoked using the dyadic form of ⎕CMD. The left argument
to ⎕CMD is the name of the program to be executed; the value of the wspath parameter is used to find the named file. In Dyalog APL/W, the right argument to ⎕CMD is
ignored.
'xutils' ⎕CMD ''
On locating the specified program, Dyalog APL starts the AP and initialises a memory segment for communication between the workspace and the AP. This communication segment allows data to be passed from the workspace to the other
process, and for results to be passed back. The AP then sends APL some information
about its external functions (names, code numbers and calling syntax), which APL
enters in the symbol table. APL then continues processing while the AP waits for
instructions.

Using the AP
Once established, an AP is used by making a reference to one of its external functions. An external function behaves as if it was a locked defined function, but it is in
effect an entry point to the AP. When an external function is referenced, APL transmits a code number to the AP, followed by any arguments. The AP then takes over
and performs the desired processing before posting the result back.

Terminating the AP
An AP is terminated when all of its external functions are expunged from the active
workspace. This could occur with the use of )CLEAR, )LOAD, )ERASE, ⎕EX, )OFF,
)CONTINUE or ⎕OFF.
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Example:
Start an Auxiliary Processor called EXAMPLE. This fixes two external functions
called DATE_TO_IDN and IDN_TO_DATE which deal with the conversion of International Day Numbers to Julian Dates.
.------------------------.
|
APL PROCESS
|
|------------------------|
|
)CLEAR
|
|clear ws
|
|
|
start AP .--------------.
|
'EXAMPLE' ⎕CMD ''
|------------>| AP EXAMPLE |
|
|
|--------------|
|
| info about |Send info on |
|
|<------------|external fns |
|
| functions |
|
|
)FNS
|
| wait ...
|
|DATE_TO_IDN IDN_TO_DATE |
|
|
|
|function code|
|
|
IDN_TO_DATE 19407
|------------>|call relevant |
|
|
19407
| subroutine
|
|
wait ...
|
|
|
|
|<-18 Feb 53--| send result |
|18 Feb 53
|
|
|
|
| terminate
|
|
|
)CLEAR
|------------>|
EXIT
|
|clear ws
| and stop
.--------------.
|
|
.------------------------.

Access Control for External Variables
External variables may be EXCLUSIVE or SHARED. An exclusive variable can
only be accessed by the owner of the file. If you are on a Local Area Network (LAN)
a shared external variable may be accessed (concurrently) by other users. The exclusive or shared status of an external variable is set by the XVAR function in the UTIL
workspace.
Access to an external variable is faster if it has exclusive status than if it is shared.
This is because if several users are accessing the file data must always be read and
written directly to disk. If it has exclusive status, the system uses buffering and
avoids disk accesses where possible.
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Creating Executables
Dyalog APL provides the facility to package an APL workspace as a Windows
executable (EXE). This may be done by selecting Export … from the File menu of the
APL Session window.
The system provides the following options:
l

l

l

You may bind your EXE as a Dyalog APL run-time application, or as a Dyalog APL developer application. The second option will allow you to debug
the application should it encounter an APL error.
You may bind your EXE as a console-mode application. A console application does not have a graphical user interface, but runs as a background
task using files or TCP/IP to perform input and output.
You may specify whether or not your .EXE will honour Native Look and
Feel if this is enabled at the Windows level.

You can package the workspace as a stand-alone executable or as a .EXE file that
must be accompanied by the Dyalog APL Dynamic Link Library (dyalog132.dll
or dyalog132rt.dll), in which case the DLL should be installed in the same
directory (as the EXE) or in the Windows System directory.
The following example illustrates how you can package the supplied workspace
calc.dws as an executable. Before making the executable, it is essential to set up
the latent expression to run the program using ⎕LX as shown. Notice that in this case
it is not necessary to execute ⎕OFF; the calc.exe program will terminate normally
when the user closes the calculator window and the system returns to Session input.
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Then, when you select Export… from the File menu, the following dialog box is displayed.
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In the example shown, the program is to be saved in ws, the (supplied workspaces)
directory from which the workspace was loaded (the default).
The Save as Type option has been set to Standalone Executable (includes interpreter
exe) which means that a single .EXE will be created containing the Dyalog APL
executable and the CALC workspace.
The Runtime application checkbox is checked, indicating that calc.exe is to
incorporate the runtime version of Dyalog APL..
As this is a GUI application, the Console application checkbox is left unset.
The Enable Native Look and Feel checkbox has been set so that calc.exe will honour Native Look and Feel if it is enabled at the Windows level.
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Note that if you enter the name of a file containing an icon (use the Browse button to
browse for it) that icon will be bound with your executable and be use instead of the
standard Dyalog APL icon.
The Command Line box allows you to enter parameters and values that are to be
passed to your executable when it is invoked.
On clicking Save, the following message box is displayed to confirm success.

Version Information
You may embed version information into your .exe by clicking the Version button
and then completing the Version Informationn dialog box that is illustrated below.

Chapter 1: Installation and Configuration

42

Run-Time Applications and Components
Using Dyalog APL you may create different types of run-time applications and components. Note that the distribution of run-time applications and components requires
a Dyalog APL Run-Time Agreement. Please contact Dyalog or your distributor, or
see the Dyalog web page for more information.
The following table shows a list of distributable components for the two Editions.
These are referred to in the remainder of this Chapter by the name shown in the first
column of the table. It is essential that you distribute the components that are appropriate for the Edition you are using.
Name

File

32-bit Unicode

Dyalog APL 13.2 Unicode\

Run-Time EXE

dyalogrt.exe

Run-Time DLL

dyalog132rt_unicode.dll

Bridge DLL

bridge132_unicode.dll

Dyalog DLL

dyalog32 dll

DyalogProvider DLL

dyalogprovider.dll

DyalogNet DLL

dyalognet.dll

APLScript Compiler

dyalogc_unicode-exe

32-bit Classic

Dyalog APL 13.2 Classic\

Run-Time EXE

dyalogrt.exe

Run-Time DLL

dyalog132rt.dll

Bridge DLL

bridge132.dll

Dyalog DLL

dyalog32 dll

DyalogProvider DLL

dyalogprovider.dll

DyalogNet DLL

dyalognet.dll

APLScript Compiler

dyalogc-exe
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Name

File

64-bit Unicode

Dyalog APL-64 13.2 Unicode\

Run-Time EXE

dyalogrt.exe

Run-Time DLL

dyalog132_64rt_unicode.dll

Bridge DLL

bridge132-64_unicode.dll

Dyalog DLL

dyalog64 dll

DyalogProvider DLL

dyalogprovider.dll

DyalogNet DLL

dyalognet.dll

APLScript Compiler

dyalogc64_unicode-exe

64-bit Classic

Dyalog APL-64 13.2 Classic\

Run-Time EXE

dyalogrt.exe

Run-Time DLL

dyalog132_64rt.dll

Bridge DLL

bridge132-64.dll

Dyalog DLL

dyalog64 dll

DyalogProvider DLL

dyalogprovider.dll

DyalogNet DLL

dyalognet.dll

APLScript Compiler

dyalogc64-exe
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Stand-alone run-time
This is the simplest type of run-time to install. Using the File/Export menu item on
the Session window, you can create a standard Windows executable program file
(EXE) which contains your workspace and the Run-Time version of the Dyalog APL
interpreter. To distribute your application, you need to supply and install:
1. Your bound executable (EXE)
2. whatever additional files that may be required by your application

Chapter 1: Installation and Configuration

44

The command-line for your application should simply invoke your EXE, with whatever start-up parameters it may require. Note that your application icon and any startup parameters for the Run-Time Interpreter are specified and bound with the EXE
when you make it.
If your application uses any component of the Microsoft .Net Framework, you must
distribute the Bridge DLL and DyalogNet DLLs. These DLLs must either be on the
system path or placed in the same directory as your EXE. If you are going to use your
application with ASP.NET, the DLLs must also be installed in the global assembly
cache (GAC) using the gacutil.exe utility program.

Bound run-time
This option requires the separate installation of the Run-Time DLL, but compared
with the stand-alone executable option, may save disk space and memory if your customer installs and runs several different Dyalog applications. Using the File/Export
menu item on the Session window, you can create a standard Windows executable
program file (EXE) which contains your workspace bound to the Run-Time DLL. To
distribute your application, you need to supply and install:
1. Your bound executable (EXE)
2. The Run-Time DLL
whatever additional files that may be required by your application
The command-line for your application should simply invoke your EXE, with whatever start-up parameters it may require. Note that your application icon and any startup parameters for the Run-Time DLL are specified and bound with the EXE when
you make it.
If your application uses any component of the Microsoft .Net Framework, you must
distribute the Bridge DLL and DyalogNet DLLs. These DLLs must either be on the
system path or placed in the same directory as your EXE. If you are going to use your
application with ASP.NET, the DLLs must also be installed in the global assembly
cache (GAC) using the gacutil.exe utility program.

Workspace based run-time
A workspace based run-time application consists of the Dyalog APL Run-Time Program (Run-Time EXE) and a separate workspace. To distribute your application, you
need to supply and install:
1. Your workspace
2. The Run-Time EXE
3. whatever additional files that may be required by your application
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The command-line for your application invokes the Run-Time EXE, passing it startup parameters required for the Run-Time EXE itself (such as MAXWS) and any startup parameters that may be required by your application. You will need to associate
your own icon with your application during its installation.
If your application uses any component of the Microsoft .Net Framework, you must
distribute the Bridge DLL and DyalogNet DLLs. These DLLs must either be on the
system path or placed in the same directory as your EXE. If you are going to use your
application with ASP.NET, the DLLs must also be installed in the global assembly
cache (GAC) using the gacutil.exe utility program.

Out-of-process COM Server
To make an out-of-process COM Server, you must:
1. Establish one or more OLEServer namespaces in your workspace, populated
with functions and variables that you wish to export as methods, properties
and events.
2. Use the File/Export … menu item on the Session window to register the
COM Server on your computer so that it is ready for use.
The command-line for your COM Server invokes the Run-Time EXE, passing it startup parameters required for the Run-Time EXE itself (such as MAXWS) and any startup parameters that may be required by your application.
To distribute an out-of-process COM Server, you need to supply and install the following files:
1.
2.
3.
4.

Your workspace
The associated Type Library (.tlb) file (created by File/Export)
The Run-Time EXE
whatever additional files that may be required by your application

To install an out-of-process COM Server you must set up the appropriate Windows
registry entries. See Interface Guide for details.

In-process COM Server
To make an in-process COM Server, you must:
1. Establish one or more OLEServer namespaces in your workspace, populated
with functions and variables that you wish to export as methods, properties
and events.
2. Use the File/Export … menu item on the Session window to create an inprocess COM Server (DLL) which contains your workspace bound to the
Run-Time DLL. This operation also registers the COM Server on your computer so that it is ready for use.
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To distribute your component, you need to supply and install
Your COM Server file (DLL)
1. The Run-Time DLL
2. Whatever additional files that may be required by your COM Server.
Note that you must register your COM Server on the target computer using the
regsvr32.exe utility.

ActiveX Control
To make an ActiveX Control, you must:
1. Establish an ActiveXControl namespaces in your workspace, populated
with functions and variables that you wish to export as methods, properties
and events.
2. Use the File/Export … menu item on the Session window to create an ActiveX Control file (OCX) which contains your workspace bound to the RunTime DLL. This operation also registers the ActiveX Control on your computer so that it is ready for use.
To distribute your component, you need to supply and install
Your ActiveX Control file (OCX)
1. The Run-Time DLL
2. Whatever additional files that may be required by your ActiveX Control.
Note that you must register your ActiveX Control on the target computer using the
regsvr32.exe utility.

Microsoft .Net Assembly
A Microsoft .Net Assembly contains one or more .Net Classes. To make a Microsoft
.Net Assembly, you must:
1. Establish one or more NetType namespaces in your workspace, populated
with functions and variables that you wish to export as methods, properties
and events.
2. Use the File/Export … menu item on the Session window to create a Microsoft .Net Assembly (DLL) which contains your workspace bound to
the Run-Time DLL.
To distribute your .Net Classes, you need to supply and install
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Your Assembly file (DLL)
1.
2.
3.
4.
5.

The Run-Time DLL
The Bridge DLL
The DyalogNet DLL
Whatever additional files that may be required by your .Net Assembly.
The Bridge DLL and DyalogNet DLLs must either be on the system path or
placed in the same directory as your EXE. If you are going to use your
Assembly with ASP.NET, the DLLs must also be installed in the global
assembly cache (GAC) using the gacutil.exe utility program.

Additional Files for SQAPL
If your application uses the SQAPL/EL ODBC interface, you must distribute and
install four additional files, according to the Edition you are using, as shown in the
tables below.
Name

File

32-bit Unicode

Dyalog APL 13.2 Unicode\

SQAPL INI

sqapl.ini

SQAPL ERR

sqapl.err

SQAPL DLL

cndya61Uni.dll

APLUNICD INI

aplunicd.ini

32-bit Classic

Dyalog APL 13.2 Classic\

SQAPL INI

sqapl.ini

SQAPL ERR

sqapl.err

SQAPL DLL

cndya61.dll

APLUNICD INI

aplunicd.ini
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Name

File

64-bit Unicode

Dyalog APL-64 13.2 Unicode\

SQAPL INI

sqapl.ini

SQAPL ERR

sqapl.err

SQAPL DLL

cndya61x64Uni.dll

APLUNICD INI

aplunicd.ini

64-bit Classic

Dyalog APL-64 13.2 Classic\

SQAPL INI

sqapl.ini

SQAPL ERR

sqapl.err

SQAPL DLL

cndya61x64.dll

APLUNICD INI

aplunicd.ini

The SQAPL DLL must be installed in the user’s Windows directory or be on the
user’s path.
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Miscellaneous Other Files
AUXILIARY PROCESSORS
If you use any of the Auxiliary Processors (APs) included in the sub-directory
XUTILS, you must include these with your application. Note that, like workspaces,
Dyalog APL searches for APs using the wspath parameter. If your application uses
APs, you must ensure that you specify wspath or that the default wspath is adequate
for your application..

DYALOG32 and/or DYALOG64
This DLL is used by some of the functions provided in the QUADNA.DWS workspace.
If you include any of these in your application this DLL must be installed in the
user’s Windows directory or be on the user’s path.

Registry Entries for Run-Time Applications
The Run-Time DLL does not obtain any parameter values from the Windows registry. If you need to specify any Dyalog APL parameter values, they must be defined
in the command line when you create an EXE.
The Run-Time EXE does obtain parameter values for the Windows registry, but does
not require them to be present. If the default values of certain parameters are inappropriate, you may specify their values on the command line. There is normally no
requirement to install registry entries for a run-time application that uses the RunTime EXE.
For example, your application may requires a greater or lesser maxws parameter
(workspace size) than the default value. This may be done by adding the phrase
MAXWS=nnnn (where nnnn is the required workspace size in kilobytes) after the
name of your application workspace on the command line, for example:
dyalogrt.exe MYAPP.DWS MAXWS=8096

Note that the default value of the DYALOG parameter (which specifies where it
looks for various other files and sub-directories) is the directory from which the application (dyalogrt.exe) is loaded.
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Nevertheless, registry entries will be required in the following circumstances.
1. If your Classic Edition run-time application requires that the user inputs
APL characters, you will need to specify input/output tables (parameters
APLK, APLT, APLKEYS and APLTRANS).
2. If your application uses the NFILES Auxiliary Processor (now superseded
by the ⎕Nxxx system functions), you must specify a registry entry for the
APLKEYS parameter. This is required so that NFILES can find any translate tables you may use. Note that NFILES cannot see the values of parameters specified on the APL command line, so you must specify APLKEYS
in the registry.

Installing Registry Entries
To specify parameters using the Registry, you must install a suitable registry folder
for each user of your application. By default, Version 13.2 will use the registry
folder:
HKEY_CURRENT_USER\Software\Dyalog\Dyalog APL/W 13.2 Unicode

or
HKEY_CURRENT_USER\Software\Dyalog\Dyalog APL/W 13.2

You may choose a different name for your registry folder if you wish. If so, you must
tell Dyalog APL the name of this folder by specifying the INIFILE parameter on the
command line. For example:
dyalogrt.exe MYAPP.DWS INIFILE=Software\MyCo\MyApplication

You may install entries into the registry folder in one of two ways:
1. Using a proprietary installation program such as InstallShield
2. Using the REGEDIT utility. This utility program installs registry entries
defined in a text file that is specified as the argument to the program. For
example, if your file is called APLAPP.REG, you would install it on your
user’s system by executing the command:
REGEDIT APLAPP.REG

An example 5-line file that specifies the APLNID and MAXWS
parameters might be as follows:
Windows Registry Editor Version 5.00
[HKEY_CURRENT_USER\Software\Dyalog\Dyalog APL/W 13.0]
"aplnid"="42"
"maxws"="8096"
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COM Objects and the Dyalog APL DLL
Introduction
In each Edition, there are two versions of the Dyalog APL Dynamic Link Library,
named dyalog132_unicode.dll and dyalog132rt_unicode.dll (Unicode Edition) and dyalog132.dll and dyalog132rt.dll (Classic Edition).
dyalog132_unicode.dll and dyalog132.dll are complete Dyalog APL
development systems packaged as Dynamic Link Libraries.
dyalog132_unicode.dll and dyalog132rt_unicode.dll and
dyalog132rt.dll are the run-time versions of dyalog132.dll.
In the remainder of this section, the term the Dyalog APL DLL is used to refer to any
one of these DLLs. The term COM object is used to refer to a Dyalog APL in-process
OLE Server (OLEServer object) or a Dyalog APL ActiveX Control (ActiveXControl
object).
The Dyalog APL DLL is used to host COM objects and .Net objects written in Dyalog APL. Although this section describes how it operates with COM objects, much
of this also applies when it hosts .Net objects. Further information is provided in the
.Net Interface Guide.

Classes, Instances and NameSpace Cloning
A COM object, whether written in Dyalog APL or not, represents a class. When a
host application loads a COM object, it actually creates an instance of that class.
When a host application creates an instance of a Dyalog APL COM object, the corresponding OLEServer or ActiveXControl namespace is cloned. If the host creates a
second instance, the original namespace is cloned a second time.
Cloned OLEServer and ActiveXControl namespaces are created in almost exactly the
same way as those that you can make yourself using ⎕OR and ⎕WC except that they
do not have separate names. In fact, each clone believes itself to be the one and only
original OLEServer or ActiveXControl namespace, with the same name, and is completely unaware of the existence of other clones.
Notice that cloning does not initially replicate all the objects within the OLEServer
or ActiveXControl namespace. Instead, the objects inside the cloned namespaces are
actually represented by pointers to the original objects in the original namespace.
Only when an object is changed does any information get replicated. Typically, the
only objects likely to differ from one instance to another are variables, so only one
copy of the functions will exist in the workspace. This design enables many
instances of a Dyalog APL COM object to exist without overloading the workspace.
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Workspace Management
By default, the Dyalog APL DLL does not use a fixed maximum workspace size, but
automatically increases the size of its active workspace as required. If you write a
run-away COM object, or if there is insufficient computer memory available to load a
new control, it is left to the host application or to Windows itself to deal with the situation.
Nevertheless, it is possible to specify a value for MAXWS for the application in
which the Dyalog APL DLL is embedded. This is achieved by defining a Registry
key named:
HKLM\Software\Dyalog\Embedded\<appname>

where <appname> is the name of the application, containing a String Value named
maxws set to the desired size (in kb). If you were running an APL in-process server
from Microsoft Excel, the application name would be excel.exe.
When an application loads its first Dyalog APL COM object, it starts the Dyalog
APL DLL which initialises a CLEAR WS. It then copies the namespace tree for the
appropriate OLEServer or ActiveXControl object into its active workspace.
This namespace tree comprises the OLEServer or ActiveXControl namespace itself,
together with all its parent namespaces with the exception of the root workspace
itself. Note that for an ActiveXControl, there is at least one parent namespace that represents a Form.
For example, if an ActiveXControl namespace is called #.F.Dual, the Dyalog APL
DLL will copy the contents of #.F into its active workspace when the first instance
of the control is loaded by the host application.
If the same host application creates a second instance of the same OLEServer or
ActiveXControl, the original namespace is cloned as described above and there is no
further impact on the workspace
If the same host application creates an instance of a different Dyalog APL COM
object, the namespace tree for this second object is copied from its DLL or OCX file
into the active workspace. For example, if the second control was named
X.Y.MyControl, the entire namespace X would be copied.
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This design raises a number of points:
1. Unless you are in total control of the user environment, you should design a
Dyalog APL COM object so that it can operate in the same workspace as
another Dyalog APL COM object supplied by another author. You cannot
make any assumptions about file ties or other resources that are properties of
the workspace itself.
2. If you write an ActiveXControl whose ultimate parent namespace is called
F, a host application could not use your control at the same time as another
ActiveXControl (perhaps supplied by a different author) whose ultimate parent namespace is also called F.
3. Dyalog APL COM objects must not rely on variables or utility functions
that were present in the root workspace when they were saved. These functions and variables will not be there when the object is run by the Dyalog
APL DLL.
4. A Dyalog APL COM object may create and subsequently use functions and
variables in the root workspace, but if two different COM objects were to
adopt the same policy, there is a danger that they would interfere with one
another. The same is true for ⎕SE.

Multiple COM Objects in a Single Workspace
If your workspace contains several OLEServer or ActiveXControl objects which
have the same ultimate parent namespace, the Dyalog APL DLL will copy them all
into the active workspace at the time when the first one is instanced. If the host application requests a second COM object that is already in the workspace, the namespace
tree is not copied again.
If the workspace contains several OLEServer or ActiveXControl objects which have
different ultimate parents, their namespace trees will be copied in separately.

Parameters
With the exception of maxws (see above) the Dyalog APL DLL does not read parameters from the registry, command-line or environment variables. This means that all
such parameters will have their default values.
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System Errors
Introduction
Dyalog APL will display a System Error Dialog and (normally) terminate in one of
two circumstances:
l
l

As a result of the failure of a workspace integrity check
As a result of a System Exception

aplcore file
In these circumstances, APL saves an aplcore file which may be sent to Dyalog for
diagnosis. The default name and location of the aplcore file may be specified by the
AplCoreName parameter. This parameter may also be used to suppress generation of
the aplcore file.

Workspace Integrity
When you )SAVE your workspace, Dyalog APL first performs a workspace integrity
check. If it detects any discrepancy or violation in the internal structure of your workspace, APL does not overwrite your existing workspace on disk. Instead, it displays
the System Error dialog box and saves the workspace, together with diagnostic information, in an aplcore file before terminating.
A System Error code is displayed in the dialog box and should be reported to Dyalog
for diagnosis.
Note that the internal error that caused the discrepancy could have occurred at any
time prior to the execution of )SAVE and it may not be possible for Dyalog to identify the cause from this aplcore file.
If APL is started in debug mode with the –Dc, -Dw or –DW flags, the Workspace
Integrity check is performed more frequently, and it is more likely that the resulting
aplcore file will contain information that will allow the problem to be identified and
corrected.
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System Exceptions
Non-specific System Errors are the result of Operating System exceptions that can
occur due to a fault in Dyalog APL itself, an error in a Windows or other DLL, or
even as a result of a hardware fault. The following system exceptions are separately
identified.
Code Description

Suggested Action
As the most likely cause is a temporary
network fault, recommended course of
action is to restart your program.

900

A Paging Fault has
occurred

990
&
991

An exception has occurred
in the Development or RunTime DLL.

995

An exception has occurred
in a DLL function called
via ⎕NA

Carefully check your ⎕NA statement and
the arguments that you have passed to
the DLL function

996

An exception has occurred
in a DLL function called
via a threaded ⎕NA call

As above

997

An exception has occurred
while processing an
incoming OLE call

999

An exception has been
caused by Dyalog APL or
by the Operating System

Recovering Data from aplcore files
Objects may often (but not always) be recovered from aplcore using )COPY. Note
that because (by default) the aplcore file has no extension, it is necessary to explicitly
add a dot, or APL will attempt to find the non-existent file aplcore.DWS, i.e.
)COPY aplcore.
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Reporting Errors to Dyalog
If APL crashes and saves an aplcore file, please email the following information to
support@dyalog.com:
1. a brief description of the circumstances surrounding the error
2. details of your version of Dyalog APL: the full version number, whether it
is Unicode or Classic Edition, and the BuildID. This information appears in
the Help->About box; the Copy button copies this information into the clipboard, from where it can be pasted into an email etc.
3. the aplcore file itself
If the problem is reproducible, i.e. can be easily repeated, please also send the appropriate description, workspace, and other files required to do so.

System Error Dialog Box
The System Error Dialog illustrated below was produced by deliberately inducing a
system exception in the Windows DLL function memcpy(). The functions used
were:
[1]
[1]
[1]

[1]
[2]

∇ foo
goo
∇
∇ goo
hoo
∇
∇ hoo
crash
∇
∇ crash
⎕NA'dyalog32|MEMCPY u u u'
MEMCPY 255 255 255
∇
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Options
Item

Parameter

Generate
complete
image
core

Dumps a complete core image with the
CreateAplCoreonSyserror User Mode Process Dumper (a
Microsoft tool) - see below.
If you check this box (only enabled on
System Error codes 995 and 996), APL
will not terminate but will instead
generate an error 91 (EXTERNAL DLL
EXCEPTION) when you press Dismiss.

Create
Trappable
Error
Create an
aplcore
file

Description

CreateAplCoreonSyserror

If this box is checked, an aplcore file
will be created.

Pass
exception
on to
PassExceptionsToOpSys
operating
system

If this box is checked, the exception
will be passed on to your current
debugging tool (e.g. Visual Studio).

Copy to
clipboard

Copies the contents of the APL stack
trace window to the Clipboard.

Generate complete image core
The Generate complete image core option attempts to execute [SYSDIR]
\userdump.exe, where [SYSDIR] is the windows system directory (typically
c:\windows\system32, and userdump.exe is the User Mode Process Dumper, a
Microsoft tool that can be downloaded from the following url (which you may copy
from Winhelp and paste into a browser):
http://www.microsoft.com/downloads/details.aspx?
FamilyID=e23cd741-d222-48df-9cd8-28796f414256&DisplayLang=en

The process creates a file called dyalog.core in the current directory. This file contains much more debug information than a normal aplcore (and is much larger than an
aplcore) and can be sent to Dyalog Limited (zip it first please). Alternatively the file
can be loaded into Visual Studio .Net to do your own debugging.

Chapter 1: Installation and Configuration

59

Debugging your own DLLs
If you are using Visual Studio, the following procedure should be used to debug your
own DLLs when an appropriate Dyalog APL System Error occurs.
Ensure that the Pass Exception box is checked, then click on Dismiss to close the System Error dialog box.
The system exception dialog box appears. Click on Debug to start the process in the
Visual Studio debugger.
After debugging, the system exception dialog box appears again. Click on Don't
send to terminate Windows' exception handling.

ErrorOnExternalException Parameter
This parameter allows you to prevent APL from displaying the System Error dialog
box (and terminating) when an exception caused by an external DLL occurs. The following example illustrates what happens when the functions above are run, but with
ErrorOnExternalException set to 1.
⎕←2 ⎕NQ'.' 'GetEnvironment'
'ErrorOnExternalException'
1
foo
EXTERNAL DLL EXCEPTION
crash[2] MEMCPY 255 255 255
^
⎕EN
91
)SI
crash[2]*
hoo[1]
goo[1]
foo[1]
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Chapter 2:
The APL Environment

Introduction
The Dyalog APL Development Environment includes a Session Manager, an Editor,
and a Tracer all of which operate in windows on the screen. The session window is
created when you start APL and is present until you terminate your APL session. In
addition there may be a number of edit and/or trace Windows, which are created and
destroyed dynamically as required. All APL windows are under the control of Windows and may be selected, moved, resized, maximised and minimised using the standard facilities that Windows provides.

APL Keyboards
The Classic and Unicode Editions of Dyalog APL for Windows use different techniques for mapping keystrokes to APL characters and to special command shortcuts.
The Classic Edition uses a proprietary technique for these mappings. The Unicode
Edition uses Microsoft’s IME (Input Method Editor) technology. Many other applications use the same technology, which means that the Dyalog Unicode IME may be
used not only with Dyalog APL for Windows Unicode Edition, but also with word
processing applications, spreadsheets, terminal emulators etc. Therefore with the Dyalog Unicode IME installed, and with a suitable font selected, APL characters can be
entered and viewed in many other applications.
In both Classic and Unicode Editions APL characters are generated when the user
presses certain combinations of meta keys in conjunction with the normal character
keys. Meta keys include Shift, Ctrl and Alt.
For both input techniques it is possible to alter the mapping of keystrokes to APL
characters, and to add support for new languages. It is also possible to alter the keystrokes which define special command keyboard shortcuts. For further details, see
"Unicode Edition Keyboard" on page 66 or "Classic Edition Keyboard" on page 71
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Unicode Edition
Previous Unicode Editions of Dyalog APL used the Dyalog Ctrl or Dyalog AltGr
keyboard or the old IME to enter APL characters. With Version 13.2 the Dyalog Ctrl
and Dyalog AltGr keyboards are no longer issued and the Dyalog Unicode IME is
the sole input mechanism for APL characters. The Dyalog Unicode IME can be used
with previous Unicode Editions of Dyalog APL provided that they are patched to a
Version created on or after 1st April 2011.
Note that previous versions of Dyalog APL included the Comfort on-screen keyboard; which has been withdrawn.
Further details and a list of languages supported are described in the Dyalog Unicode
IME section below.

Classic Edition
The mapping for each of the ⎕AV positions and its associated keystroke is defined by
a selectable translate table. ⎕AV includes all the APL symbols used by Dyalog APL
as well as all the (non-APL) characters which appear on a standard keyboard. This
mapping only works with Classic Edition.
The Classic Edition installation also includes the Dyalog Unicode IME (described
below) so that users may enter APL characters into other applications; the Dyalog
Unicode IME is however not used by the Classic Edition itself.
The Classic Edition includes support for Danish, Finnish, French, German, Italian,
Swedish, and both British and American English keyboards. The default keyboard
mapping for unsupported languages is American English.

Dyalog Unicode IME
The Dyalog Unicode IME defines the mapping of keystrokes to Unicode characters.
Only keystrokes which resolve to characters that either do not appear on the standard
keyboard or which differ from those that appear on the standard keyboard are
included in the selectable translate table. In effect the Dyalog Unicode IME can be
regarded as an overlay of the standard keyboard which contains just APL characters.
Dyalog intends to extend the Dyalog Unicode IME to include a mechanism that will
allow any overstrike combination to be added, and that the Dyalog Unicode IME
will be made freely available and not be reserved just for Dyalog APL users.
This new Dyalog Unicode IME replaces the previously issued IME, as well as the
Dyalog Ctrl and Dyalog AltGr keyboards.
The Dyalog Unicode IME supplied with Version 13.2 includes support for Danish,
Finnish, French, German, Italian, Swedish and British and American English keyboards, based on the Version 12.1 Dyalog Ctrl layouts.
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The Dyalog Unicode IME also has support for the Danish, British and American English physical keyboards, which are available from Dyalog Ltd. It also includes support for Spanish and German keyboards based on the layout of the Dyalog hardware
keyboard.
The default keyboard mapping for unsupported languages is American English.
The IME translate tables include mappings for the special command keystrokes used
by Dyalog APL.
These command keystroke mappings are ignored by applications unless the application is explicitly named in the Dyalog Unicode IME configuration. It is expected
that only terminal emulators used for running UNIX-based versions of Dyalog APL
will use this feature.
In particular, Dyalog APL for Windows Unicode Edition does not use the mappings
in the translate tables; the mappings are defined under Options/Configure/Keyboard
Shortcuts (see "Keyboard Shortcuts Tab" on page 135).
To allow you to identify which IME you are using, the Dyalog Unicode IME uses a
different icon to that used in previous Versions as shown below:
The Dyalog Unicode IME

The old APL IME

Session Manager
The Dyalog APL/W session is fully configurable. Not only can you change the
appearance of the menus, tool bars and status bars, but you can add new objects of
your choice and attach your own APL functions and expressions to them. Functions
and variables can be stored in the session namespace. This is independent of the
active workspace; so there is no conflict with workspace names, and your utilities
remain permanently accessible for the duration of the session. Finally, you may set up
different session configurations for different purposes which can be saved and loaded
as required.
The session window is defined by an object called ⎕SE. This is very similar to a
Form object, but has certain special properties. The menu bar, tool bar and status bars
on the session window are in fact MenuBar, ToolControl and StatusBar objects
owned by ⎕SE. All of the other components such as menu items and tool buttons are
also standard GUI objects. You may use ⎕WC to create new session objects and you
may use ⎕WS to change the properties of existing ones. ⎕WG and ⎕WN may also be
used with ⎕SE and its children.
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Components of the session that perform actions (MenuItem and Button objects) do so
because their Event properties are defined to execute system operations or APL
expressions. System operations comprise a pre-defined set of actions that can be performed by Dyalog APL/W. These are coded as keywords within square brackets. For
example, the system operation [WSClear] produces a clear ws, after first displaying a dialog box for confirmation. You may customise your session by adding or
deleting objects and by attaching system operations or APL expressions to them.
Like any other object, ⎕SE is a namespace that may contain functions and variables.
Furthermore, ⎕SE is independent of the active workspace and is unaffected by )
LOAD and )CLEAR. It is therefore sensible to store commonly used utilities, particularly those utilities that are invoked by events on session objects, in ⎕SE itself,
rather than in each of your application workspaces.
The possibility of configuring your APL session so extensively leads to the requirement to have different sessions for different purposes. To meet this need, sessions are
stored in special files with a .DSE (Dyalog Session) extension. The default session
(i.e. the one loaded when you start APL) is specified by the session_file parameter.
You may customise this session and then save it over the default one or in a separate
file. You can load a new session from file at any stage without affecting your active
workspace.

Positioning the Cursor
The cursor may be positioned within the current APL window by moving the mouse
pointer to the desired location and then clicking the Left Button. The APL cursor
will then move to the character under the pointer.

Selection
Dragging the mouse selects the text from the point where the mouse button is
depressed to the point where the button is released. When you select multiple lines,
the use of the left mouse button always selects text from the start of the line. A contiguous block of text can be selected by dragging with the right mouse button.
Double-clicking the left mouse button to the left of a line selects the whole line,
including the end-of-line character.

Scrolling
Data can be scrolled in a window using the mouse in conjunction with the scrollbar.

Chapter 2: The APL Environment

65

Invoking the Editor
The Editor can be invoked by placing the mouse pointer over the name of an editable
object and double-clicking the left button on the mouse. If you double-click on the
empty Input Line it acts as "Naked Edit" and opens an edit window for the suspended
function (if any) on the APL stack. For further details, see "Invoking the Editor" on
page 211. See also "DoubleClickEdit " on page 18.

The Current Object
If you position the input cursor over the name of an object in the session window,
that object becomes the current object. This name is stored in the CurObj property of
the Session object and may be used by an application or a utility program. This
means that you can click the mouse over a name and then select a menu item or click
a button that executes code that accesses the name.

The Session Pop-up Menu
Clicking the right mouse button brings up the Session pop-up menu. This is
described later in this chapter.

Drag-and-Drop Editing
Drag-and-Drop editing is the easiest way to move or copy a selection a short distance
within an edit window or between edit windows.

To move text using drag-and-drop editing:
1. Select the text you want to move.
2. Point to the selected text and then press and hold down the left mouse button. When the drag-and-drop pointer appears, drag the cursor to a new location.
3. Release the mouse button to drop the text into place.

To copy text using drag-and-drop editing:
1. Select the text you want to move.
2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.
3. Release the mouse button to drop the text into place.
If you drag-and-drop text within the Session window, the text is copied and not
moved whether or not you use the Ctrl key.
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Interrupts
To generate an interrupt, click on the Dyalog APL icon in the Windows System
Tray; then choose Weak Interrupt or Strong Interrupt. To close the menu, click
Cancel. Alternatively, to generate a weak interrupt, press Ctrl+Break, or select
Interrupt from the Action menu on the Session Window.

Unicode Edition Keyboard
Introduction
Unicode Edition supports the use of standard Windows keyboards that have the additional capability to generate APL characters when the user presses Ctrl, Alt, AltGr (or
some other combination of meta keys) in combination with the normal character
keys.
Version 13.2 is supplied with the Dyalog Unicode IME keyboard for a range of different languages as listed below. These keyboards have the same mappings as the
Dyalog Ctrl keyboard layouts used in Version 12.1. The intention is that only APL
characters and characters that appear in locations different from the underlying keyboard are defined; any other keystroke is passed through as is.

Installation
During the Installation of Dyalog Version 13.2 Unicode Edition, setup installs the
Dyalog Unicode IME (IME). For any given Input Language the IME consists of an
additional service for that Input Language, and a translate table which maps keystrokes for the appropriate keyboard to Unicode code points for APL characters
An IME service is installed for every Input Language that the user who installs Dyalog APL has defined, as well as every Input Language for which Dyalog has support.
The keyboard mappings are defined for the following national languages:
l

l

l

Danish, Finnish, French, German, Italian, Swedish and British and American
English keyboards (based on the Dyalog APL Version 12.1 Ctrl layouts)
Danish, British and American English physical keyboards, as supplied by
Dyalog Ltd.
German and Spanish keyboards based on the Dyalog hardware keyboard layout

For any other Input Language the American English translate table is selected. Note
that some Input Languages are defined to be substitutes for other Input Languages;
for example Australian English Input is a substitute for American English Input, Austrian German Input a substitute for German German Input. In these cases the IME will
install the appropriate translate table. It is also possible to create support for new languages or to modify the existing support. See the IME User Guide for further details.
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Configuring the Dyalog APL IME
The following description uses screenshots taken from a Windows 7 PC with three
Input Languages configured for the current user: English (United Kingdom) - the
default Input Language, Danish (Denmark) and English (United States).
The Dyalog Unicode IME is added as an additional service to all keyboards defined
to the user and the administrator at the time that the IME was installed.
For each IME the underlying keyboard layout file will be the same as that defined for
the base keyboard. The layout file is a DLL created by Microsoft.
The language specified in the description of the IME is the name of the IME translate
table that has been associated with the IME for the specific keyboard. In the case of
languages not supported by the IME the keyboard will default to en-US. With the
IME as supplied with Version 13.2 altering this text requires editing the appropriate
Registry value.
The IME may be configured from within APL or from Windows.

From within Dyalog APL
To change the properties of the IME go to Options/Configure/Unicode Input tab and
select Configure Layout:
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From Windows
Right click on either the Input Language icon or the Keyboard layout icon in the
TaskBar and select Settings:
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To alter the configuration of any of the installed IMEs, select that IME and click on
Properties:

Input translate table:
The translate table defines the mapping between APL characters and the keystrokes
that generate those APL characters. It is possible to alter the mapping or to create support for new keyboards by altering the translate table, or by selecting a different translate table. See the IME User Guide for more details.

Overstrikes:
In the original implementations of APL, many of the special symbols could only be
generated by overstriking one character on top of another as is reflected in the appearance of the glyphs. For example, the symbol for Grade Up (⍋) is actually the symbol
for delta (∆) superimposed on the symbol for vertical bar (|)
In Dyalog APL such symbols can be generated either by a single keystroke, or (in
Replace mode) by overtyping one symbol with another. For example ⍋ may be generated using Shift+Ctrl+4, or by switching to Replace mode and typing the three keystrokes Ctrl+h, Left-Cursor, Ctrl+m.
Using the Dyalog Unicode IME the character can also be entered by pressing
Ctrl+Bksp, Ctrl+m, Ctrl+h. Note that Ctrl+Bksp is the default Overstrike Introducer
Key (key code OS).
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Use Overstrike popup:
With this option selected, when the character following the Overstrike Introducer
Key is pressed, a popup box displays all the overstrikes which contain the last character typed: in the example below Ctrl+Bksp has been followed by Ctrl+h:

Note the fine (red) line under the ∆ in the Session window. This indicates that an
overstrike creation operation is in progress.
The input of the symbol ⍋ can be completed by pressing Ctr+m, or by moving the
selection up and down the pop-up list using Cursor-Up or Cursor-Down

Overstrikes do not require the OS introducer key (experimental):
With this option selected, the IME identifies characters which are part of a valid overstrike, and when such a character is entered into the session, begins an overstrike creation operation. This mode is experimental in the IME supplied with Version 13.2.
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Classic Edition Keyboard
The standard Version 13.2 Classic Edition keyboard tables are files supplied in the
aplkeys sub-directory named cc.din where cc is the standard 2-character country
code, e.g. uk.din.
Note that the standard tables do not support the entry of APL underscored characters
⍙ⒶⒷⒸⒹⒺⒻⒼⒽⒾⒿⓀⓁⓂⓃⓄⓅⓆⓇⓈⓉⓊⓋⓌⓍⓎⓏ.
The standard table supports two modes of use; traditional (mode 0) and unified
(mode 1). The keyboard starts in mode 1 and may be switched between modes by
clicking the Uni/Apl field in the status bar or by keying * on the Numeric-Keypad.

Unified Layout
The following picture illustrates the standard UK keyboard Unified layout.
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APL symbols are entered using the Ctrl and Ctrl+Shift keys as illustrated below.
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Traditional Layout
The following picture illustrates the standard UK keyboard Traditional layout.

APL symbols are entered using the Shift and Ctrl+Shift keys as illustrated below.
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Line-Drawing Symbols
Classic Edition includes 12 single-line graphics characters for drawing lines and
boxes. Line-drawing characters are entered using the keys on the numeric keypad in
conjunction with the Ctrl key as shown below. Num Lock must be on.
Normal

Ctrl

7

8

9

┌

┬

┐

4

5

6

├

┼

┤

1

2

3

└

┴

┘

0

.

│

─

Note:to accommodate other characters, line-drawing symbols are located in the nonprintable area of the font layout. Although these characters can normally be used in
output to the session (function: DISP in the UTIL workspace uses them), many
printer drivers and some display drivers will not display characters from these
positions in the font.
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Keyboard Shortcuts
The terms keyboard shortcut (Unicode Edition) and command (Classic Edition) are
used herein to describe a keystroke that generates an action, rather than one that
produces a symbol.

Unicode Edition
Unicode Edition provides a number of shortcut keys that may be used to perform
actions. For compatibility with Classic Edition and with previous Versions of Dyalog APL, these are identified by 2-character codes; for example the action to start the
Tracer is identified by the code <TC>, and mapped to user-configurable keystrokes.
In the Unicode Edition, Keyboard Shortcuts are defined using Options/Configure/Keyboard Shortcuts and stored in the Windows Registry. Note that the Unicode IME translate tables have definitions for the Keyboard Shortcuts too; these are
ignored by the interpreter, and are intended for use with terminal emulators being
used in conjunction with non-GUI versions of Dyalog APL.
To the right of the last symbol in the Language Bar is the Keyboard Shortcut icon
. If you hover the mouse over this icon, a pop-up tip is displayed to remind you of
your keyboard shortcuts as illustrated below.
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Classic Edition
Commands fall into four categories, namely cursor movement, selection, editing directives and special operations, and are summarised in the following tables. The input
codes in the first column of the tables are the codes by which the commands are identified in the Input Translate Table.
Table 1: Cursor Movement Commands
Input
Code

Keystroke

Description

LS

Ctrl+PgUp

Scrolls left by a page

RS

Ctrl+PgDn

Scrolls right by a page

US

PgUp

Scrolls up by a page

DS

PgDn

Scrolls down by a page

LC

Left Arrow

Moves the cursor one character position to the left

RC

Right Arrow

Moves the cursor one character position to the
right

DC

Down Arrow

Moves the cursor to the current character position
on the line below the current line

UC

Up Arrow

Moves the cursor to the current character position
on the line above the current line

UL

Ctrl+Home

Move the cursor to the top-left position in the
window

DL

Ctrl+End

Moves the cursor to the bottom-right position in
the window

RL

End

Moves the cursor to the end of the current line

LL

Home

Moves the cursor to the beginning of the current
line

LW

Ctrl+Left Arrow

Moves the cursor to the beginning of the word to
the left of the cursor

RW

Ctrl+Right
Arrow

Moves the cursor to the end of the word to the
right of the cursor

TB

Ctrl+Tab

Switches to the next session/edit/trace window

BT

Ctrl+Shift+Tab

Switches to the previous session/edit/trace window
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Table 2: Selection Commands
Input
Code

Keystroke

Description

Lc

Shift+Left Arrow

Extends the selection one character position to
the left

Rc

Shift+Right
Arrow

Extends the selection one character position to
the right

Lw

Ctrl+Shift+Left
Arrow

Extends the selection to the beginning of the
word to the left of the cursor

Rw

Ctrl+Shift+Right Extends the selection to the end of the word to
Arrow
the right of the cursor

Uc

Shift+Up Arrow

Extends the selection to the current character
position on the line above the current line

Dc

Shift+Down
Arrow

Extends the selection to the current character
position on the line below the current line

Ll

Shift+Home

Extends the selection to the beginning of the
current line

Rl

Shift+End

Extends the selection to the end of the current
line

Ul

Ctrl+Shift+Home

Extends the selection to the beginning of the first
line in the window

Dl

Ctrl+Shift+End

Extends the selection to the end of the last line in
the window

Us

Shift+PgUp

Extends the selection up by a page.

Ds

Shift+PgDn

Extends the selection down by a page
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Table 3: Editing Directives
Input
Code

Keystroke

Description

DI

Delete

Deletes the selection

DK

Ctrl+Delete

Deletes the current line in an Edit window.
Deletes selected lines in the Session Log.

CT

Shift+Delete

Removes the selection and copies it to the
clipboard

CP

Ctrl+Insert

Copies the selection into the clipboard

FD

Ctrl+Shift+Enter Reapplies the most recent undo operation

BK

Ctrl+Shift+Bksp Performs an undo operation

PT

Shift+Insert

Copies the contents of the clipboard into a
window at the location selected

OP

Ctrl+Shift+Insert

Inserts a blank line immediately after the current
one (editor only)

HT

Tab

Indents text

TH

Shift+Tab

Removes indentation

RD

Keypad-slash

Reformats a function (editor only)

TL

Ctrl+Alt+L

Toggles localisation of the current name

GL

Ctrl+Alt+G

Go to [line]

AO

Ctrl+Alt+,

Add Comments

DO

Ctrl+Alt+.

Delete Comments
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Table 4: Special Operations
Input
Code

Keystroke

Description

IN

Insert

Insert on/off

LN

Keypad-minus

Line numbers on/off

ER

Enter

Execute

ED

Shift+Enter

Edit

TC

Ctrl+Enter

Trace

EP

Esc

Exit

QT

Shift+Esc

Quit
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The Session Colour Scheme
Within the Development Environment, different colours are used to identify different
types of information. These colours are normally defined by registry entries and may
be changed using the Colour Configuration dialog box as described later in this chapter. In the Classic Edition, colours may alternatively be defined in the Output Translate Table (normally WIN.DOT). This table recognises up to 256 foreground and 256
background colours which are referenced by colour indices 0-255. These colour
indices are mapped to physical colours in terms of their Red, Green and Blue intensities (also 0-255). Foreground and background colours are specified independently
as Cnnn or Bnnn. For example, the following entry in the Output Translate Table
defines colour 250 to be red on magenta.
C250: 255 0 0
+ Red foreground
B250: 255 0 255 + Magenta background

The first table below shows the colours used for different session components. The
second table shows how different colours are used to identify different types of data
in edit windows.
Table 5: Default Colour Scheme - Session
Colour

Used for

Default

249

Input and marked lines

Red on White

250

Session log

Black on White

252

Tracer : Suspended Function

Yellow on Black

253

Tracer : Pendent Function

Yellow on Dark Grey

245

Tracer : Current Line

White on Red

Table 6: Default Colour Scheme Edit windows
Colour

Array Type

Editable

Default

236

Simple character matrix

Yes

Green on Black

239

Simple numeric

No

White on Dk Grey

241

Simple mixed

No

Cyan on Dk Grey

242

Character vector of vectors

Yes

Cyan on Black

243

Nested array

No

Cyan on Dk Grey

245

⎕OR object

No

White on Red

248

Function or Operator

No

White on Dk Cyan

254

Function or Operator

Yes

White on Blue
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Syntax Colouring in the Session
As an adjunct to the overall Session Colour Scheme, you may choose to apply a syntax colouring scheme to the current Session Input line(s). You may also extend syntax colouring to previously entered input lines, although this only applies to input
lines in the current session; syntax colouring information is not remembered in the
Session Log.
Syntax colouring may be used to highlight the context of names and other elements
when the line was entered. For example, you can identify global names and local
names by allocating them different colours.
"Colour Selection Dialog" on page 157 for further details.
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The Session Window
The primary purpose of the session window is to provide a scrolling area within
which you may enter APL expressions and view results. This area is described as the
session log. Normally, the session window will have a menu bar at the top with a
tool bar below it. At the bottom of the session window is a status bar. However, these
components of the session may be extensively customised and, although this chapter
describes a typical session layout, your own session may look distinctly different. A
typical Session is illustrated below.

A typical Session window

Window Management
When you start APL, the session is loaded from the file specified by the session_file
parameter. The position and size of the session window are defined by the Posn and
Size properties of the Session object ⎕SE, which will be as they were when the session file was last saved.
The name of the active workspace is shown in the title bar of the window, and
changes if you rename the workspace or )LOAD another.
You can move, resize, minimise or maximise the Session Window using the standard
Windows facilities.
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In addition to the Session Window itself, there are various subsidiary windows
which are described later in the Chapter. In general, these subsidiary windows may
be docked inside the Session window, or may be stand-alone floating windows. You
may dock and undock these windows as required. The standard Session layout illustrated above, contains docked Editor, Tracer and SIStack windows.
Note that the session window is only displayed when it is required, i.e. when APL
requests input from or output to the session. This means that end-user applications
that do not interact with the user through the session, will not have an APL session
window.

Docking
Nearly all of the windows used in the Dyalog APL IDE may be docked in the Session window or be stand-alone floating windows. When windows are docked in the
Session, the Session window is split into resizable panes, separated by splitters. The
following example, using the Status window, illustrates the principles involved. (The
use of the Status window is described later in this Chapter.)
To start with, the Status window is hidden. You may display it by selecting the
Status menu item from the Tools menu. It initially appears as a floating (undocked)
window as shown below.
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If you press the left mouse button down over the Status window title bar, and drag it,
you will find that when the mouse pointer is close to an edge of the Session window,
the drag rectangle indicates a docking zone as shown below. This indicates the space
that the window will occupy if you now release the mouse button to dock it.

Chapter 2: The APL Environment

85

The next picture shows the result of the docking operation. The Session window is
now split into 2 panes, with the Status window in the upper pane and the Session log
window in the lower pane. You can resize the panes by dragging with the mouse.
You will notice that a docked window has a title bar (in this case, the caption is
Status) and 3 buttons which are used to Minimise, Maximise and Close the docked
window.
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The next picture shows the result of minimising the Status window pane. All that
remains of it is its title bar. The Minimise button has changed to a Restore button,
which is used to restore the pane to its original size.
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You can pick up a docked window and then re-dock it along a different edge of the
Session as illustrated below.

Docking the Status window along the left edge of the Session causes the Session window to be split into two vertical panes. Notice how the title bar is now drawn vertically.
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If you click the right mouse button over any window, its context menu is displayed.
If the window is dockable, the context menu contains the following options:
Undock

Undocks the docked window. The window is displayed at
whatever position and size it occupied prior to being docked.

Hide
Caption

Hides the title bar of the docked window,

Specifies whether the window is currently dockable or is locked
Dockable in its current state. You can use this to prevent the window from
being docked or undocked accidentally.
The last picture shows the effect of using Hide Caption to remove the title bar. In this
state, you can resize the pane with the mouse, but the Minimise, Maximise and Close
buttons are not available. However, you can restore the object's title bar using its context menu.
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Entering and Executing Expressions
Introduction
The session contains the input line and the session log. The input line is the last line
in the session, and is (normally) the line into which you type an expression to be evaluated.
The session log is a history of previously entered expressions and the results they
produced.
If you are using a log file, the Session log is loaded into memory when APL is started
from the file specified by the log_file parameter. When you close your APL session,
the Session log is written back out to the log file, replacing its previous contents.
In general you type an expression into the input line, then press Enter (ER) to run it.
After execution, the expression and any displayed results become part of the session
log.
You can move around in the session using the scrollbar, the cursor keys, and the
PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the beginning of the top-line in the Log and Ctrl+End (DL) moves the cursor to the end of the
last (i.e. the current) line in the session log. Home (LL) and End (RL) move the cursor
to the beginning and end respectively of the line containing the cursor.
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Language Bar
The Language Bar is an optional window which is initially docked to the Session
Window, to make it easy to pick APL symbols without using the keyboard.
If you hover the mouse pointer over a symbol in the APL Language Bar, a pop-up tip
is displayed to remind you of its usage. If you click on a symbol in the Language Bar,
that symbol is inserted at the cursor in the current line in the Session.

Auto Complete
As you start to enter characters in an APL expression, the Auto Complete suggestions
pop-up window (AC for short) offers you a choice based upon the characters you
have already entered and the current context.
For example, if you enter a ⎕, AC displays a list of all the system functions and variables. If you then enter the character r, the list shrinks to those system functions and
variables beginning with the letter r, namely ⎕refs, ⎕rl, and ⎕rtl. Instead of
entering the remaining characters, you may select the appropriate choice in the AC
list. This is done by pressing the right cursor key or (in PocketAPL) by tapping the
choice in the list.
If you begin to enter a name, AC will display a list of namespaces, variables, functions, operators that are defined in the current namespace. If you are editing a function, AC will also include names that are localised in the function header.
If the current space is a GUI namespace, the list will also include Properties, Events
and Methods exposed by that object.
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As an additional refinement, AC remembers a certain number of previous auto complete operations, and uses this information to highlight the most recent choice you
made.
For example, suppose that you enter the two characters )c. AC offers you )clear
thru' )cs, and you choose )cs from the list. The next time you enter the two characters )c, AC displays the same list of choices, but this time )cs is pre-selected.
You can disable or customise Auto Completion from the Auto Complete page in the
Configuration dialog box which is described later in this chapter.

Executing an Expression
To execute an expression, you type it into the input line, then press Enter (ER). Alternatively, you can select Execute from the Action menu. Following execution, the
expression and any displayed results become part of the session log.
Instead of entering a new expression in the input line, you can move back through
the session log and re-execute a previous expression (or line of a result) by simply
pointing at it with the cursor and pressing Enter. Alternatively, you can select
Execute from the Action menu. You may alter the line before executing it. If you do
so, it will be displayed using colour 249 (Red on White), the same as that used for the
input line. When you press Enter the new line is copied to the input line prior to
being executed. The original line is restored and redisplayed in the normal session
log colour 250 (Black on White).
An alternative way to retrieve a previously entered expression is to use
Ctrl+Shift+Bksp (BK) and Ctrl+Shift+Enter (FD). These commands cycle backwards
and forwards through the input history, successively copying previously entered
expressions over the current line. When you reach the expression you want, simply
press Enter to re-run it. These operations may also be performed from the Edit menu
in the session window.

Executing Several Expressions
You can execute several expressions, by changing more than one line in the session
log before pressing Enter. Each line that you change will be displayed using colour
249 (Red on White). When you press Enter, these marked lines are copied down and
executed in the order they appear in the log.
Note that you don't actually have to change a line to mark it for re-execution; you
can mark it by overtyping a character with the same character, or by deleting a leading space for instance.
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It is also possible to execute a contiguous block of lines. To do this, you must first
select the lines (by dragging the mouse or using the keyboard) and then copy them
into the clipboard using Shift+Delete (CT) or Ctrl+Insert (CP). You then paste them
back into the session using Shift+Insert (PT). Lines pasted into the session are always
marked (Red on White) and will therefore be executed when you press Enter. To
execute lines from an edit window, you use a similar procedure. First select the lines
you want to execute, then cut or copy the selection to the clipboard. Then move to
the session window and paste them in, then press Enter to execute them.

Session Print Width (PW)
Throughout its history, APL has used a system variable ⎕PW to specify the width of
the user's terminal or screen. Session output that is longer than ⎕PW is automatically
wrapped and split into multiple lines on the display. This feature of APL was
designed in the days of hard-copy terminals and has become less relevant in modern
Windows environments.
Dyalog APL continues to support the traditional use of ⎕PW, but also provides an
alternative option to have the system wrap Session output according to the width of
the Session Window. This behaviour may be selected by checking the Auto PW
checkbox in the Session tab of the Configuration dialog box.

Using Find/Replace in the Session
The search and replace facilities work not just in the Editor as you would expect, but
also in the Session. For example, if you have just entered a series of expressions
involving a variable called SALES and you want to perform the same calculations
using NEWSALES, the following commands will achieve it:
Enter SALES in the Find box, and NEWSALES in the Replace box. Now click the
Replace All button. You will see all occurrences of SALES change to NEWSALES.
Furthermore, each changed line in the session becomes marked (Red on White). Now
click on the session and press Enter (or select Execute from the Action menu).
Once displayed, the Find or Find/Replace dialog box remains on the screen until it is
either closed or replaced by the other. This is particularly convenient if the same operations are to be performed over and over again, and/or in several windows. Find and
Find/Replace operations are effective in the window that previously had the focus.
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Value Tips
If you hover the mouse pointer over a name in the Session or Debugger window, APL
will display a pop-up window containing the value of the symbol under the mouse
pointer.
For example, in the following picture the mouse pointer was moved over the name of
the variable HW in the Session window.
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The next picture illustrates the Value Tip displayed when the mouse is hovered over
the name of the variable MAT.
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Similarly, if you hover the mouse pointer over the name of a function, the system displays the body of the function as a pop-up, as illustrated below.
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Configuring Value Tips
You may enable/disable Value Tips and select other options from the General tab of
the Configuration dialog box as shown below.
You may experiment by changing the value of the delay before which Value Tips are
displayed, until you find a comfortable setting.
Note that the colour scheme used to display the Value Tip for a function need not
necessarily be the same colour scheme as you use for the function editor.
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Array Editor
The Array Editor1 allows you to edit arbitrary arrays. It is invoked by either:
l

l

l

Clicking the
icon in the Session toolbar when the mouse pointer is over
the name of a suitable variable.
Calling the User Command ]aedit, specifying the name of a suitable variable as its argument.
Calling it directly via ⎕NA

The Array Editor draws data using a format that is similar to the output of the
DISPLAY function. For example:

1Array Editor Version 1 Release 1 © Copyright davidliebtag.com 2012, 2013
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Documentation
Full documentation for the Array Editor, including a list of the keystrokes it uses, is
available from the Help menu in the Array Editor's window.

Supported Arrays
The Array Editor supports arrays that consist solely of characters and/or numbers.
You may not use it to edit an array that contains an object reference or a ⎕OR.

Reject unsupported data
The way that the Arrays Editor reacts to unsupported arrays is determined by the
value of the Reject unsupported data option which is accessed by the
Options/Reject unsupported data menu item on the Array Editor menubar.
If this is set to true (the default), and you try to edit an array containing an object reference, the Array Editor will refuse the start and the system will generate an error message.
⎕SE.NumEd.numed: Unexpected error in array editor:
DOMAIN ERROR Argument contained data that is neither simple or
nested.

If this option is cleared, the Array editor will start but you will not be able to do anything. It is therefore advisable that you leave this option set.

Notes
l

l
l
l
l
l

The Array Editor is supplied only with Unicode Editions of Dyalog
APL/W. Please visit www.davidliebtag.com for details about availability
and support for Classic Editions of Dyalog APL/W.
Namespaces are not supported.
Internal representations returned by ⎕OR are not supported.
Only one instance of the Array Editor may be executed at a time.
All calls to interpreter primitives use a value of 3 for ⎕ML.
Negative numbers must be represented using high minus signs. For example,
¯3 not -3.

Chapter 2: The APL Environment

Implementation
The Array Editor is implemented by a DLL named dlaedit.dll (32-bit) or
dlaedit64.dll (64-bit).
The DLL exports two functions: DyalogEditArray and
DyalogEditArrayTitle. The latter is used when you click the the
icon in
the Session toolbar (via the APL function ⎕SE.NumEd.numed) and by the User
Command ]aedit

Calling the Array Editor Directly
If you wish to use the Array Editor directly, you may do so as follows using ⎕NA1.
For both DyalogEditArray and DyalogEditArrayTitle the first argument
is the array to be edited, while the second argument is a place holder and should
always be 0
For DyalogEditArrayTitle the 3rd argument is a character vector whose contents are displayed in the caption of the array editor window.
The result is the newly altered array.

Examples
⎕NA'dlaedit.dll|DyalogEditArray <pp >pp'
⎕NA'dlaedit.dll|DyalogEditArrayTitle <pp >pp <0C2[]'

⍝ 32-bit
⍝ 32-bit

⎕NA'dlaedit64.dll|DyalogEditArray <pp >pp'
⍝ 64-bit
⎕NA'dlaedit64.dll|DyalogEditArrayTitle <pp >pp <0C2[]'⍝ 64-bit

New←DyalogEditArray Old 0
New←DyalogEditArrayTitle Old 0 Name

1Note that these are not standard ⎕NA calls, but rather use an extension to ⎕NA, called Direct

Workspace Access. Dyalog does not intend to make this feature generally available at present: if
you are interested in this feature please contact sales@dyalog.com.
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SharpPlot Graphics Tools
Introduction
Included with Dyalog APL (32-bit Windows versions only with the Microsoft .Net
Framework Version 2.0 or later installed) is the SharpPlot graphics library which is
part of the RainPro graphics package..
The Session includes 4 buttons which use SharpPlot to generate simple graphical pictures of the contents of the Current Object (identified by the name under or to the left
of the cursor).
For example, if you have a numerical matrix in a variable called MAT, you can plot it
by first positioning the cursor on the name MATin the Session window, and then clicking one of the 4 graphical buttons in the Session toolbar.

Data Structures
The charting function can plot variables with the following data structures:
l
l
l
l

l

l

a simple numeric vector
a vector of simple numeric vectors
a simple numeric matrix
a matrix whose first row contains simple character vectors and whose other
elements are simple numerics. In bar and line charts, the column headings in
row 1 are used as x-axis labels.
a matrix whose first column contains simple character vectors and whose
other elements are simple numerics. In bar and line charts, the row headings
in column 1 are used as legends to annotate the different series.
a matrix whose first row and first column both contain simple character vectors and whose other elements are simple numerics. In bar and line charts,
the column headings in row 1 are used as x-axis labels, and the row headings in column 1 are used as legends annotate the different series.
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Example: Bar Chart
Wine_Prices
1961 1964 1966
Lafite 8800 1342 1210
Latour 15400 2357.5 4600
Margaux 5980 672.5 920
Mouton Rothschild 6710 713 2070
Haut-Brion 13225 1840 1323
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Example: Line Chart
First_Growths
1961 1964 1966 1970 1975 1976 1978 ...
Lafite 8800 1342 1210 605 1380 2070 920 ...
Latour 15400 2357.5 4600 2760 1552 978 1058 ...
Margaux 5980 672.5 920 632 900 800 1208 ...

Implementation
The SharpPlot tools are implemented by four buttons in the Session toolbar. Each button has a Select callback which runs the function ⎕SE.Chart.DoChart. This runs
⎕SE.Chart.Do which constructs and then runs a function named
⎕SE.Chart.MyChart.
⎕SE.Chart.MyChart uses an instance of the SharpPlot graphics class to produce
a chart of your data, which it saves as a temporary file. It then calls the SharpPlot
viewer to display the file on your screen.
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SharpPlot is a library of graphical subroutines, (originally written in APL and
machine-translated into C#) which is implemented as a .Net Namespace named
Causeway and supplied in \bin\sharpplot.dll in the Dyalog program directory.

Notes
Although ⎕SE.Chart.MyChart is overwritten by successive uses of the graphical
buttons, it is deliberately not erased each time. This allows you to use MyChart as a
simple template to develop your own custom graphics function.
The image is stored in Microsoft Enhanced Metafile Format in a temporary file whose
name and location are generated automatically. The system does not delete the temporary file after use. For further details, See GetTempFileName in the Windows
documentation..
The default program used to display the EMF file is SharpView.exe. You can opt
to use a different EMF viewer by setting the Charts\ViewCMDregistry key to name
another program, such as Windows Picture and Fax Viewer.
An attempt to plot the contents of a variables with an unsupported data structure (see
above) is handled entirely by error trapping and will result in an error message box
and perhaps messages in the Status window.

The Session GUI Hierarchy
As distributed, the Session object ⎕SE contains two CoolBar objects. The first,
named ⎕SE.cbtop runs along the top of the Session window and contains the toolbars. The second, named ⎕SE.cbbot, runs along the bottom of the Session windows and contains the statusbars.
The menubar is implemented by a MenuBar object named ⎕SE.mb.
The toolbars in ⎕SE.cbtop are implemented by four CoolBand objects, bandtb1,
bandtb2, bandtb3 and bandtb4 each containing a ToolControl named tb.
The statusbars in ⎕SE.cbbot, are implemented by two CoolBand objects ,
bandtb1 and bandtb2, each containing a StatusBar named sb.
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The Session MenuBar
The Session MenuBar (⎕SE.mb) contains a set of menus as follows.

The File Menu
The File menu (⎕SE.mb.file) provides a means to execute those APL System
Commands that are concerned with the active and saved workspaces. The contents of
a typical File menu and the operations they perform are illustrated below.
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Table 7: File Menu Operations
Item

Action

Description

New

[WSClear]

Prompts for confirmation, then clears the
workspace

Open

[WSLoad]

Prompts for a workspace file name, then loads
it

Copy

[WSCopy]

Prompts for a workspace file name, then
copies it

Save

[WSSave]

Saves the active workspace

Save As

[WSSaveas]

Prompts for a workspace file name, then saves
it

Export

[Makeexe]

Creates a bound executable, an OLE Server,
an ActiveX Control, or a .Net Assembly

Export to
Memory

[MakeMemory
Assembly]

Creates an in-memory .Net Assembly

Drop

[WSDrop]

Prompts for a workspace file name, then erases
it

Print
Setup

[PrintSetup] Invokes the print set-up dialog box

Continue

[Continue]

Saves the active workspace in
CONTINUE.DWS and exits APL

Exit

[Off]

Exits APL
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Export
The Export… menu item allows you to create a bound executable, an OLE Server (inprocess or out-of-process), an ActiveX Control or a .Net Assembly.
The dialog box used to create these various different files offers selective options
according to the type of file you are making. The system detects which of these types
is most appropriate from the objects in your workspace. For example, if your workspace contains an ActiveXControl namespace, it will automatically select the
ActiveX Control option.
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The Create bound file dialog box contains the following fields. These will only be
present if applicable to the type of bound file you are making.
Item

Description

File name

Allows you to choose the name for your bound file The name
defaults to the name of your workspace with the appropriate
extension.

Save as
type

Allows you to choose the type of file you wish to create.

If this is checked, your application file will be bound with the
Runtime
Run-Time DLL. If not, it will be bound with the Development
application DLL. The latter should normally only be used to permit
debugging.
Check this box if you want your executable to run as a console
Console
application. This is appropriate only if the application has no
application
graphical user interface.
Enable
Native
Look and
Feel

If checked, Native Look and Feel will be enabled for your bound
file.

Icon file

Allows you to associate an icon with your executable. Type in
the pathname, or use the Browse button to navigate to an icon
file.

Command
line

For an out-of-process COM Server, this allows you to specify the
command line for the process. For a bound executable, this
allows you to specify command-line parameters for the
corresponding Dyalog APL DLL.
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Pressing the Version button brings up the Version Information dialog box shown
below.
This dialog box allows you to specify versioning information that will be stored in
your bound file.
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The Edit Menu
The Edit menu (⎕SE.mb.edit) provides a means to recall previously entered input
lines for re-execution and for copying text to and from the clipboard.

Unicode Edition

Classic Edition

Table 8: Edit menu operations
Item

Action

Description

Back

[Undo]

Displays the previous input line. Repeated
use of this command cycles back through the
input history.

Forward [Redo]

Displays the next input line. Repeated use of
this command cycles forward through the
input history.

Clear

[Delete]

Clears the selected text

Copy

[Copy]

Copies the selection to the clipboard

[Paste]

Pastes the text contents of the clipboard into
the session log at the current location. The
new lines are marked and may be executed
by pressing Enter.

Paste

Same as Paste, but gets the Unicode text from
Paste
[Pasteunicode] the clipboard and converts to ⎕AV. Classic
Unicode
Edition only.
Paste
Non[Pasteansi]
Unicode
Find

[Find]

Replace [Replace]

Same as Paste, but gets the ANSI text from
the clipboard and converts to ⎕AV. Classic
Edition only.
Displays the Find dialog box
Displays the Find/Replace dialog box
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The View Menu
The View menu (⎕SE.mb.view) toggles the visibility of the Session Toolbar, StatusBar, and Language Bar.

Table 9: View menu operations
Item

Action

Description

Toolbar

Shows/Hides Session toolbars

Statusbar

Shows/Hides Session statusbars

LanguageBar

Shows/Hides Language Bar

The Window Menu
This contains a single action (⎕SE.mb.windows) which is to close all of the Edit
and Trace windows and the Status window.

Table 10: Window menu operations
Item

Action

Description

Close all Windows

[CloseAll]

Closes all Edit and Trace windows

Note that [CloseAll] removes all Trace windows but does not reset the State Indicator.
In addition, the Window menu will contain options to switch the focus to any subsidiary windows that are docked in the Session as illustrated above.
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The Session Menu
The Session menu (⎕SE.mb.session) provides access to the system operations
that allow you to load a session (⎕SE) from a session file and to save your current session (⎕SE) to a session file. If you use these facilities rarely, you may wish to move
them to (say) the Options menu or even dispense with them entirely.

Table 11: Session menu operations
Item Action

Description

Open [SELoad]

Prompts for a session file name, then loads the session
from it, replacing the current one. Sets the File
property of ⎕SE to the name of the file from which the
session was loaded.

Save [SESave]

Saves the current session (as defined by ⎕SE) to the
session file specified by the File property of ⎕SE.

Prompts for a session file name, then saves the current
Save
[SESaveas] session (as defined by ⎕SE) in it. Resets the File
As
property of ⎕SE.

Chapter 2: The APL Environment

112

The Log Menu
The Log menu (⎕SE.mb.log) provides access to the system operations that manipulate Session log files.

Table 12: Log menu operations
Item Action
New

[NewLog]

Description
Prompts for confirmation, then empties the current
Session log.

Open [OpenLog]

Prompts for a Session log file, then loads it into
memory, replacing the current Session log

Save [SaveLog]

Saves the current Session log in the current log file,
replacing its previous contents

Save
Prompts for a file name, then saves the current
[SaveLogAs]
As
Session log in it.
Print [PrintLog]

Prints the contents of the Session log.

The Action Menu
The Action menu (⎕SE.mb.action) may be used to perform a variety of operations
on the current object or the current line. The current object is the object whose name
contains the cursor. The current line is that line that contains the cursor. The Edit,
Copy Object, Paste Object and Print Object items operate on the current object. For
example, if the name SALES appears in the session and the cursor is placed somewhere within it, SALES is the current object and will be copied to the clipboard by
selecting Copy object or opened up for editing by selecting Edit.
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Execute runs the current line; Trace traces it.

Unicode Edition

Classic Edition

Table 13: Action menu operations
Item

Action

Description

Edit

[Edit]

Edit the current object

Trace

[Trace]

Executes the current line under the control of the
Tracer

Execute [Execute]

Executes the current line

Copy
Object

[ObjCopy]

Copies the contents of the current object to the
clipboard.

Paste
Object

[ObjPaste]

Pastes the contents of the clipboard into the
current object, replacing its previous value

Print
Object

[ObjPrint]

Prints the current object.

Clear
Stops

[ClearTSM]

Clears all ⎕STOP, ⎕MONITOR and ⎕TRACE
settings

Interrupt [Interrupt] Generates a weak interrupt
Reset

[Reset]

Performs )RESET
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The Options Menu
The Options menu (⎕SE.mb.options) provides configuration options.

Table 14: Options menu operations
Item

Action

Description

Expose GUI
Properties

[ExposeGUI]

Exposes the names of properties,
methods and events in GUI objects

Expose Root
Properties

[ExposeRoot]

Exposes the names of the properties,
methods and events of the Root object

Expose
Session
Properties

[ExposeSession]

Exposes the names of the properties,
methods and events of ⎕SE

Line Numbers [LineNumbers]

Toggle the display of line numbers in
edit and trace windows on/off

Configure

[Configure]

Displays the Configuration dialog
box

Colours

[ChooseColors]

Displays the Colours Selection dialog
box

The values associated with the Expose GUI, Expose Root and Expose Session options
reflect the values of these settings in your current workspace and are saved in it.
When you change these values through the Options menu, you are changing them in
the current workspace only.
The default values of these items are defined by the parameters default_wx, PropertyExposeRoot and PropertyExposeSE which may be set using the Object Syntax
tab of the Configuration dialog.
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The Tools Menu
The Tools menu (⎕SE.mb.tools) provides access to various session tools and
dialog boxes.

Unicode Edition

Classic Edition

Table 15: Tools Menu Operations
Item

Action

Description

Explorer

[Explorer]

Displays the Workspace Explorer tool

Search

[WSSearch]

Displays the Workspace Search tool

Status

[Status]

Displays or hides the Status window

AutoStatus [AutoStatus]

Toggle; if checked, causes the Status
window to be displayed when a new
message is generated for it

Event
Viewer

[EventViewer] Displays or hides the Event Viewer

Properties

[ObjProps]

Keyboard
Viewer

Displays a property sheet for the current
object
Displays the APLTeam Keyboard Viewer.
Classic Edition only.
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The Threads Menu
The Threads menu (⎕SE.mb.threads) provides access to various session tools
and dialog boxes.

Table 16: Threads Menu Operations
Item

Action

Description

Show
Threads

[Threads]

Displays the Threads Tool

Show Stack

[Stack]

Displays the SI Stack window

Show Token
Pool

[TokenPool]

Displays the Token Pool
window

Auto Refresh [ThreadsAutoRefresh]

Refreshes the Threads Tool on
every thread switch

Pause on
Error

[ThreadsPauseOnError] Pauses all threads on error

Pause all
Threads

[ThreadsPauseAll]

Pauses all threads

Resume all
Threads

[ThreadsResumeAll]

Resumes all threads

Restart all
Threads

[ThreadsResrartAll]

Restarts all threads
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The Help Menu
The Help menu (⎕SE.mb.help) provides access to the help system which is packaged as a single Microsoft HTML Help compiled help file named
help\dyalog.chm.

Table 17: Help menu operations
Label

Action

Description

Documentation
[Decanter]
Center

Opens your web browser on
help\index.html which displays an
index to the on-line PDF documentation
and selected internet links.

Latest
Enhancements

Opens help\dyalog.chm, starting at
the first topic in the Version 13.2
Release Notes section. Note that
previous Release Notes are also
included for your convenience.

[Reunites]

Language Help [Lang Help]

Opens help\dyalog.chm, starting at
the first topic in the Language Reference
section.

Gui Help

[GuiHelp]

Opens help\dyalog.chm, starting at
the first topic in the Object Reference
section.

Dyalog Web
Site

[DyalogWeb]

Opens your web browser on the Dyalog
home page.

Email Dyalog

Opens your email client and creates a
new message to Dyalog Support, with
[DyalogEmail]
information about the Version of
Dyalog APL you are running.

About Dyalog
APL

[About]

Displays an About dialog box
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Session Pop-Up Menu
The Session popup menu (⎕SE.popup) is displayed by clicking the right mouse button anywhere in the Session window. If the mouse pointer is over a visible object
name, the popup menu allows you to edit, print, delete it or view its properties. Note
that the name of the pop-up menu is specified by the Popup property of ⎕SE.

Table 18: Session popup menu operations
Item

Action

Description

Edit

[Edit]

Edits the current object

Print

[ObjPrint]

Prints the current object

Delete

[ObjDelete]

Erases the current object

Properties [GUIHelp]

Displays the Object Properties dialog box
for the current object

Chapter 2: The APL Environment

119

Item

Action

Description

Help

[Help]

Displays the help topic associated with the
current object or the APL symbol under the
cursor

Line
Numbers

[LineNumbers]

Toggles line numbers on/off

Copy

[Copy]

Copies the selection to the clipboard

Paste

[Paste]

Pastes the text contents of the clipboard into
the session log at the current location. The
new lines are marked and may be executed
by pressing Enter.

Paste
Unicode

[Pasteunicode]

Same as Paste, but gets the Unicode text
from the clipboard and converts to ⎕AV

Paste
NonUnicode

[Pasteansi]

Same as Paste, but gets the ANSI text from
the clipboard and converts to ⎕AV

Explorer

[Explorer]

Displays the Workspace Explorer

Search

[WSSearch]

Displays the Find Objects tool

Event
Viewer

[EventViewer]

Displays the Event Viewer

Threads

[Threads]

Displays the Threads Tool

Status

[Status]

Displays the Status window

Colours

[ChooseColors] Displays the Colour Selection dialog

Interrupt

[Interrupt]

Generates a weak interrupt

Open
link

[OpenLink]

Opens the URL or link using the appropriate
program. See "Underline URLs and links" on
page 128

Copy
link to
[Copy_Link]
clipboard

Copies the URL or link to the Windows
Clipboard. See "Underline URLs and links"
on page 128
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The Session Toolbars
The Session toolbars are contained by four separate CoolBand objects, allowing you
to configure their order in whichever way you choose.

The Session tool bars
The bitmaps for the buttons displayed on the session tool bar are implemented by
three ImageList objects owned by the CoolBar ⎕SE.cbtop. These represent the
ToolButton images in their normal, highlighted and inactive states and are named
iln, ilh and ili respectively.
These images derive from three bitmap resources contained in dyalog.exe named
tb_normal, tb_hot and tb_inactive. The statements that create these ImageList object in function BUILD_SESSION in BUILDSE.DWS are as follows.
:With '⎕SE.cbtop'
'iln'⎕WC'ImageList'('MapCols' 0)('Masked' 1)
'iln.bm'⎕WC'Bitmap'('' 'tb_normal')('MaskCol'(192 192
192))
'ilh'⎕WC'ImageList'('MapCols' 0)('Masked' 1)
'ilh.bm'⎕WC'Bitmap'('' 'tb_hot')('MaskCol'(192 192
192))
'ili'⎕WC'ImageList'('MapCols' 0)('Masked' 1)
'ili.bm'⎕WC'Bitmap'('' 'tb_inactive')('MaskCol'(192
192 192))
:EndWith
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Workspace (WS) Operations
Clear Workspace

Load Workspace

Copy Workspace

Save Workspace

Re-Export
Workspace

Print Workspace

Executes the system operation [WSClear] which asks
for confirmation, then clears the workspace.
Executes the system operation [WSLoad] which
displays a file selection dialog box and loads the
selected workspace.
Executes the system operation [WSCopy] which
displays a file selection dialog box and copies the
(entire) selected workspace
Executes the system operation [WSSaveas] which
displays a file selection dialog box and saves the
workspace in the selected file.
Executes the system operation [REExport] which reexports the workspace using the settings, parameters and
options that were previously selected using the Create
Bound File dialog.
Executes the system operation [PrintFnsInNS] that
prints all the functions and operators in the current
namespace.
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Object Operations
Copy Object

Executes the system operation [ObjCopy] which
copies the contents of the current object to the
clipboard.

Paste Object

Executes the system operation [ObjPaste] which
copies the contents of the clipboard into the current
object, replacing its previous value.

Print Object

Executes the system operation [ObjPrint] that prints
the current object.

Edit Object

Executes the system operation [Edit] which edits the
current object using the standard system editor.

Edit Array

Executes a defined function in ⎕SE that edits the
current object using the Array Editor (Unicode Edition)
or a spreadsheet-like interface based upon the Grid
object (Classic Edition). See "Array Editor" on page 97.

Barchart

Executes a defined function in ⎕SE that displays the
value of the current object in a Barchart.

Linechart

Executes a defined function in ⎕SE that that displays
the value of the current object in a Linechart.

Piechart

Executes a defined function in ⎕SE that that displays
the value of the current object in a Piechart.

Scatterplot

Executes a defined function in ⎕SE that that displays
the value of the current object in a Scatterplot.
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Tools
Explorer

Search

Line Numbers

Clear all Stops

Executes the system operation [Explorer] which
displays the Workspace Explorer tool.
Executes the system operation [WSSearch] which
displays the Workspace Search tool.
Executes the system operation [LineNumbers] which
toggles the display of line numbers in edit and trace
windows on and off.
Executes the system operation [ClearTSM] which
clears all ⎕STOP, ⎕MONITOR and ⎕TRACE settings

Edit Operations
Copy Selection

Paste Selection

Recall Last
Recall Next

Executes the system operation [Copy] which copies
the selected text to the clipboard.
Executes the system operation [Paste] which pastes
the text in the clipboard into the current window at the
insertion point.
Executes the system operation [Undo]which recalls the
previous input line from the input history stack
Executes the system operation [Redo] which recalls
the next input line from the input history stack.
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Session Operations
Load Session

Executes the system operation [SELoad] which
displays a file selection dialog box and loads the
selected Session File.
Selects the font to be used in the Session window.

Select Font

Select Font Size

Selects the size of the font to be used in the Session
window.
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The Session Status Bar
The session status bar is represented by two CoolBands each of which contains a StatusBar object. There are a number of StatusFields as illustrated below. Your own
status bar may be configured differently.

Classic Edition

Unicode Edition
The StatusField objects owned by the session StatusBar may have special values of
Style, which are used for operations relevant only to the Session. These styles are summarised in the tables shown below.
Table 19: Session status fields : first row
StatusField Style

Description

hint

None

Displays hints for the session objects, or "Ready..."
when APL is waiting for input

insrep

InsRep

Displays the mode of the Insert key (Ins or Rep)

mode

Displays the keyboard mode. This is applicable only
to a multi-mode keyboard. The text displayed is
KeyMode
defined by the Mn= string in the Input Table.
Classic Edition Only.

num

NumLock

Indicates the state of the Num Lock key. Displays
"NUM" if Num Lock is on, blank if off.

caps

CapsLock

Indicates the state of the Caps Lock key. Displays
"Caps" if Caps Lock is on, blank if off.

pause

Pause

Displays a flashing red "Pause" message when the
Pause key is used to halt session output
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Table 20: Session status fields : second row
StatusField Style

Description

curobj

CurObj

Displays the name of the current object (the name
last under the input cursor)

tc

ThreadCount

Displays the number of threads currently running
(minimum is 1)

dqlen

DQLen

Displays the number of events in the APL event
queue

trap

Trap

Turns red if ⎕TRAP is set

si

SI

Displays the length of ⎕SI. Turns red if non-zero

io

IO

Displays the value of ⎕IO. Turns red if ⎕IO is not
equal to the value of the default_io parameter

ml

ML

Displays the value of ⎕ML. Turns red if ⎕ML is not
equal to the value of the default_ml parameter

Toggle Status Fields
In the default Session files distributed with this release, the Statusfields used to display the value of ⎕IO, the state of the Insert key (Ins/Rep) and the current keyboard
mode (e.g. Apl/Uni) have callback functions attached to MouseDblClick. This means
that you can toggle the state of these fields by double-clicking with the left mouse
button.
If you dislike this behaviour, you may set the Event property of the Statusfields to 0
and re-save the Session file. Alternatively, you may modify BUILDSE.DWS and
rebuild the Session from scratch.
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Table 21: Configuration dialog: General
Label

Parameter

Description

Show line
numbers

lines_on_functions

Determines whether or not line
numbers are shown in edit/trace
windows

Recently used
file list size

file_stack_size

Specifies the number of the most
recently used workspaces
displayed in the File menu.

ValueTips/Delay

Specifies the delay before APL
will display the value of a
variable or the code for a function
when the user hovers the mouse
over its name.

ValueTips/
ColourScheme

Specifies the colour scheme used
to display the value of a variable
or the code for a function when
the user hovers the mouse over its
name.

Enable Native
Look and Feel

XPLookAndFeel

Specifies whether or not Native
Look and Feel is enabled. This
changes the appearance of userinterface controls such as Buttons
in both the Session and the
Dyalog GUI.

Apply Native
Look and Feel
to docked
captions

Specifies whether or not Native
Look and Feel is honoured when
XPLookAndFeelDocker drawing the title bars of docked
windows, including docked
Session windows.

Display Value
Tips after

Colour Scheme

Underline
URLHighlight
URLs and links

Specifies whether or not URLs
and links are highlighted in
Session and Edit windows.

Configuration
saved in

Specifies the full pathname of the
registry folder used by APL

inifile

Underline URLs and links
If this option is selected, valid URLs are identified when the cursor is in the Session
or in an Edit or Trace window. When the mouse pointer is over a URL, the URL is
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underscored and the appropriate items in the Session Popup menu are activated.
These allow you to open the link or copy it to the clipboard.
You may also open a URL using Ctrl+Click (Left Mouse button).
Currently a URL string is defined to be a string starting with any of the following
strings:
l
l
l
l

http://
https://
www.
mailto:
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Unicode Input Tab (Unicode Edition Only)
Unicode Edition can optionally select your APL keyboard each time you start APL.
To choose this option, select one of your installed APL keyboards, enable the
Activate selected keyboard checkbox, then click OK
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Parameter

Description

Activate
selected
keyboard

InitialKeyboardLayoutInUse

1 = automatically select
the specified APL
keyboard on start-up.
0 = no action

Show
keyboards for
all Languages

1 = show list of all
installed keyboards
InitialKeyboardLayoutShowAll
0 = show only the Dyalog
keyboards

Keyboard

InitialKeyboardLayout

the name of the APL
keyboard to be selected.
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Table 22: Configuration dialog: Unicode Input/Configure Layout
Label

Parameter

Description

Enable
Overstrikes

ResolveOverstrikes

1 = enable overstrikes.
0 = disable overstrikes
1 = IME identifies overstrike operation
automatically
0 = IME requires the <OS> key to
signal an overstrike operation

Overstrikes do
not require the
<OS> key
Use Overstrike
popup

OverstrikesPopup

1 = enable the overstrike popup.
0 = disable the overstrike popup
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Input Tab (Classic Edition Only)

Table 23: Configuration dialog: Keyboard
Label

Parameter

Description

Input table
search path

aplkeys

A list of directories to be searched for the
specified input table

Input table file

aplk

The name of the input table file (.DIN)
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Output Tab (Classic Edition Only)

Table 24: Configuration dialog: Output
Label

Parameter

Description

Output table
search path

apltrans

A list of directories to be searched for the
specified output table

Output table
file

aplt

The name of the output table file (.DOT)
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Keyboard Shortcuts Tab

To alter the keystroke associated with a particular action, simply select the action
required and press the keystroke. For example, to change the keystroke associated
with the action <UA> (undo all changes) from (None) to Ctrl+Shift+u, simply select
the corresponding row in the list and press Ctrl+Shift+u. If Confirm before Overwrite
is checked, you will be prompted to confirm or cancel before each and every change
is written back to the registry.
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Workspace Tab

Table 25: Configuration dialog: Workspace
Label

Parameter

Description

Workspace
search path

wspath

A list of directories to be searched for the
specified workspace when the user
executes )LOAD wsname

Maximum
workspace size
(kB)

maxws

The maximum size of the workspace in
KB. Default is 16384.
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Help/DMX Tab

Table 26: Configuration dialog: Help/DMX
Label

Parameter

Description

If checked, these boxes cause
DMX messages
APL to display ⎕DMX messages
DMXOUTPUTONERROR
should go to
in the corresponding window
(s).
Use Microsoft's
documentation
centre for nonDyalog topics

If this option is checked, APL
will look for help at
UseDefaultHelpCollection Microsoft's documentaion
center for the the current string
under the cursor.

URL

DefaultHelpCollection

The url for the documentation
center.
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Table 27: Configuration dialog: Windows (Edit Windows)
Label

Parameter

Description

Width

edit_cols

The maximum number of rows displayed
in a new edit window

Height

edit_rows

The maximum number of columns
displayed in a new edit window

X Pos

edit_first_x

The initial horizontal position in
characters of the first edit window relative
to the Session window

Y Pos

edit_first_y

The initial vertical position in characters
of the first edit window relative to the
Session window

X Offset

edit_offset_x

The initial horizontal position in
characters of the second and subsequent
edit windows relative to the previous one

Y Offset

edit_offset_y

The initial vertical position in characters
of the second and subsequent edit
windows relative to the previous one

Table 28: Configuration dialog: Windows (Trace Windows)
Label

Parameter

Description

X Pos

trace_first_x

The initial horizontal position in
characters of the first trace window
relative to the Session window

Y Pos

trace_first_y

The initial vertical position in characters
of the first trace window relative to the
Session window

X Offset

trace_offset_x

The initial horizontal position in
characters of the second and subsequent
trace windows relative to the previous
one

Y Offset

trace_offset_y

The initial vertical position in characters
of the second and subsequent trace
windows relative to the previous one
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Table 29: Configuration dialog: Windows (QuadSM Window)
Label

Parameter

Description

Width

sm_cols

The width of the ⎕SM and prefect
windows

Height

sm_rows

The height of the ⎕SM and prefect
windows
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Table 30: Configuration dialog: Session
Label

Parameter

Description

⎕IO

default_io

The default value of ⎕IO in a clear
ws.

⎕ML

default_ml

The default value of ⎕ML in a clear ws

⎕PP

default_pp

The default value of ⎕PP in a clear
ws.

⎕RTL

default_rtl

The default value of ⎕RTL in a clear
ws.

⎕RL

default_rl

The default value of ⎕RL in a clear
ws.

⎕DIV

default_div

The default value of ⎕DIV in a clear
ws.

⎕WX

default_wx

The default value of ⎕WX in a clear
ws.

Auto PW

auto_pw

If checked, the value of ⎕PW is dynamic
and depends on the width of the Session
Window.

Session file

session_file

The name of the Session file in which the
definition of your session (⎕SE) is stored.
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Table 31: Configuration dialog: Log
Label

Parameter

Description

Use Session log
log_file_inuse
file

Specifies whether or not the Session log
is saved in a session log file

Use Session log
log_file
file

The full pathname of the Session log file

Confirm on
Deletion from
Session log

Specifies whether or not you are
prompted to confirm the deletion of a line
from the Session (and Session log).

confirm_
session_delete

Session log size
log_size
(Kb)

The size of the Session log buffer in Kb

Input buffer size
input_size
(Kb)

The size of the buffer used to store
marked lines (lines awaiting execution) in
the Session

History size
(Kb)

history_size

The size of the buffer used to store
previously entered (input) lines in the
Session

PFKey buffer
size(Kb)

pfkey_size

The size of the buffer used to store PFKey
definitions (⎕PFKEY)
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Table 32: Configuration dialog: Trace/Edit
Label

Parameter

Description

Classic Dyalog
mode

ClassicMode

Selects pre-Version 9 behaviour for
Edit and Trace windows

Allow floating
edit windows

Allows individual Edit windows
DockableEditWindows to be undocked from (and redocked in) the main Edit window

Allow session
above edit
windows

SessionOnTop

Specifies whether or not the
Session may appear on top of Edit
and Trace Windows

Single trace
window

SingleTrace

Specifies whether or not there is a
single Trace window

Show status
bars

StatusOnEdit

Specifies whether or not status bars
are displayed along the bottom of
individual Edit windows

Show tool bars

ToolBarsOnEdit

Specifies whether or not tool bars
are displayed along the top of
individual Edit windows

Show trace
stack on error

Trace_on_error

Specifies whether or not the Tracer
is automatically invoked when an
error or stop occurs in a defined
function

Warn if trace
stack bigger
than

Trace_level_warn

Specifies the maximum stack size
for automatic deployment of the
Tracer.

Confirm on edit
confirm_close
window close

Specifies whether or not a
confirmation dialog is displayed if
the user alters the contents of an
edit window, then closes it
without saving

Confirm on edit
confirm_fix
window fix

Specifies whether or not a
confirmation dialog is displayed if
the user alters the contents of an
edit window, then saves it using
Fix or Exit
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Description

Confirm on edit
confirm_abort
window abort

Specifies whether or not a
confirmation dialog is displayed if
the user alters the contents of an
edit window, then aborts using

Autoformat
functions

AutoFormat

Selects automatic indentation for
Control Structures when function
is opened for editing

Autoindent
functions

AutoIndent

Selects semi-automatic indentation
for Control Structures while
editing

Double-click to
DoubleClickEdit
Edit

Specifies whether or not doubleclicking over a name invokes the
editor

Paste text as
Unicode

Specifies whether or not text
transferred to and from the
Windows clipboard is to be treated
as Unicode

UnicodeToClipboard

Tab stops every TabStops

The number of spaces inserted by
pressing Tab in an edit window

Exit and fix ...

See Fixing Scripts below

If not ...

See Fixing Scripts below
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Fixing Scripts
When using the Editor to edit a script such as a Class or Namespace you can specify
whether, when you Fix the script and Exit the Editor, just the functions in the script
are re-fixed, or whether the whole script is re-executed, thereby re-initialising any
Fields or variables defined within.
These two actions always appear in the Editor File menu, but you can specify which
is associated with the <EP> (Esc) key by selecting the appropriate option in the
drop-downs labelled:
l
l

Exit and save changes (EP) in a suspended class or namespace should fix:
If not suspended fix:

In both cases, you may select either Only Functions or Everything.
The label for the corresponding items on the Editor File menu (see "The File Menu
(editing a script)" on page 219) will change according to which behaviour applies.
Note that if you specify a keystroke for <S1> in the Keyboard Shortcuts tab, this will
be associated with the unselected action.

Chapter 2: The APL Environment

149

Auto Complete Tab

Note: To enter values in the OK Key and Cancel Keyfields, click on the field with the
mouse and then press the desired keystroke.
Table 33: Configuration dialog: Auto Complete
Label

Parameter

Description

Use Auto
Complete

Enabled

Specifies whether or not Auto
Completion is enabled.

Make
suggestions
after

PrefixSize

Specifies the number of characters
you must enter before Auto
Completion begins to make
suggestions

Delay
completion for

Specifies the delay in milliseconds
KeyboardInputDelay before Auto Completion begins to
make suggestions

Suggest up to

Rows

Specifies the maximum number of
rows (height) in the AutoComplete
pop-up suggestions box.
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Parameter

Description

Show up to

Cols

Specifies the maximum number of
columns (width) in the
AutoComplete pop-up suggestion
box

Keep History

History

Specifies whether or not
AutoComplete maintains a list of
previous AutoCompletions.

History Length

HistorySize

Specifies the number of previous
AutoCompletions that are maintained

Include
filenames

ShowFiles

Specifies whether or not
AutoCompletion suggests directory
and file names for )LOAD, )COPY
and )DROP system commands.

OK Key

CompleteKey1
CompleteKey2

Specifies two possible keys that may
be used to select the current option
from the Auto Complete suggestion
box.

Cancel Key

CancelKey1
CancelKey2

Specifies two possible keys that may
be used to cancel (hide) the Auto
Complete suggestion box.

CommonKey1

Specifies the key that will autocomplete the common prefix. This is
defined to be the longest string of
leading characters in the currently
selected name that is shared by at
least one other name in the Auto
Complete suggestion box.

Common Key
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SALT
SALT is the Simple APL Library Toolkit, a simple source code management system
for Classes and script-based Namespaces. SPICE uses SALT to manage development
tools which “plug in” to the Dyalog session
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Table 34: Configuration dialog: SALT
Label

Parameter

Description

Enable
Salt

AddSALT

Specifies whether or not SALT is enabled

Compare
command
line

CompareCMD

The command line for a 3rd party file
comparison tool to be used to compare
two versions of a file. See note.

Editor

Editor

Name of the program to be used to edit
script files (default "Notepad").

Class
source
folders

SourceFolder

Sets the SALT working directory; a list of
folders to be searched for source code.
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User Commands Tab

This page is used to specify and organise a list of folders that contain User-Command
files. When you issue a User Command, these folders will be searched for the source
of the command in the order in which they appear in this list.
Table 35: Configuration dialog: User Commands
Label

Parameter

Description

Source Folders

Use this field to add folders to the
SALT\CommandFolder list of folders that will be searched
for User Commands.
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Table 36: Configuration dialog: Object Syntax
Label

Parameter

Description

Expose
properties of
GUI
Namespaces

default_wx

Specifies the value of ⎕WX in a clear
workspace. This in turn determines
whether or not the names of
properties, methods and events of
GUI objects are exposed. If set (⎕WX
is 1), you may query/set properties
and invoke methods directly as if
they were variables and functions
respectively. As a consequence, these
names may not be used for global
variables in GUI objects.

Expose
properties of
Root

Specifies whether or not the names of
properties, methods and events of the
Root object are exposed. If set, you
may query/set the properties of Root
and invoke the Root methods directly
PropertyExposeRoot
as if they were variables and
functions respectively. As a
consequence, these names may not be
used for global variables in your
workspace.

Expose
properties of
Session
Namespace

Specifies whether or not the names of
properties, methods and events of the
Session object are exposed. If set, you
may query/set the properties of ⎕SE
and invoke ⎕SE methods directly as
if they were variables and functions
respectively. As a consequence, these
names may not be used for global
variables in the ⎕SE namespace.

PropertyExposeSE

The Object Syntax tab of the Configuration dialog is used to set your default preferences for Object Syntax.
The Object Syntax settings for the current workspace are reflected by the Object
Syntax submenu of the Options menu. Use Options/Object Syntax to change them.
These settings are saved in the workspace.
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.Net FrameworkTab

This dialog box allows you to specify which version of the .Net Framework you
want to use with Dyalog APL. It is only necessary to do this if you have more than
one version of the .Net Framework installed.
If Specify .Net Version is selected, APL will display the versions of the .Net Framework that are installed in the combo box below.
Choose the version you require and click OK.
Unlike the other configuration dialogs, which typically set values in the Registry,
this dialog creates a configuration file dyalog.exe.config in the same directory
as the Dyalog APL program. Note the following:
l

l

l

Version 13.2 does not read the contents of an existing
dyalog.exe.config file.
For .Net Version 2, no configuration file is required; if you select Version 2
having previously selected Version 4, the file will be deleted.
You will need suitable permissions to write the configuration file, or delete
it – you may wish to start APL by right clicking on the Dyalog shortcut
and selecting Run as administrator.

The dialog box shows the contents of this file as illustrated above.
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Colour Selection Dialog

The Colour Selection dialog box allows you to select colours for:
l
l
l

Syntax colouring
Edit, Trace and Session windows
Status window

The colour selection dialog box is selected by the [ChooseColor] system action
which by default is attached to the Options/Colours menu item on the Session menubar and to the Colours menu item in the Session pop-up menu.
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Syntax Colouring
Syntax colouring allows you to visually identify various components in the function
edit and session windows by assigning different colours to them, such as:
l
l
l
l
l
l
l
l
l
l
l

Global references (functions and variables)
Local references (functions and variables)
Primitive functions
System functions
Localised System Variables
Comments
Character constants
Numeric constants
Labels
Control Structures
Unmatched parentheses, quotes, and braces

Schemes
You may define a number of different syntax colouring schemes which are suitable
for different purposes and a selection of schemes is provided. Choose the scheme you
wish to use from the Combo box provided. If you change a colour allocation, you
may overwrite an existing Colour Scheme or define a new one by clicking Save As
and then entering the name of the Scheme. You may delete a Colour Scheme using
the Delete button.

Changing Colours
To allocate a colour to a syntax element, you must first select the syntax element.
You may select a syntax element from the Combo box provided, or by clicking on an
example in the sample function provided. Having selected a syntax element, choose
a colour using the Foreground or Background selectors as appropriate.

Show Idioms
The Show Idioms checkbox allows you to choose whether or not idioms are to be
identified by syntax colouring.

Single Background
The Single Background checkbox allows you to choose whether to impose a single
background colour, or to allow the use of different background colours for different
syntax elements.
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Function Editor
Check this box if you want to enable syntax colouring in Edit windows.

Function Tracer
Check this box if you want to enable syntax colouring in Trace windows.

Session Input
Check this box if you want to enable syntax colouring in the Session window. Note
that the colour scheme used for the Session may differ from the colour scheme
selected for Edit windows and is specified by the Session Colour Scheme box on the
Session/Trace tab.

Only current input line
This option only applies if Session syntax colouring is enabled. Check this box if
you want syntax colouring to apply only to the current input line. Clear this box, if
you want to apply syntax colouring to all the input lines in the current Session window. Note that syntax colouring of input lines is not remembered in the Session log,
so input lines from previous sessions do not have syntax colouring.

HotKeys
You may associate different hot key with any or all of your colour schemes.
When you depress a hot key over a function in an Edit window, the function is displayed using the scheme associated with the hot key. Releasing the hot key causes it
to be displayed in the normal scheme.
This feature is intended to allow you to quickly check for certain syntax elements.
For example, you may define a special scheme that only highlights global names and
associate a hot key with it. Pressing the hot key will temporarily highlight the globals for you.
To associate a hot key with a colour scheme, click on the Hotkey field, and then
make the desired keystroke. To disassociate a hot key, use <backspace>.
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Print Configuration Dialog Box
The Print Configuration dialog box is displayed by the system operation
[PrintSetup] that is associated with the File/Print Setup menu item. It is also
available from Edit windows and from the Workspace Explorer and Find Objects
tools.
There are four separate tabs namely Setup, Margins, Header/Footer and Printer.
Note that the printing parameters are stored in the Registry in the Printing sub-folder

Setup Tab
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Table 37: Print Configuration dialog: Setup
Label

Parameter

Description

Color scheme

InColour

Check this box if you want to print
functions with syntax colouring. Note
that that printing in colour is slower than
printing without colour.

Color scheme

SchemeName

Select the colour scheme to be used for
printing.

This text

WrapWithText

Check this option button if you wish to
prefix wrapped lines (lines that exceed
the width of the paper) with a particular
text string

This text

WrapLeadText

Specifies the text for prefixing wrapped
lines

This many
spaces

WrapWithSpaces

Check this option button if you wish to
prefix wrapped lines with spaces.

This many
spaces

Specifies the number of spaces to be
WrapLeadSpaces inserted at the beginning of wrapped
lines.

Line numbers
on functions

LineNumsFns

Check this box if you want line numbers
to be printed in defined functions.

Line numbers
on variables

LineNumsVars

Check this box if you want line numbers
to be printed in variables. If you choose
this option, line numbering starts at ⎕IO.

Font

Font

Click to select the font to be used for
printing. Note that only fixed-pitch fonts
are supported.
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Margins Tab

Table 38: Print Configuration dialog: Margins
Label

Parameter

Description

Use margins

UseMargins

Check this box if you want margins to
apply

Left margin

MarginLeft

Specifies the width of the left margin

Right margin

MarginRight

Specifies the width of the right margin

Top margin

MarginTop

Specifies the height of the top margin

Bottom margin

MarginBottom

Specifies the height of the bottom margin

Inches

MarginInch

Specifies that the margin units are inches

Centimetres

MarginCM

Specifies that the margin units are
centimetres
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Table 39: Print Configuration dialog: Header/Footer
Label

Parameter

Description

Header

DoHeader

Specifies whether or not a header is
printed at the top of each page

Header

HeaderText

The header text

Footer

DoFooter

Specifies whether or not a footer is
printed at the bottom of each page

Footer

FooterText

The footer text

Prefix functions
DoSepFn
with

Specifies whether or not text is printed
before each defined function

Prefix functions
SepFnText
with

The text to be printed before each defined
function. This can include its name,
timestamp and author

Prefix variables
with

DoSepVar

Specifies whether or not text is printed
before each variable.

Prefix variables
with

SepVarText

The text to be printed before each
variable. This can include its name.

Prefix other
objects with

DoSepOther

Specifies whether or not text is printed
before other objects. These include locked
functions, external functions, ⎕NA
functions, derived functions and
namespaces.

Prefix other
objects with

SepOtherText

The text to be printed before other
objects. This can include its name.
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The specification for headers and footers may include a mixture of your own text, and
keywords which are enclosed in braces, e.g. {objname}. Keywords act like variables
and are replaced at print time by corresponding values.
Any of the following fields may be included in headers, footers and separators.
{WSName}
{NSName}
{ObjName}
{Author}
{FixDate}
{FixTime}
{PrintDate}
{PrintTime}
{CurrentPage}
{TotalPages}
{RightJustify}
{HorizontalLine}
{CarriageReturn}

{WS}
{NS}
{OB}
{AU}
{FD}
{FT}
{PD}
{PT}
{CP}
{TP}
{RJ}
{HL}
{CR}

Workspace name
Namespace name
Object name
Author
Date function was last fixed
Time function was fixed
Today's date
Current time
Current page number
Total number of pages
Right-justifies subsequent text/fields
Inserts a horizontal line
Inserts a new-line

For example, the specification:
Workspace: {wsname} {objname} {rj} Printed {PrintTime} {PrintDate}
would cause the following header, footer or separator to be printed at the appropriate
position in each page of output:
Workspace: U:\WS\WDESIGN WIZ_change_toolbar Printed 14:40:11 02 March
1998
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Printer Tab

Table 40: Print Configuration dialog: Print
Label

Parameter

Description

Name

PrinterField

The name of the printer to be used for
printing from Dyalog APL.

Properties

Click this to set Printer options.

Where

Reports the printer device

Print

Allows you to choose between printing
all of the current object or just the
selection. Note that this option is present
only when the dialog box is displayed in
response to selecting Print.

Status Window

Chapter 2: The APL Environment

167

The Status window is used to display system messages and supplementary information. These include the operations that take place when you register an OLEServer
or ActiveXControl.
The Status window is also used to display supplementary information about errors.
For example, if in a ⎕WC statement you misspell the type of an object, you will get a
suitable error message in the Status window, in addition to the DOMAIN ERROR message in the Session.

Example
'F'⎕WC'FROM' ⍝ Should be 'FORM'
DOMAIN ERROR
'F'⎕WC'FROM'
^

The Status window can be explicitly displayed or hidden using the [Status] system operation which is associated with the Tools/Status menu item.
There is also an option to have the Status window appear automatically whenever a
new message is written to it. This option is selected using the [AutoStatus] system operation which is associated with the Tools/AutoStatus menu item.
Note that when you close the Status window, all the system messages in it are
cleared.
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The Workspace Explorer Tool
The Explorer tool is a modeless dialog box that may be toggled on and off by the system action [Explorer]. In a default Session, this is attached to a MenuItem in the
Tools menu and a Button on the session toolbar.
The Explorer contains two sub-windows. The one on the left displays the namespace
structure of your workspace using a TreeView. The right-hand window is a ListView
that displays the contents of the namespace that is selected in the TreeView.

The Explorer is closely modelled on the Windows Explorer in Windows and the facilities it provides are very similar. For Windows users, the operation of this tool is probably self-explanatory. However, other users may find the following discussion useful.

Chapter 2: The APL Environment

169

Exploring the Workspace
The TreeView displays the structure of your workspace. Initially it shows the root
and Session namespaces # and ⎕SE. The icon for # is open indicating that its contents are those that appear in the ListView. You can expand or collapse the TreeView
of the workspace structure by clicking on the mini-buttons (labelled + and -) or by
double-clicking the icons. A single click on a closed namespace icon opens it and
causes its contents to be displayed in the ListView. Another way to open a namespace is to double-click its icon in the ListView. Only one namespace can be open at
a time. The icons used in the display are described below.
Class
Namespace (closed)
GUI Namespace (closed)
Namespace (open)
GUI Namespace (open)
Function
Variable
Operator
Indicates an object that has been erased
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Viewing and Arranging Objects
The ListView displays the contents of a namespace in one of four different ways
namely Large Icon view, Small Icon view, List view or Details view. You can switch
between views using the View menu or the tool buttons that are provided. In the first
three views, the system displays the name of the object together with an icon that
identifies its type. In Details view, the system displays several columns of additional
information. You may resize the column widths by dragging or double-clicking the
lines in the header. To hide a column, drag its width to the far left. The additional columns are:
Location

This is the namespace containing the object. By definition, this
is the same for all of the objects shown in the ListView and is
normally hidden

For a function or operator, this is the function header stripped of
localised names and comment. For a variable, the description
indicates its rank, shape and data type. For a namespace, the
Description
description indicates the nature of the namespace; a plain
namespace is described as namespace, a GUI Form object is
described as Form, and so forth.
Size

The size of the object as reported by ⎕SIZE.

Modified
on

For functions and operators, this is the timestamp when the
object was last fixed. For other objects this field is empty.

Modified
by

For functions and operators, this is the name of the user who last
fixed the object. For other objects this field is empty.

In any view, you may arrange the objects in ascending order of name, size, timestamp
or class by clicking the appropriate tool button. In Details view, you may sort in
ascending or descending order by clicking on the appropriate column heading. The
first click sorts in ascending order; the second in descending order.
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Moving and Copying Objects
You can move and copy objects from one namespace to another using drag-drop or
from the Edit menu.
To move one or more objects using drag-and-drop editing:
1. Select the objects you want to move in the ListView.
2. Point to one of the selected objects and then press and hold down the left
mouse button. When the drag-and-drop pointer appears, drag the object(s) to
another namespace in the TreeView. To indicate which of the namespaces is
the current target, its name will be highlighted as you drag the selected
object(s) over the TreeView.
3. Release the mouse button to drop the objects into place. The objects will
disappear from the ListView because they have been moved to another
namespace.
To copy one or more objects using drag-and-drop editing, the procedure is the same
except that you must press and hold the Ctrl key before you release the mouse button.
You may also move and copy objects using the Edit menu. To do so, select the object
(s) and then choose Move or Copy from the Edit menu. You will be prompted for the
name of the namespace into which the objects are to be moved or copied. Enter the
namespace and click OK.

Editing and Renaming Objects
You can open up an edit window for a function or variable by double-clicking its
icon, or by selecting it and choosing Edit from the Edit menu or from the popup
menu. You may rename an object by clicking its name (as opposed to its icon) and
then editing this text. You may also select the object and choose Rename from the
Edit menu or from the popup menu. Note that when you rename an object, the original name is discarded. Unlike changing a function name in the editor, this is not a
copy operation.
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Using the Explorer as an Editor
If you open the Fns/Ops item, the names of the functions and operators in the namespace are displayed below it alphabetically in the left (tree view) pane. When you
select one of these names, the function itself is opened in the right (list view) pane.

You may use this feature to quickly cycle through the functions (or variables) in a
namespace, pressing cursor up and cursor down in the left (tree view) pane to move
from one to another.
You may also edit the function directly in the right (list view) pane before moving on
to another.
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The File Menu

The File menu, illustrated above, provides the following actions. All but Print setup
and Close act on the object or objects that are currently selected in the ListView.
Print

Prints the object(s).

Print
setup

Displays the Print Configuration dialog box.

Delete

Erases the object(s).

Rename

Renames the object. This option only applies when a single
object is selected.

Properties Displays a property sheet; one for each object that is selected.
Close

Closes the Explorer
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The Edit Menu

The Edit menu, illustrated above, provides the following actions. The Edit, Copy and
Move operations act on the object or objects that are currently selected in the ListView.
Edit

Opens an edit window for each of the objects selected.

Copy

Prompts for a namespace and copies the object(s) there.

Move

Prompts for a namespace and moves the object(s) there.

Select
Functions

Selects all of the functions and operators in the ListView.

Select
Variables

Selects all of the variables in the ListView.

Select None

Deselects all of the objects in the ListView.

Select All

Selects all of the objects in the ListView.

Invert
Selection

Deselects the selected objects and selects all those that were
not selected.
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The Options Menu

The Options menu, illustrated above, provides the following actions.
Toolbar

Displays or hides the Explorer toolbar.

Toolbar
Captions

Displays or hides the button captions on the Explorer toolbar.

StatusBar Displays or hides the Explorer statusbar.
Type
Enables/disables the exploring of Type Libraries
Libraries
Expand
All

Expands all namespaces and sub-namespaces in the TreeView,
providing a complete view of the workspace structure, including
or excluding the Session object ⎕SE.

Refresh
Now

Redisplays the TreeView and ListView with the current structure
and contents of the workspace. Used if Auto Refresh is not
enabled.

Auto
Refresh

Specifies whether or not the Explorer immediately reflects
changes in the active workspace.

If Auto Refresh is checked the Explorer is updated every time APL returns to desk-calculator mode. This means that it is always in step with the active workspace. If you
have a large number of objects displayed in the Explorer, the update may take a few
seconds and you may wish to prevent this by un-checking this menu item If you do
so, the Explorer must be explicitly updated by selecting the Refresh Now action.
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The View Menu

The View menu, illustrated above, provides the following actions.
Columns

Allows you to select which columns you wish to display.

Large
Icons

Selects Large Icon view in the ListView.

Small
Icons

Selects Small Icon view in the ListView.

List Icons Selects List view in the ListView.

.

Details

Selects Details view in the ListView.

Scope

Allows you to choose whether the Explorer displays objects in
local scope or in global scope.

Arrange
Icons

Sorts the items in the ListView by name, type, size or date.

Line up
Icons

Rearranges the icons into a regular grid.

Auto
Arrange

If checked, the icons are automatically re-arranged when
appropriate
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The Tools Menu

The Tools menu, illustrated above, provides the following actions.
Find

Displays the Find Objects Tool

Go to

Prompts for a namespace and then opens that namespace in the
TreeView, displaying its contents in the ListView

Go to
Session
Space

Opens the namespace in the TreeView control corresponding to
the current space in the Session.

Set Session Sets the current space in the Session to be the namespace that is
Space
currently open in the TreeView.
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Browsing Classes
Classes are represented by
icons. The picture below shows 3 classes: Bird,
Parrot and DomesticParrot.

If you open the # node in the left-hand pane, you see the contents of # as a tree.
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Browsing Class Scripts
Selecting DomesticParrot in the left-hand pane brings up its Class Script in the
right-hand pane.
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… and selecting Parrot in the left-hand pane brings up the Class Script for
Parrot.
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… and finally, selecting Bird in the left-hand pane brings up the Class Script for
Bird.
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If you open a Class node, a tree appears to help you to navigate within the Class
script. In the picture below, the user has opened the [Methods] node and then
clicked on Speak. The system has responded by scrolling to (if necessary) and highlighting the appropriate section of the script.
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Browsing Type Libraries
When the View/Type Libraries option is enabled, the Workspace Explorer allows
you to:
l

l
l

Browse the Type Libraries for all the COM server objects that are installed
on your computer, whether or not they are loaded in your workspace.
Load Type Libraries for COM objects
Browse the Type Library associated with an OLEClient object that is
already instantiated in the workspace.

If the Microsoft .Net Framework is installed, you may in addition:
l
l

Load Metadata for specific .Net classes
Browse the loaded Metadata, viewing information about classes, methods,
properties and so forth.

If the Type Libraries option is enabled, the Workspace Explorer displays a folder
labelled TypeLibs which, when opened, displays two others labelled Loaded
Libraries and Registered Libraries as shown below.
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Browsing Registered Libraries
If you open the Registered Libraries folder, the Workspace Explorer will display in
the tree view pane the names of all the Type Libraries associated with the COM
Server objects that are installed on your computer.
If you select one of these Library names, some summary information is displayed in
the list view pane.
For example, the result of selecting the Microsoft Excel 9.0 Object Library is illustrated below.

If instead, you select the Registered Libraries folder itself, the list of Registered Type
Libraries is displayed in the list view pane
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Loading a Type Library
You can load a library shown in the list view pane by double-clicking its name.
Alternatively, you can load a library shown in the tree view pane by selecting Load
from its context menu.
In either case, a message box will appear asking you to confirm. The operation to
load a Type Library may take a few moments to complete.
Notice that if the selected Library references any other libraries, they too will be
loaded. For example, loading the Microsoft Excel 9.0 Object Library brings in the
Microsoft Office 9.0 Object Library and the Microsoft Visual Basic for Applications
Extensibility 5.3 Library too. It also contains references to a general library called the
OLE Automation Type Library, so this is also loaded.
When you )SAVE your workspace, all of the Type Libraries that you have loaded
will be saved with it. Note that type library information can take up a considerable
amount of workspace.

Chapter 2: The APL Environment

186

Browsing Loaded Libraries
If you have already loaded any Type Libraries into the workspace, using the Workspace Explorer or as a result of creating one or more OLEClient objects, you can
select and open the Loaded Libraries folder.
The picture below illustrates the effect of having loaded the Microsoft Excel 9.0
Object Library.

Notice that any external references to other libraries causes these to be brought in
too.
If you select a loaded Type Library, summary information is displayed in the list
view pane.
If you open a loaded Type Library, four sub-folders appear named Object CoClasses,
Objects, Enums and Event Sets respectively.
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Object CoClasses
A Type Library describes a number of objects. Typically, all of the objects have properties and methods, but only some of them, perhaps just a few, generate events.
Objects which generate events are represented by CoClasses, each of which has a
pointer to the object itself and a pointer to an event set.
For example, the Microsoft Excel 9.0 Object Library contains seven CoClasses
named Application, Chart, Global etc as shown below.
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Opening the Application folder you can see that the Application CoClass comprises
the _Application object coupled with the AppEvents event set as shown below.

The specific methods, properties and events supported by the CoClass object can be
examined by opening the appropriate sub-folder. The same information for these and
other objects is also accessible from the Objects and Event Sets folders as discussed
below.
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Objects
The Objects folder contains several sub-folders each of which represents a named
object defined in the library.
Each object folder contains two sub-folders named Methods and Properties. Selecting
one of these causes the list of Methods or Properties to be displayed in the list view
pane. The picture below shows the Methods exposed by the Microsoft Excel 9.0
Range object.
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If you open the Methods or Properties subfolder, you can display more detailed information about individual Methods and Properties. For example, the following picture
shows information about the SaveAs method exposed by the Microsoft Excel 9.0
Worksheet object.

This tells you that the SaveAs method takes up to 9 parameters of which the first, Filename, is mandatory and is of data type VT_BSTR (a character string). Note that [in]
indicates that the parameter is an input parameter.
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Incidentally, the optional Fileformat parameter is an example of a parameter whose
value must be one of a list of Enumerated Constants. Even without looking at the documentation, the possible values can be deduced by browsing the Enums folder, with
the results shown below.

You can therefore deduce that the following expression, executed in the namespace
associated with the currently active worksheet, will save the sheet in comma-separated format (CSV) in a file called mysheet.csv:
SaveAs 'MYSHEET.CSV' xlCSV
or
SaveAs 'MYSHEET.CSV' 6
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Event Sets
The Event Sets folder contains several sub-folders each of which represents a named
set of events generated by the objects defined in the library.
If you open one of these event sets, the names of the events it contains are displayed
in the tree view pane. If you then select one of the events, its details are displayed in
the list view pane as shown below.

This example shows that when it fires, the SheetActivate event invokes your callback function with a single argument named Sh whose datatype is VT_DISPATCH
(in practice, a Worksheet object).
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Enums
The Enums folder will typically contain several sub-folders each of which represents
a named set of enumerated constants.
If you select one of these sets, the names and values of the constants it contains are
displayed in the list view pane as shown below.

Chapter 2: The APL Environment

194

Browsing .Net Classes
Microsoft supplies a tool for browsing .NET Class libraries called ILDASM.EXE1.
As a convenience, the Dyalog APL Workspace Explorer has been extended to perform a similar task as ILDASM so that you can gain access to the information within
the context of the APL environment.
The information that describes .NET classes, which is known as its Metadata, is part
of the definition of the class and is stored with it. This Metadata corresponds to Type
Information in COM, which is typically stored in a separate Type Library.
To enable the display of Metadata in the Workspace Explorer, you must have the
Type Libraries option of the View menu checked.

1 ILDASM.EXE can be found in the .NET SDK and is distributed with Visual Studio
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To gain information about one or more Net Classes, open the Workspace Explorer,
right click the Metadata folder, and choose Load.

This brings up the Browse .Net Assembly dialog box as shown below. Navigate to the
.NET assembly of your choice, and click Open.
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Note that the .NET Classes provided with the .NET Framework are typically located
in C:\WINDOWS\Microsoft.NET\Framework\V2.0.50215. The last named
folder is the Version number.
The most commonly used classes of the .NET Namespace System are stored in this
directory in an Assembly named mscorlib.dll, along with a number of other fundamental .NET Namespaces.
The result of opening this Assembly is illustrated in the following screen shot. The
somewhat complex tree structure that is shown in the Workspace Explorer merely
reflects the structure of the Metadata itself.
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Opening the System/ Classes sub-folder causes the Explorer to display the list of
classes contained in the .NET Namespace System as shown in the picture below.
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The Constructors folder shows you the list of all of the valid constructors and their
parameter sets with which you may create a new instance of the Class by calling
New. The constructors are those named .ctor; you may ignore the one named .cctor,
(the class constructor) and any labelled as Private.
For example, you can deduce that DateTime.New may be called with three
numeric (Int32) parameters, or six numeric (Int32) parameters, and so forth. There
are in fact seven different ways that you can create an instance of a DateTime.

For example, the following statement may be used to create a new instance of
DateTime (09:30 in the morning on 30th April 2001):
mydt←⎕NEW DateTime (2001 4 30 9 30 0)
mydt
30/04/2001 09:30:00

Chapter 2: The APL Environment

The Properties folder provides a list of the properties supported by the Class. It
shows the name of the property followed by its data type. For example, the
DayOfYear property is defined to be of type Int32.

You can query a property by direct reference:
Monday

mydt.DayOfWeek
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Notice too that the data types of some properties are not simple data types, but
Classes in their own right. For example, the data type of the Now property is itself
System.DateTime. This means that when you reference the Now property, you
get back an object that represents an instance of the System.DateTime object:
mydt.Now
07/11/2001 11:30:48
⎕TS
2001 11 7 11 30 48 0
The Methods folder lists the methods supported by the Class. The Explorer shows the
data type of the result of the method, followed by the name of the method and the
types of its arguments. For example, the IsLeapYear method takes an Int32
parameter (year) and returns a Boolean result.
1

mydt.IsLeapYear 2000
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Many of the reported objects are listed as Private, which means they are inaccessible
to users of the class – you are not able to call them or inspect their value. For more
information about classes, see the chapter on Object Oriented Programming in the
Dyalog APL Language Reference Manual.
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Find Objects Tool
The Find Objects tool is a modeless dialog box that may be toggled on and off by the
system action [WSSearch]. In a default Session, this is attached to a MenuItem in
the Tools menu and a Button on the session toolbar. This tool allows you to search
the active workspace for objects that satisfy various criteria.
The first page allows you to specify the name of the object which you wish to find
and the namespace(s) in the workspace that are to be searched for it.

You type the name of the object you wish to find into the field labelled Named. To
locate all objects beginning with a particular string, enter the string followed by a '*'
character. For example, if you enter the string FOO*, the system will locate all objects
whose name begins with FOO.
Four check boxes are provided for you to specify the types of objects you wish to
locate. For example, if you clear Variables, Operators and Namespaces, the system
will only search for functions.
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You can restrict the search to a particular namespace by typing its name into the field
labelled Look in. You can also restrict the search by clearing the Include subnamespaces and Include Session namespace check boxes. Clearing the former
restricts the search to the root namespace or to the namespace that you have specified
in Look in, and does not search within any sub-namespaces contained therein. Clearing the latter causes the system to ignore ⎕SE in its search.
The second page, labelled Modified, allows you to search for objects that have been
modified by a particular user or at a certain time

To make the search dependent upon modification, you must check the Modified
Objects check box.
To locate objects modified by a particular user, enter the user name in the field
labelled Modified by. Otherwise leave this blank.
To find objects which have been modified at a certain time or within a specified
period of time, check the appropriate radio button and enter the appropriate dates or
time spans.
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The third page, labelled Advanced, allows you to search for objects that contain a particular text string.

If you wish to search for objects containing a particular character string, type the
string into the field labelled Containing Text.
Match Case specifies whether or not the text search is case sensitive.
Use Regular Expressions specifies whether or not regular expressions are applicable.
For example, if you enter FOO* into the field labelled Containing Text and check
this box, the system will find objects that contain any text string starting with the 3
characters FOO. If this box is not checked, the system will find objects that contain
the 4 characters FOO*.
Match Whole Word specifies whether or not the search is restricted to entire words.
As Symbol Reference specifies whether or not the search is restricted to APL symbols.
If so, matching text in comments and other strings is ignored.
If you wish to restrict the search to find only objects whose size is within a given
range, check the box labelled Size is between and enter values into the fields provided.
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When you press the Find Now button, the system searches for objects that satisfy all
of the criteria that you have specified on all 3 pages of the dialog box and displays
them in a ListView. The example below illustrates the result of searching the workspace for all functions containing references to the symbol CURSOR.

You may change the way in which the objects are displayed in the ListView using
the View menu or the tool buttons, in the same manner as for objects displayed in the
Workspace Explorer. You may also edit, delete and rename objects in the same way.
Furthermore, objects can be copied or moved by dragging from the ListView in the
Search tool to the TreeView in the Explorer.
If you wish to specify a completely new set of criteria, press the New Search button.
This will reset all of the various controls on the 3 pages of the dialog box to their
default values.
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Object Properties Dialog Box
The Object Properties dialog box displays detailed information for an APL object. It
is displayed by executing the system action [ObjProps]. In a default Session, this
is provided in the Tools menu, the Session popup menu and from the Explorer. An
example (for a function) is shown below.

Properties Tab
The Properties tab displays general information about the object. For a function, this
includes an extract from its header line, when it was last modified, and by whom.
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Value Tab
For a variable, the Values tab displays the value of the variable. For a function, it displays its canonical representation.
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Monitor Tab
The Monitor tab applies only to a function and displays the result of ⎕MONITOR.
The Reset button resets ⎕MONITOR for the lines on which it is currently set. The Set
All Lines button sets ⎕MONITOR to monitor all the lines in the function. The Clear
All Lines switches ⎕MONITOR off.
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COM Properties Tab
The COM Properties tab applies only to a function in an OLEServer or ActiveXControl namespace. The tab is used to define arguments and data types for an
exported Method or Property. For further information, see Interface Guide.
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Net Properties Tab
The Net Properties tab applies only to a function in a NetType namespace. The tab is
used to define arguments and data types for an exported Method or Property. For further information, see .Net Interface Guide.
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The Editor
Invoking the Editor
The editor may be invoked in several ways. From the session, you can use the system
command )ED or the system function ⎕ED, specifying the names(s) of the object(s) to
be edited. You can also type the name of the object and then press Shift+Enter (ED),
click the Edit tool on the tool bar, or select Edit from the Action menu. If you invoke
the editor when the cursor is positioned on the empty input line, with a suspended
function in the State Indicator, the editor is invoked on the suspended function and
the cursor is positioned on the line at which it is suspended. This is termed naked
edit. These ways of invoking the editor apply only in the session window

In addition, there is a general point-and-edit facility which works in edit and trace
windows too. Simply position the input cursor over a name and double-click the left
mouse button. Alternatively, you can press Shift+Enter or select Edit from the File
menu. The name can appear in the Session, in an Edit window, or in a Trace window;
the effect is the same. Note that, in the Session, typing a name and pressing
Shift+Enter is actually a special case of point-and-edit. Note also that a naked edit
can be invoked by double-clicking the left mouse button in the empty input line.
The type of a new object defaults to function/operator unless the object is shadowed,
in which case it defaults to a variable (vector of character vectors). You can however
specify the type of a new object explicitly using )ED or ⎕ED . For example, typing
")ED ∊LIST -MAT" in a CLEAR WS would create Edit windows for a vector of
character vectors named LIST and a character matrix called MAT. See )ED or ⎕ED for
details.
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If the name is not already being edited, it is assigned a new edit window. If you edit a
name which is already being edited, the system focuses on the existing edit window
rather than opening a new one. Edit windows are displayed using the colour combination associated with the type of the object being edited.

Window Management (Standard)
Unless Classic Dyalog mode is selected (Options/Configure/Trace/Edit), the Editor
is a Multiple Document Interface (MDI) window that may be a stand-alone window,
or be docked in the Session window. Each of the objects being edited is displayed in
a separate sub-window. Individual edit windows are managed using standard MDI
facilities.

The initial size of an edit window is specified by the edit_rows and edit_cols parameters. The first edit window is positioned at 0 0. Subsequent ones are staggered
according to the values of the edit_offset_y and edit_offset_x parameters.
By default, the Session has the Editor docked along the right edge of the Session window. When you edit a function, the Editor window automatically springs into view
as illustrated overleaf.
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You can resize the Editor pane to view more or less of the Session itself, by dragging
its title bar.
Using the buttons in the title bar, you can instantly maximise the Editor pane to
allow you to concentrate on editing, or minimise it to reveal the entire Session. In
either case, the restore button quickly restores the 2-pane layout.
The picture below shows the effect of maximising the Editor. The BUILD_SESSION
edit window is itself maximised within the Editor too.

Note that when the Editor has the focus, the Editor menubar is displayed in place of
the Session menubar.
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Window Management (Classic Dyalog mode)
If Classic Dyalog mode is selected (Options/Configure/Trace/Edit) each Edit window is a top-level window created as a child of the Session window. This means that
Edit windows always appear on top of the Session.
The first edit window is created at the position specified by the edit_first_y and
edit_first_x parameters. The initial size of an edit window is specified by the edit_
rows and edit_cols parameters.
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Subsequent ones are staggered according to the values of the edit_offset_y and edit_
offset_x parameters.

Moving around an edit window
You can move around in the edit window using the scrollbar, the cursor keys, and the
PgUp and PgDn keys. In addition, Ctrl+Home (UL) moves the cursor to the beginning of the top-line in the object and Ctrl+End moves the cursor to the end of the last
line in the object. Home (LL) and End (RL) move the cursor to the beginning and end
respectively of the line containing the cursor.

Closing an edit window
Closing an edit window from its System Menu has the same effect as choosing Exit
from the File Menu; namely that it fixes the object in the workspace and then closes
the edit window.

Minimising an edit window
Minimising an edit window causes it to be displayed as a Dyalog APL Edit icon,
with the name of the object underneath. The edit window can be restored in the normal way, or by an attempt to re-edit the same name.
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Editor ToolBar

Toggles Line numbers on/off.
Toggle line numbers

Comment selected text

Adds a comment to the beginning of
the current line or all selected lines.

Uncomment selected text

Removes a comment (if present) from
the current line or all selected lines.

Save changes and return

Saves changes and closes the current
edit window.
Enter search text and click one of the
following two buttons.

Search Box

Search for Next Match

Locates the next occurrence of the
search text

Search for Previous Match

Locates the previous occurrence of
the search.

Refactor text as method

Inserts a Method template for the
selected name.

Refactor text as field

Inserts a Field template for the
selected name.

Refactor text as property

Inserts a Property template for the
selected name.
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The File Menu

The File menu illustrated above is displayed when editing a simple object and provides the following options.

Fix

Fixes the object in the workspace, but leaves the edit
window open. Edit history is also preserved. If the data
has changed and the confirm_fix parameter is set, you
will be prompted to confirm.

Fix Script

(Disabled unless editing a script)

Edit

Opens an Edit window on the name under the mouse
pointer. (Disabled when not).

Print

Prints the current contents of the edit window.

Print Setup

Displays the Print Configuration dialog box.

Properties

Displays the Object Properties dialog box for the
current object.

Exit (and Fix)

Fixes the object in the workspace and closes the edit
window. If the data has changed and the confirm_exit
parameter is set, you will be prompted to confirm.

Exit (and fix
script)

(Disabled unless editing a script)

Exit and discard
changes

Closes the edit window, but does not fix the object in
the workspace. If the data has changed and the
confirm_abort parameter is set, you will be prompted to
confirm.
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The File Menu (editing a script)

The File menu illustrated above is displayed when editing a script and provides the
following different options from those shown on the preceding page.
Fix whole script

Fixes the entire script

Fix only functions

Fixes only the functions in the script.

Exit and fix whole
Fixes the entire script, and exits the Editor.
script
Exit and fix only
functions

Fixes only the functions in the script and exits the
Editor.

Editing Scripts
Suppose that you have a Class that manages a list of items in a shared Field, so somewhere in the script would appear a line such as::Field shared public List {gets} {zilde}
You run your application for a bit, and List, which was initially empty, gets
updated as new instances of the Class are created. You then edit the Class to add a
new function, or fix a bug. In this instance, when you exit the editor you may not
want List to be reset back to the empty vector although you do want the new version of the function(s) in the Class to be fixed.
Nevertheless whenever you edit the Class when it is not suspended, you probably
always want the entire script to be re-fixed, and List re-initialised.
The options in the File menu shown above provide for these alternatives.
In addition, the Configuration dialog (See "Fixing Scripts" on page 148) allows you
to define the behaviour of the keystrokes <EP> and <S1> for both the suspended
case and the non-suspended case. This association will be displayed against the
appropriate action according to the state of the script you are editing.
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The Edit Menu
The Edit menu provides a means to execute those commands that are concerned with
editing text. The Edit menu and the actions it provides are described below.
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Reformat

Reformats the function body in the edit window, indenting
control structures as appropriate.

Undo

Undoes the last change made to the object. Repeated use of
this command sequentially undoes each change made since
the edit window was opened.

Redo

Re-applies the previous undone change. Repeated use of
this command sequentially restores every undone change.

Cut

Copies the selected text to the clipboard and removes it
from the object.

Copy

Copies the selected text to the clipboard.

Paste

Copies the text in the clipboard into the object at the
current location of the input cursor.

Paste Unicode

Same as Paste, but gets the Unicode text from the clipboard
and converts to ⎕AV

Paste NonUnicode

Same as Paste, but gets the ANSI text from the clipboard
and converts to ⎕AV.

Clear

Deletes the selection or the character under the cursor. Has
no effect on the clipboard

Open Line

Inserts a blank line immediately below the current one.

Delete Line

Deletes the current line.

Goto Line

Prompts for a line number, then positions the cursor on that
line.

Find

Displays the Find dialog box.

Replace

Displays the Replace dialog box.

Comment
selected lines

Adds a comment symbol to the beginning of all selected
lines.

UnComment
selected lines

Removes a comment symbol from the beginning of all
selected lines.

Toggle Local
name

Adds or removes the name under the cursor to/from the
function header line.

The Find and Replace items are used to display the Find dialog box and the
Find/Replace dialog box respectively. These boxes are used to perform search and
replace operations and are described later in this Chapter.
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Once displayed, each of the two dialog boxes remains on the screen until it is either
closed or replaced by the other. This is convenient if the same operations are to be performed over and over again, and/or in several windows. Find and Find/Replace operations are effective in the window that previously had the focus.

The Refactor Menu

The Refactor menu illustrated above applies only when editing a Class and provides
the following options. In each case, the user must highlight a name in the Edit window, and then select one of these options to insert the appropriate template for that
name into the body of the Class.
Add text as Field

Inserts a Field template for the selected name.

Add text as Property

Inserts a Property template for the selected name.

Add text as Method

Inserts a Method template for the selected text name.

The View Menu
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The View menu, illustrated above, provides the following actions.
Trace

Displays a column to the left of the function that displays
⎕TRACE settings

Stop

Displays a column to the left of the function that displays
⎕STOP settings

Monitor

Displays a column to the left of the function that displays
⎕MONITOR settings

Line
Numbers

Toggles the display of line numbers on/off.

Function
Line
Numbers

Toggles the display of line numbers on individual functions
on/off. This option is only enabled when editing a Class,
Namespace script or Interface.

Tree View

Toggles the display of the treeview in the left-hand pane.

Outlining

Turns outlining on and off.

Expand All
Outlines

Expands all outlines.

Collapse All
Collapses all outlines
Outlines
Expand all
Outlines
below here

Expands all outlines below the level of the current line.

Function Line Numbers
The Function Line Numbers option in the Editor menu provides an additional level
of line-numbering. If selected, line numbers are displayed independently on each
individual function (or operator) in the Class. This option is only enabled when you
are editing a Class, Namespace script or Interface, and is disabled for all other types
of object.
Note that function line-numbering and general line-numbering are independent
options and it is possible to have the entire Class numbered (from [0] to the number
of lines in the Class) in addition to having line-numbering on each individual function.
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The Window Menu
The Window menu provides a means to control the display of the various edit windows. The Window menu and the actions it provides are described below.

Closes all the edit windows. If Confirm on Edit Window Closed is
Close All
checked, you will be prompted to confirm for any objects that you
Windows
have changed.
Cascade

Arranges the edit windows in overlapping fashion.

Tile

Arranges the edit windows in a tiling fashion.

Arrange
Arranges any minimised edit windows.
Icons
Editor

Allows you to Select the edit window corresponding to the named
object.
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Using the Editor
Creating a New Function
Type the name of your function and invoke the editor. To do this you may press
Shift+Enter, or select Edit from the Action menu, or double-click the left button on
your mouse, or click the Edit tool in the tool bar. A new window will appear on the
screen with the name you have chosen displayed in the top border. The name is also
inserted in the function header and the cursor positioned to the right. The new window is automatically given the input focus.

Line-Numbers on/off
Try changing the line numbers setting by clicking on the Line Numbers option in the
Options menu. Note that line-numbering on/off is effective for all edit windows.

Adding Lines
If the keyboard is in Insert mode, pressing Enter at the end of a line opens you a new
blank line under the current one and positions the cursor there ready for input. You
can also open a new blank line by pressing Ctrl+Shift+Insert (OP).
If the cursor is at the end of the last line in the function, pressing Enter adds another
line even if the keyboard is in Replace mode.

Indenting Text
Dyalog APL allows you to insert leading spaces in lines of a function and (unless the
AutoFormat parameter is set) preserves these spaces between editing sessions.
Embedded spaces are however discarded. You can enter spaces using the space bar or
the Tab key. Pressing Tab inserts spaces up to the next tab stop corresponding to the
value of the TabStops parameter. If the AutoIndent parameter is set, new lines are
automatically indented the same amount as the preceding line.

Reformatting
The RD command (which by default is mapped to Keypad-Slash) reformats a function according to your AutoFormat and TabStops settings.

Deleting Lines
To delete a block of lines, select them by dragging the mouse or using the keyboard
and then press Delete or select Clear from the Edit menu. A quick way to delete the
current line without selecting it first is to press Ctrl+Delete (DK) or select Delete
Line from the Edit menu.
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Copying Lines
Select the lines you wish to copy by dragging the mouse or using the keyboard. Then
press Ctrl+Insert or select Copy from the Edit menu. This action copies the selection
to the clipboard. Now position the input cursor where you wish to make the copy
and press Shift+Insert, or select Paste from the Edit menu. You can also use this
method to duplicate a ragged block of text.
To copy text using drag-and-drop editing:
1. Select the text you want to move.
2. Hold down the Ctrl key, point to the selected text and then press and hold
down the left mouse button. When the drag-and-drop pointer appears, drag
the cursor to a new location.
3. Release the mouse button to drop the text into place.

Moving Lines
Select the lines you wish to copy by dragging the mouse or using the keyboard. Then
press Shift+Delete or select Cut from the Edit menu. This action copies the selection
to the clipboard and removes it. Now position the input cursor at the new location
and press Shift+Insert, or select Paste from the Edit menu. You can also use this
method to move a ragged block of text.
To move text using drag-and-drop editing:
1. Select the text you want to move.
2. Point to the selected text and then press and hold down the left mouse button. When the drag-and-drop pointer appears, drag the cursor to a new location.
3. Release the mouse button to drop the text into place.

Joining and Splitting Lines
To join a line to the previous one: select Insert mode; position the cursor on the first
character in the line; press Bksp.
To split a line: select Insert mode; position the cursor at the place you want it split;
press Return.

Toggling Localisation
The TL command (which by default is mapped to Ctrl+Up) toggles the localisation
of the name under the cursor. If the name is currently global, pressing Ctrl+Up causes
the name to be added to the list of locals in the function header. If the name is already
localised, pressing Ctrl+Alt+l removes it from the header.
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Outlining
When you are editing a function, outlining identifies the blocks of code within control structures, and allows you to collapse and expand these blocks so that you can
focus your attention on particular parts of the code
The picture below shows the result of opening the function ⎕SE.cbtop.TB_
POPUP.
)ed ⎕SE.cbtop.TB_POPUP

Notice that the various control structure blocks are delineated by a treeview diagram.
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When you hover the mouse pointer over one of the boxes that mark the start
of a block , the line marking the extent of that block becomes highlighted,
as shown above.
If you click on a
box, the corresponding section collapses, so that only
the first line of the block is displayed, as shown below.
If you click on a
box, the corresponding section is expanded.
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Sections
Functions and scripted objects (classes, namespaces etc.) can be subdivided into Sections with :Section and :EndSection statements. Both statements may be followed by an optional and arbitrary name or description. The purpose is to split the
function up into sections that you can open and close in the Editor, thereby aiding
readability and code management. Sections have no effect on the execution of the
code, but must follow the nesting rules of other control structures.
The following picture illustrates the use of sections in a function called
DumpWindow. The function is divided into 5 sections named Comments, Init,
NAs, MakeBitmap and CopyToClipBoard.
The first picture shows the function with all sections closed.
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The next picture shows the effect of opening the Comments section. Notice how this
is delineated by the statements:
:Section Comments
...
:EndSection Comments

And with the Init section opened too:

Chapter 2: The APL Environment

Finally, with all the sections opened:
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Editing Classes
The picture below shows the result of opening the ComponentFile class. Notice
how each function is delineated separately and that each function is individually
line-numbered.
)ed ComponentFile
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The outlining feature really comes into its own when editing classes because you can
collapse and expand whole functions. The picture below shows the effect of collapsing all but the Append method.
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When you edit a class, a separate treeview is optionally displayed in the left pane to
make it easy to navigate within the class. When you click on a name in the treeview,
the editor automatically scrolls the appropriate section into view (if necessary) and
positions the edit cursor at its start. The picture below illustrates the result of opening
the [Methods] section and then clicking on Rename.
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Sections within Scripts
Scripts can also be subdivided into Sections using :Section and :EndSection
statements. As with single functions, the purpose is only to split the script up into sections that you can open and close in the Editor. Sections have no effect on the
execution of the code.
The following picture illustrates a Class named actuarial which, for editing purposes, has been sub-divided into five separate Sections named Main,
MenuHandlers, Validation, Utilities and OldCode. In this picture, all
the Sections are closed.
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The next picture shows the effect of opening just the Main section.

Notice that this section is delimited by the two statements:
:Section Main
...
:EndSection Main
In this picture the 3 functions within the Main section are temporarily closed.
Similarly, the section called Validation is delimited by:
:Section Validation
...
:EndSection Validation
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Find and Replace Dialogs
The Find and Find/Replace dialog boxes are used to locate and modify text in an
Edit window.

Search For

Enter the text string that you want to find. Note that the
text from the last 10 searches is available from the dropdown list. If appropriate, the search text is copied from the
Find Objects tool. This makes it easy to first search for
functions containing a particular string, and then to locate
the string in the functions.

Replace With

Enter the text string that you want to use as a replacement.
Note that the text from the last 10 replacements is available
from the drop-down list.

Match Case

Check this box if you want the search to be case-sensitive.

Match Whole
Word

Check this box if you want the search to only match whole
words.

Use Regular
Expressions

Check this box if you want to use various wild card
symbols.

AutoMove

If checked, the Find or Find/Replace dialog box will
automatically position itself so as not to obscure a matched
search string in the edit window.

Direction

Select Up or Down to control the direction of search.
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Using Find and Replace
Find and Replace work on the concept of a current search string and a current
replace string which are entered using the Find and Find/Replace Dialog boxes.
These boxes also contain buttons for performing search/replace operations.
Suppose that you want to search through a function for references to the string
"Adam". It is probably best to work from the start of the function, so first position the
cursor there (by pressing Ctrl+Home). Then select Find from the Edit menu. The Find
Dialog box will appear on your screen with the input cursor positioned in the edit
box awaiting your input. Type "Adam" and click the Find Next button (or press
Return), and the cursor will locate the first occurrence. Clicking Find Next again will
locate the second occurrence. You can change the direction of the search by selecting
Up instead of Down. You could search another function for "Adam" by opening a
new Edit window for it and clicking Find Next. You do not have to redefine the
search string.
Now let us suppose that you wish to replace all occurrences of "Adam" with
"Amanda". First select Replace from the Edit menu. This will cause the Find Dialog
box to be replaced by the Find/Replace Dialog box. Enter the string "Amanda" into
the box labelled Replace With, then click Replace All. All occurrences of "Adam" in
the current Edit window are changed to "Amanda". To repeat the same global change
in another function, simply open an edit window and click Replace All again. If
instead you only want to change particular instances of "Adam" to "Amanda" you
may use Find Next to locate the ones you want, and then Replace to make each
individual alteration.

Saving and Quitting
To save the function and terminate the edit, press Esc (EP) or select Exit from the File
menu. The new version of the function replaces the previous one (if any) and the edit
window is destroyed.
Alternatively, you can select Fix from the File menu. This fixes the new version of
the function in the workspace, but leaves the edit window open. Note that the history
is also retained, so you can subsequently undo some changes and fix the function
again.
To abandon the edit, press Shift+Esc (QT) or select Abort from the File menu. This
destroys the edit window but does not fix the function. The previous version (if any)
is unchanged.
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The Tracer
The Tracer is a visual debugging aid that allows you to step through an application
line by line. During a Trace you can track the path taken through your code, display
variables in edit windows and watch them change, skip forwards and backwards in a
function. You can cutback the stack to a calling function and use the Session and
Editor to experiment with and correct your code. The Tracer may be invoked in several ways as discussed below.

Tracing an expression
Firstly, you may explicitly trace a function (strictly an expression) by typing an
expression then pressing Ctrl+Enter (TC) or by selecting Trace from the Action menu.
This lets you step through the execution of an expression from the beginning.
In the same way as when you execute a statement by pressing Enter, the expression is
(if necessary) copied down to the input line and then executed. However, if the
expression includes a reference to an unlocked defined function or operator,
execution halts at its first line and a Trace window containing the suspended function or operator is displayed on the screen. The cursor is positioned to the left of the
first line which is highlighted.

Naked Trace
The second way to invoke the Tracer is when you have a suspended function in the
State Indicator and you press Ctrl+Enter (TC) on the empty input line. This is termed
naked trace. The same thing can be achieved by selecting Trace from the Action
menu on the Session Window or by clicking the Trace button in the Trace Tools.
However, in ALL cases it is essential that the input cursor is on the empty Input line
in the Session.
The effect of naked trace is to open the Tracer and to position the cursor on the currently suspended line. It is exactly as if you had Traced to that point from the Input
Line expression whose execution caused the suspension.

Automatic Trace
The third way to invoke the Tracer is to have the system do it automatically for you
whenever an error occurs. This is achieved by setting the Show trace stack on error
option in the Trace/Edit tab of the Configuration dialog (Trace_on_error parameter). When an error occurs, the system will automatically deploy the Tracer. Note
that this means that when an error occurs, the Trace window will then receive the
input focus and not the Session window.
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Tracer Options
From Version 10.1 onwards, the Tracer is designed to be docked in the Session window.
In previous versions of Dyalog APL, the Tracer was implemented as a stack of separate windows (one per function on the calling stack) or as a single, but still separate,
window.
You can disable the standard behaviour by selecting Classic Dyalog mode from the
Trace/Edit tab of the Configuration dialog box.
If you do so, you may then choose to have the Tracer operate in multiple windows or
in a single window.
These alternatives are discussed later in this Chapter.
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The Trace Window
The Tracer is implemented as a single dockable window that displays the function
that is currently being executed. There are two subsidiary information windows
which are also fully dockable. The first of these (SIStack) displays the current function calling stack; the second (Threads) displays a list of running threads.
In the default Session files, the Tracer is docked along the bottom edge of the Session
window. When you invoke the Tracer, it springs up as illustrated below. In this example, the function being traced is ⎕SE.UCMD, which is invoked by typing a user-command, in this case ]display.

In the default layout, the SIstack window is displayed alongside the main Tracer window, although this can be hidden or made to appear as a separate floating window, as
required.
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Trace Tools
The Tracer may be controlled from the keyboard, or by using the Trace Tools which
are arranged along the title bar of the Debugger window. Note that the button names
are solely for reference purposes in the description that follows.
Key
Keystroke
Code

Description

Exec

ER

Enter

Executes the current line

Trace

TC

Ctrl+Enter

Traces execution of the current
line

Back

BK

Ctrl+Shift+Bksp Skips back one line

Fwd

FD

Ctrl+Shift+Enter Skips forward one line

Restart

RM →⎕LC

Button Name

Restart all

Restarts execution of the current
thread, closing all its trace
windows
Restarts execution for all threads,
closing all trace windows

Continue

BH

Edit

ED

Shift+Enter

Invokes the Editor

Exit

EP

Esc

Closes the Trace window, exits
the current function

Ctrl+Pause

Interrupts execution

Intr

Reset

CS

Continues execution of the
current thread, leaving Trace
windows displayed

Clears all break-points (resets
⎕STOP on every function)
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Using the Trace Tools, you can single-step through the function or operator by clicking the Exec and/or Trace buttons. If you click Exec the current line of the function or
operator is executed and the system halts at the next line. If you click Trace, the current line is executed but any defined functions or operators referenced on that line are
themselves traced. After execution of the line the system again halts at the next one.
Using the keyboard, the same effect can be achieved by pressing Enter or Ctrl+Enter.
The illustration below shows the state of execution having clicked Exec 6 times to
reach ⎕SE.UCMD[7].

Execution Reached ⎕SE.UCMD[7]
The next illustration shows the result of clicking Trace at this point. This caused the
system to trace into ⎕SE.SaltUtils.Spice, the function called from
⎕SE.UCMD[7].
Notice how each function call on the stack is represented by an item in the SIstack
window.
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The illustration below shows the state of execution having traced deeper into the system.

Execution reached four levels deep
At this stage, the State Indicator is as follows:
)SI
⎕SE.SALT.Load[1]*
⎕SE.SALTUtils.BootSpice[17]
⎕SE.SALTUtils.Spice[18]
⎕SE.UCMD[7]
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Controlling Execution
The point of execution may be moved by clicking the Back and Fwd buttons in the
Trace Tools window or, using the keyboard, by pressing Ctrl+Shift+Bksp and
Ctrl+Shift+Enter. Notice however that these buttons do not themselves change the
State Indicator or the display in the SIStack window. This happens only when you
restart execution from the new point.
You can cut back the stack by clicking the <EP> button in the Trace Tools window.
This causes execution to be suspended at the start of the line which was previously
traced. The same effect can be achieved using the keyboard by pressing Esc. It can
also be done by selecting Exit from the File menu on the Trace Window or by selecting Close from its system menu.
The <RM> button removes the Trace window and resumes execution. The same is
achieved by the expression →⎕LC. The <BH> button also continues execution, but
leaves the Trace window displayed and allows you to watch its progress.

Using the Session and the Editor
Whilst using the Tracer you can skip to the Session or to any Edit window and back
again. While it is docked, you may resize the Tracer pane by dragging its title bar,
and you may use the buttons provided to maximise, minimise and restore the Tracer
pane within the Session window.
Unless you move it sideways, the cursor is positioned to the left of the suspended
line in the top Trace window. If you press Shift+Enter (ED) with the cursor in this
position, the trace window becomes an edit window allowing you to edit the function or operator on top of the stack. You can achieve the same thing by selecting Edit
from the File menu, but the input cursor MUST again be in the left-most (empty) column, or the system will attempt to open an edit window for the name under the cursor
(point-and-edit).
When you finish editing, the window reverts to a trace window with the new definition of the function or operator displayed.
You may also open a new edit window from within the Tracer using point-and-edit.
You can copy text from a trace window to the session for editing and execution or for
experimentation.
It is possible to skip from the Tracer to the Session and then re-invoke the Tracer on a
different expression.

Chapter 2: The APL Environment

248

Setting Break-Points
Break-points are defined by ⎕STOP and may be toggled on and off in an Edit or
Trace window by clicking in the appropriate column. The example below illustrates
a function with a ⎕STOP break-point set on line [5].

⎕STOP break-points set or cleared in an Edit window are not established until the
function is fixed. ⎕STOP break-points set or cleared in a Trace window are established immediately.

Clearing All Break-Points

You can clear all break-points by pressing the above button in the Trace Tools window. This in fact resets ⎕STOP for all functions in the workspace.
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The Classic mode Tracer
If you select Classic Dyalog mode from the Trace/Edit tab in the Configuration
dialog box, the Tracer behaves in the same way as in Dyalog APL Version 8.2. However, the Tracer is not dockable in the Session.
If you select the Classic mode Tracer, you may choose between multiple trace windows or a single trace window using the Single Trace Window option.

Multiple Trace Windows
The following behaviour is obtained by deselecting the Single Trace Window
option.
l

l

l

l

l

l

l

Each function on the SI stack is represented by a separate trace window.
The top window contains the function that is currently executing, other windows display functions further up the stack, in the order in which they were
called.
When you press Ctrl+Enter or click the Trace button on a line that calls
another function, a new trace window appears on top of the stack and displays the newly called function.
When a function exits, its trace window disappears and the focus moves to
the previous trace window. When the last function in a traced suspension
exits, the last trace window disappears.
If you click the Quit this function button in the Trace Tools window, or
press Escape, or close the trace window by clicking on its [X] button or typing Alt-F4, the top trace window disappears and the focus moves to the previous trace window
If you close any of the trace windows further down the stack, the stack will
be cut back to the corresponding point, i.e. to the line of code that called
the function whose trace window you closed.
The <RM> button removes all the trace windows and resumes execution.
The same is achieved by the expression →⎕LC. The <CS> button also continues execution, but leaves the trace windows displayed and allows you to
watch their progress.
If you minimise any of the trace windows, the entire stack is minimised to a
single icon, from which it may be restored.
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Single Trace Window
The following behaviour is obtained by selecting the Single Trace Window option.
l

l

l

l

l

l

The trace window contains a combo box whose drop-down displays the contents of the SI stack. This box is not provided if there are multiple trace windows.
The trace window is re-used when tracing into, or returning from, a called
function. This means that there is never more than one trace window
present.
When the last function in a traced suspension exits, the trace window disappears.
If you click the Quit this function button in the Trace Tools window, or
press Escape, the current function is removed from the stack and the trace
window reused to display the calling function if there is one.
Closing the trace window by clicking on its [X] button or typing Alt-F4
removes the window and clears the current suspension. It is equivalent to
typing naked branch (→) in the session window.
If you move or resize the trace window, APL remembers its position, so that
it reappears in the same position when next used.
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The Threads Tool
The Threads Tool is used to monitor and debug multi-threaded applications. To display the Threads Tool, select Show Threads Tool from the Session Threads menu, or
Threads from the Session pop-up menu.

The above picture illustrates a situation using the LIFT.DWS workspace after executing the function RUN. The Pause on Error option was enabled and a Stop was set on
RUN[63]. When RUN suspended at this point, all other threads (1-8) were automatically Paused. Note that all other threads happen to be Paused in the middle of
calls to system functions
The columns of the Threads Tool display the following information.
Column

Description

Tid

The Thread ID (⎕TID) and name (⎕TNAME) if set

Location

The currently executing line of function code

State

Indicates what the thread is doing. (see below)

Flags

Normal or Paused.

Treq

The Thread Requirements (⎕TREQ)
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Thread States
State

Description

Pending

Not yet running

Initializing

Not yet running

Defined function

Between lines of a defined function

Dynamic function

Between lines of a dynamic function

Suspended

Indicates that the thread is suspended and is able to
accept input from the Session window.

Session

Indicates that Session window is connected to this
thread.

(no stack)

Indicates that the thread has no SI stack and the Session
is connected to another thread. This state can only occur
for Thread 0.

Exiting

About to be terminated

:Hold

Waiting for a :Hold token

:EndHold

Waiting for a :Hold token

⎕DL

Executing ⎕DL

⎕DQ

Executing ⎕DQ

⎕NA

Waiting for a DLL (⎕NA) call to return.

⎕TGET

Executing ⎕TGET, waiting for a token

⎕TGET
Executing ⎕TGET, having got a token
(Ready to continue)
⎕TSYNC

Waiting for another thread to terminate

Awaiting request

Indicates a thread that is associated with a .NET system
thread, but is currently unused

Called .Net

Waiting for a call to .NET to return.

Paused/Normal
In addition to the thread state as described above, a thread may be Paused or Normal
as shown in the Flags column. A Paused thread is one that has temporarily been
removed from the list of threads that are being scheduled by the thread scheduler. A
Paused thread is effectively frozen.
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Threads Tool Pop-Up Menu

Switch to

Selecting this item causes APL to attempt to suspend (if
necessary) and switch to the selected thread, connecting
it to the Session and Debugger windows.

Refresh Now

Refreshes the Threads Tool display to show the current
position and state of each thread.

Auto Refresh

Selecting this item causes the Threads Tool to be
updated continuously, so that it shows the latest
position and state of each thread.

Pause Threads on
Error

If this item is checked, APL automatically Pauses all
other threads when a thread suspends due to an error or
an interrupt.

Paused

This item toggles a thread between being Paused and
Normal. It Pauses a Normal thread and resumes a
Paused thread.

Pause All

This item causes all threads to be Paused.

Resume All

This item resumes all threads.

Restart All

This item resumes all Paused threads, restarts all
suspended threads, and closes the Debugger.
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Debugging Threads
The Debugger provides a tabbed interface that allows you to easily switch between
suspended threads for debugging purposes. To keep things simple for non-threaded
applications, Tabs are only displayed if there is a thread suspended that is other than
Thread 0. The following picture shows the Debugger open on a multi-threaded application (LIFT.DWS) when only Thread 0 is suspended. This has been achieved by setting a stop on RUN[63]
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In the next picture, the user has chosen to display the Threads Tool and then dock it
between the Session and Debugger windows. Note that only one thread, thread 0
(Run) is suspended. All the other threads are Paused (because Pause on Error is enabled).
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The user then uses the context menu to Switch To Thread 6 (whose name is Lady 6)
which was Paused on PERSON[7] in the middle of a ⎕TGET. The act of switching
to this thread caused it to be suspended at the beginning of its current line PERSON
[7] and the Debugger now displays two Tabs to represent the two suspended
threads. Note that both the thread id and the thread name are displayed on the Tabs.

Note also that the Session window is connected to the thread indicated by the
selected Tab. In this case, typing MYFLOOR into the Session window displays the
value of the local variable MYFLOOR in Thread 6 (Lady 6).
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You can use the Tabs to switch between the suspended threads, so clicking the Tab
labelled 0:Run causes the display to change to the picture shown below. The Session is now connected to Thread 0 (Run), so the value of ⎕LC is 63.
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The Event Viewer
The Event Viewer can be used to monitor events on Dyalog APL GUI objects. To display the Event Viewer, select Event Viewer from the Session Tools menu.
You can choose:
l
l

which types of events you want to monitor
which objects you want to monitor

In the example illustrated above, the user has chosen to monitor events on a Form
#.F. Furthermore, the user has chosen to monitor GotFocus, LostFocus, MouseUp,
MouseDblClick and Configure events. Notice that there is a callback #.FOO
attached to the Configure event.
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The Spy Menu

The Spy menu, illustrated above, provides the following options and actions.
Close:

Closes the Event Viewer

Clear:

Clears all of the event information that is currently
displayed in the Event Viewer.

All:

In this mode all the events are displayed in the Event
Viewer as they occur, whether or not there is an action
associated with them.

As Queued:

In this mode only events that have associated actions
are displayed in the event viewer. Note that KeyPress
events are always queued and therefore always appear,
even if there is no associated action.

SnapShot:

In this mode the Event Viewer displays a snapshot of the
internal event queue. Only those events that are
currently in the internal APL event queue waiting to be
processed are displayed.

Stop Logging:

When checked, this item switches event logging off.
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The Columns Menu

The Columns menu allows you to choose which information is displayed for the
events you are monitoring.
Object

If checked, this item displays the name of the object on
which the event occurred.

Event Name

If checked, this item displays the name of the event that
occurred.

Event Number

If checked, this item displays the event number of the
event that occurred.

Parameters

If checked, this item displays the parameters for the
event that occurred. These are the items that would be
passed in the argument to a callback function.

Action

If checked, this item displays the action associated with
the event, for example the name of a callback function,
or an expression to be executed.

Thread ID

If checked, this item displays the thread id of the thread
in which the event occurred

Nqed

If checked, this item displays 0 or 1 according to
whether or not the event occurred naturally or was
generated programmatically by ⎕NQ.

Event ID

If checked, this item displays the event id of the event
that occurred. This id is used internally.
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The Select Menu

The Select menu allows you to highlight certain events in the Event Viewer. For
example, if you are monitoring TCP/IP events on a number of TCPSockets, you can
highlight just the events for a particular socket.
Select Matching
Events

Highlights all the events that have the same Object and
Event Name (or Event Number) as the currently selected
event.

Select All Events
On This Object

Highlights all the events that have the same Object as
the currently selected event.

Select All Events
Of This Type

Highlights all the events that have the same Event
Name (or Event Number) as the currently selected event

These items are also available from the pop-up menu that appears when you press the
right mouse button over an event displayed in the Event Viewer window.

The Options Menu

The Options menu allows you to choose which information is displayed for the
events you are monitoring.
Always on Top

If checked, this item causes the Event Viewer window to
be displayed above all other windows (including other
application windows).

Use APL font

If checked, this item causes the information displayed in
the Event Viewer window to be displayed using the
APL font (the same font as is used in the Session
window). If not, the system uses the appropriate
Windows font.

Settings...

Displays the Event Viewer Options Dialog Box.
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Options Dialog Box
The Event Viewer Options dialog box allows you to select the objects and events
that you wish to monitor.

Events to view
The list box shows all the events that are support by the Dyalog APL GUI and allows
you to select which events are to be monitored. Only those events that are selected
will be reported. You can sort the events by name or by event number by clicking the
appropriate column header.
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Objects to view
All Objects

If checked, this item enables event reporting on all
Dyalog APL GUI objects.

Objects of Type

If checked, this item activates the adjoining Select
button and disables all other Object selection
mechanisms. Clicking the Select button brings up a
dialog box that allows you to choose which types of
Dyalog APL GUI objects you want to monitor.

Find Tool

This tool allows you to choose a single specific Dyalog
APL GUI object that you want to monitor. To use it,
drag the Find Tool and move it over your Dyalog APL
GUI objects. As you drag it, the individual objects are
highlighted and their details displayed in the Name,
Type, Thread ID and Handle fields. Drop the Find Tool
on the object of your choice.

Select

Clicking this button brings up a dialog box that
displays the entire Dyalog APL GUI structure as a tree
view. You can choose a single object by selecting it.
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The Session Object
Purpose:

The Session object ⎕SE is a special system object that represents
the session window and acts as a parent for the session menus, tool
bar(s) and status bar.

Children

Form, MenuBar, Menu, MsgBox, Font, FileBox, Printer, Bitmap,
Icon, Cursor, Clipboard, Locator, Timer, Metafile, ToolBar,
StatusBar, TipField, TabBar, ImageList, PropertySheet, OLEClient,
TCPSocket, CoolBar, ToolControl, BrowseBox

Properties

Type, Caption, Posn, Size, File, Coord, State, Event, FontObj,
YRange, XRange, Data, TextSize, Handle, HintObj, TipObj,
CurObj, CurPos, CurSpace, Log, Input, Popup, RadiusMode,
MethodList, ChildList, EventList, PropList

Methods

ChooseFont, FileRead, FileWrite

Events

Close, Create, FontOK, FontCancel, WorkspaceLoaded

Description
There is one (and only one) object of type Session and it is called ⎕SE. You may use
⎕WG, ⎕WS and ⎕WN to perform operations on ⎕SE, but you cannot expunge it with
⎕EX nor can you recreate it using ⎕WC. You may however expunge all its children.
This will result in a bare session with no menu bar, tool bar or status bar.
⎕SE is loaded from a session file when APL starts. The name of the session file is
specified by the session_file parameter. If no session file is defined, ⎕SE will have no
children and the session will be devoid of menu bar, tool bar and status bar components.
You may use all of the standard GUI system functions to build or configure the components of the Session to your own requirements. You may also control the Session
by changing certain of its properties.
Note that the Session reports a Create event when APL is first started, and a WorkspaceLoaded event when a workspace is loaded or on a clear ws.
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Read-Only Properties
The following properties of ⎕SE are read-only and may not be set using ⎕WS:
Type

A character vector containing 'Session'

Caption

A character vector containing the current caption in the title bar
of the Session window.

TextSize

Reports the bounding rectangle for a text string. For a full
description, see TextSize in Object Reference.

CurObj

A character vector containing the name of the current object.
This is the name under or immediately to the left of the input
cursor.

CurPos

A 2-element integer vector containing the position of the input
cursor (row and column number) in the session log. This is ⎕IO
dependent. If ⎕IO is 1, and the cursor is positioned on the
character at the beginning of the first (top) line in the log,
CurPos is (1 1). If ⎕IO is 0, its value would be (0 0).

CurSpace

A character vector which identifies the namespace from which
the current expression was executed. If the system is not
executing code, CurSpace is the current space and is equivalent
to the result of ⊃''⎕NS''.

Handle

The window handle of the Session window.

Log

A vector of character vectors containing the most recent set of
lines (input statements and results) that are recorded in the
session log. The first element contains the top line in the log.

Input

A vector of character vectors containing the most recent set of
input statements (lines that you have executed) contained in the
input history buffer.

ChildList

A vector of character vectors containing the types of object that
can be created as a child of ⎕SE.

MethodList

A vector of character vectors containing the names of the
methods associated with ⎕SE.

EventList

A vector of character vectors containing the names of the events
generated by ⎕SE

PropList

A vector of character vectors containing the names of the
properties associated with ⎕SE.
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Read/Write Properties
The following properties of ⎕SE may be changed using ⎕WS:
Coord

Specifies the co-ordinate system for the session window.

Data

May be used to associate arbitrary data with the session object
⎕SE.

Event

You may use this property to attach an expression or callback
function to the Create event or to user-defined events. A callback
attached to the Create event can be used to initialise the Session
when APL starts.

File

The full pathname of the session file that is associated with the
current session. This is the file name used when you save or load
the session by invoking the FileRead or FileWrite method.

Specifies the APL font. In general, the FontObj property may
specify a font in terms of its face name, size, and so forth or it may
specify the name of a Font object. For applications, the latter
FontObj
method is recommended as it will result in better management of
font resources. However, in the case of the Session object, it is
recommended that the former method be used.
Specifies the name of the object in which hints are displayed.
Unless you specify HintObj individually for session components,
this object will be used to display the hints associated with all of
HintObj
the menu items, buttons, and so forth in the session. The object
named by this property is also used to display the message
“Ready...” when APL is waiting for input.
Popup

A character vector that specifies the name of a popup menu to be
displayed when you click the right mouse button in a Session
window.

Posn

A 2-element numeric vector containing the position of the top-left
corner of the session window relative to the top-left corner of the
screen. This is reported and set in units specified by the Coord
property.

Size

A 2-element numeric vector containing the height and width of the
session window expressed in units specified by the Coord property.
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State

An integer that specifies the window state (0=normal, 1=minimised,
2=maximised). You may wish to use this property to minimise and
later restore the session under program control. If you save your
session with State set to 2, your APL session will start off
maximised.

TipObj

Specifies the name of the object in which tips are displayed. Unless
you specify TipObj individually for session components, this object
will be used to display the tips associated with all of the menu
items, buttons, and so forth in the session.

XRange See Object Reference
YRange See Object Reference

Configuring the Session
As supplied, your default session will have a menu bar, a tool bar and a status bar.
There are many ways in which you may configure this set-up, including the following:
You may select a different APL font or character size.
You may alter the appearance of the menus by changing the Caption properties of the
various Menu and MenuItem objects. For example, you may prefer the menus to
appear in your own language.
You may alter the structure of the menus. For example, you may wish to create a
Search menu directly on the menu bar rather than having Find and Replace as part of
the Edit menu.
You may add new Menu and MenuItem objects to the menu bar, or new Button
objects to the tool bar, that execute APL functions or expressions for you. You can
store the code inside the ⎕SE namespace so that it is remains available when you
switch from one workspace to another.
You may add other objects to the tool bar to allow you to provide input for your functions or to display output. For example, you may display a Combo object that offers
you a selection of names applicable to a particular task.
You may add additional toolbars.
You may remove objects too; for example, you can remove fields from the StatusBar
or even delete it entirely. Indeed, you may dispense with the menu bar and/or tool bar
as well.
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This section illustrates how you can configure your session using worked examples.
The examples are by no means exhaustive, but are designed to demonstrate the principles. Please note that the structure and names of the objects used in these examples
may not be identical to your default session as supplied. Before you attempt to
change your session, please check the structure and the object names using ⎕WN and
⎕WG. The supplied session was created using the function BUILD_SESSION in the
workspace BUILDSE. If you wish to make substantial changes to your session, you
may find it most convenient to edit the functions in this workspace, re-run BUILD_
SESSION, and then save it.
Please note that these examples assume that Expose Session Properties is enabled.

Changing the Font
The APL session font is defined by the Font property of ⎕SE. To change the font permanently, you should select a different Font and/or size of Font using the combo and
spinner boxes on the Session toolbar, and save your Session.
Classic Edition is distributed with bitmap fonts suitable for use on your screen, and
TrueType fonts for your printer. You can use the TrueType font on the screen, but it
is less attractive than the bitmap fonts at low resolutions. The bitmap fonts come in
two sizes (16 x 8 and 22 x 11) and two weights (normal and bold). You may select
other sizes, so long as the height is a multiple of 16 or 22. The scaling is performed
automatically by Windows.

Changing Menu Appearance
The name of the Session MenuBar is '⎕SE.mb'. To simplify the specification of
object names, we will first change space to the MenuBar itself:
⎕SE.mb

)CS ⎕SE.mb

The names of the Menu objects owned by the MenuBar are given by the expression:
'Menu' ⎕WN ''
file edit view windows
tools help

session

log

action

The current caption on the file menu is:
file.Caption
&File
To change the Caption to Workspace:
file.Caption←'Workspace'
To change the colour of the New option in the File menu to red:
file.clear.FCol←255 0 0

options
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Reorganising the Menu Structure
This example shows how you may alter the structure of the session menus by adding
a Search menu to the menu bar to provide access to the Find and Find/Replace
dialog boxes and removing these options from the Edit menu.
To simplify the process, we will first change space into the MenuBar object itself:
⎕SE.mb

)CS ⎕SE.mb

Then we can begin by adding the Search menu. You can specify where the new
menu is to be added using its Posn property. In this case, Search will be added at position 3 (after Edit).
'search'⎕WC 'Menu' '&Search' 3
Next we will remove the Find and Replace MenuItem objects from the Edit menu.
Their names can be obtained from ⎕WN:
'MenuItem'⎕WN'edit'
edit.prev edit.next edit.clear
edit.find edit.replace

edit.copy

edit.paste

It is worth noting that these MenuItems perform their actions because their Event
property is set to execute the system operations [Find] and [Replace] respectively when they are selected.
edit.find.Event
Select [Find]
edit.replace.Event
Select [Replace]
The following statement removes them from the Edit menu:
⎕EX¨'edit.find' 'edit.replace'
and the following statements add them to the Search menu:
'search.find' ⎕WC 'MenuItem' '&Find'
('Event' 'Select' '[Find]')
'search.replace' ⎕WC 'MenuItem' '&Replace'
('Event' 'Select' '[Replace]')

Adding your own MenuItem
This example shows how you can add a menu item that executes an APL expression.
In this case we will do something very simple; namely add a Time option to the
Tools menu which will execute ⎕TS. Notice that the statement also defines a Hint.
This will be displayed when you select the option, prior to releasing the mouse button to action it.
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Once again, we will start by changing space into the Tools menu itself
)CS ⎕SE.mb.tools
⎕SE.mb.tools
Then we will define a new MenuItem to perform the action we require:
'ts'⎕WC'MenuItem' '&Time'
('Event' 'Select' '⍎⎕TS')
('Hint' 'Display Timestamp')
The ⍎ symbol is very important and distinguishes an expression to be executed immediately, as in this case, from a callback function. The resulting Tools menu now
appears as follows:

A customised Tools menu
Selecting Time produces the following output in the session:
2007 12 10 17 10 2 0

Adding your own Tool Button
This example shows how you can add a button to the session tool bar that executes
an APL function.
The example function we will use is called XREF. This function analyses another
function, listing the sub-functions that it calls. Instead of returning a result, this example displays the sub-functions in a Form.
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∇ XREF FN;REFS
:If 0<⍴FN
:AndIf 3=⎕NC FN
REFS←⎕REFS FN
REFS←(3=⎕NC REFS)⌿REFS
REFS←(↓REFS)~¨' '
REFS←REFS~⊂FN
:If 0<⍴REFS
'F'⎕WC'Form'('Functions called by ',FN)
F.FontObj←⎕SE.FontObj
'F.L'⎕WC'List'REFS(0 0)(100 100)
:EndIf
:EndIf
∇

To make this function available from a Session tool button, we need to do a number
of things.
Firstly, we must install the function in ⎕SE so that it is always there, regardless of the
current active workspace. This is easily achieved using the Explorer or ⎕NS.
'⎕SE' ⎕NS 'XREF'
Secondly, we need to find another way to specify its argument FN. One possibility
would be to display a dialog box, asking the user to specify the name of the function
to be analysed. A neater solution is to use the CurObj property of ⎕SE which reports
the name under the cursor. Using CurObj, the user can simply place the cursor over
the name of the function to be analysed, and then click the XREF tool button.
To get FN from CurObj, all we need to do is to change the header and lines 1-2 to:
[0]
[1]
[2]

XREF;FN;REFS
:If 0<⍴FN←⎕SE.CurObj
:AndIf 3=⎕NC FN←⎕SE.CurSpace,'.',FN

Notice that the function name reported by CurObj is prefixed by its pathname which
comes from the CurSpace property. This reports the user’s current namespace.
Next we will add a new button to the tool bar in the Tools CoolBand. Ideally we
would use a suitable bitmap, but to simplify the example, we will use a standard text
button:
)CS ⎕SE.cbtop.bandtb3.tb
⎕SE.cbtop.bandtb3.tb
'xref' ⎕WC 'Button' 'XREF'
'xref' ⎕WS 'Event' 'Select' '⍎⎕SE.XREF'

Adding a tool button
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User Commands
Dyalog APL includes a mechanism to define User Commands.
User commands are developer tools, written in APL, which can be executed without
having to explicitly copy code into your workspace and/or save it in every workspace in which you want to use it.
A User Command is a name prefixed by a closing square bracket, which may be niladic or take an argument. A User Command executes APL code that is typically stored
somewhere outside the current active workspace.
By default, the existing SPICE command processor is hooked up to the user command mechanism, and a number of new SPICE commands have been added. For example:
]display 'hello' (⍪'world')
┌→────────────┐
│ ┌→────┐ ┌→┐ │
│ │hello│ ↓w│ │
│ └─────┘ │o│ │
│
│r│ │
│
│l│ │
│
│d│ │
│
│w│ │
│
└─┘ │
└∊────────────┘
The implementation of User Commands is very simple: If a line of input begins with
a closing square bracket (]), and there exists a function by the name ⎕SE.UCMD,
then the interpreter will call that function, passing the input line (without the
bracket) as the right argument.
To add a user command, drop a new Spice command file in the folder SALT\Spice.
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Chapter 3:
APL Files

Introduction
Most languages store programs and data separately. APL is unusual in that it allows
you to store programs and data together in a workspace.
This can be inefficient if your dataset gets very large; when your workspace is
loaded, you are loading ALL of your data, whether you need it or not.
It also makes it difficult for other users to access your data, particularly if you want
them to be able to update it.
In these circumstances, you must extract your data from your workspace, and write it
to a file on disk, thus separating your data from your program. There are many different kinds of file format. This section is concerned with the APL Component File
system which preserves the idea that your data consists of APL objects; hence you
can only access this type of file from within APL
The Component File system has a set of system functions through which you access
the file. Although this means that you have to learn a whole new set of functions in
order to use files, you will find that they provide you with a very powerful mechanism to control access to your data.
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Component Files
Overview
A component file is a data file maintained by Dyalog APL. It contains a series of
APL arrays known as components which are accessed by reference to their relative
position or component number within the file. Component files are just like other
data files and there are no special restrictions imposed on names or sizes.
A set of system functions is supplied to perform a range of file operations. These provide facilities to create or delete files, and to read and write components. Facilities
are also provided for multi-user access, including the capability to determine who
may do what, and file locking for concurrent updates.

Tying and Untying Files
To access an existing component file it must be tied, i.e. opened for use. The tie may
be exclusive (single-user access) or shared (multi-user access). A file is untied, i.e.
closed, using ⎕FUNTIE or on terminating Dyalog APL. File ties survive )LOAD,
⎕LOAD and )CLEAR operations.

Tie Numbers
A file is tied by associating a file name with a tie number. Tie numbers are integers
in the range 1 - 2147483647 and, you can supply one explicitly, or have the interpreter allocate the next available one by specifying 0. The system functions which tie
files return the tie number as a ‘shy’ result.

Creating and Removing Files
A component file is created using ⎕FCREATE which automatically ties the file for
exclusive use. A newly created file is empty, i.e. contains 0 components. A file is
removed with ⎕FERASE, although it must be exclusively tied to do so.

Adding and Removing Components
Components are added to a file using ⎕FAPPEND and removed using ⎕FDROP. Component numbers are allocated consecutively starting at 1. Thus a new component
added by ⎕FAPPEND is given a component number which is one greater that that of
the last component in the file. Components may be removed from the beginning or
end of the file, but not from the middle. Component numbers are therefore contiguous.
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Reading and Writing Components
Components are read using ⎕FREAD and overwritten using ⎕FREPLACE. There are
no restrictions on the size or type of array which may replace an existing component.
Components are accessed by component number, and may be read or overwritten at
random.

Component Information
In addition to the data held in a component, the user ID that wrote it and the time at
which it was written is also recorded. This control information is useful in providing
an audit trail and in facilitating partial backups of components that have changed.

Multi-User Access
⎕FSTIE ties a file for shared (i.e. multi-user) access. This kind of access would be
appropriate for a multi-user UNIX system, a network of single user PCs, or multiple
APL tasks under Microsoft Windows.
⎕FHOLD provides the means for the user to temporarily prevent other co-operating
users from accessing one or more files. This is necessary to allow a single logical
update involving more than one component, and perhaps more than one file, to be
completed without interference from another user. ⎕FHOLD is applicable to External
Variables as well as Component Files

File Access Control
There are two levels of file access control. As a regular data file, the operating system
read/write controls for owner and other users apply. In addition, Dyalog APL manages its own access controls using the access matrix. This is an integer matrix with 3
columns and any number of rows. Column 1 contains user numbers, column 2 an
encoding of permitted file operations, and column 3 passnumbers. Each row specifies
which file operations may be performed by which user(s) with which passnumber.

User Number
This is a number which is defined by the aplnid parameter. If you intend to use Dyalog APL’s access matrix to control file access in a multi-user environment, it is desirable to allocate to each user, a distinct user number. However, if you intend to rely
on under-lying operating system controls, allocating a user number of 0 to everyone
is more appropriate. A user number of 0 (which is the installation default), causes
APL to circumvent the access matrix mechanism described below.
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Permission Code
This is an integer representation of a Boolean mask. Each bit in the mask indicates
whether or not a particular file operation is permitted as follows:
┌──┬──┬──┬──┬──┬──┬─┬─┬─┬─┬─┬─┬─┬─┬─┐ Bit No.
│15│14│13│12│11│10│9│8│7│6│5│4│3│2│1│
└──┴──┴──┴──┴──┴──┴─┴─┴─┴─┴─┴─┴─┴─┴─┘ File
Access
↑ ↑ ↑ ↑ ↑ ↑
↑
↑ ↑ ↑ ↑ ↑ ↑
Operation
Code
│ │ │ │ │ │
│
│ │ │ │ │ │
│ │ │ │ │ │
│
│ │ │ │ │ └── ⎕FREAD
1
│ │ │ │ │ │
│
│ │ │ │ └──── ⎕FTIE
2
│ │ │ │ │ │
│
│ │ │ └────── ⎕FERASE
4
│ │ │ │ │ │
│
│ │ └──────── ⎕FAPPEND
8
│ │ │ │ │ │
│
│ └────────── ⎕FREPLACE
16
│ │ │ │ │ │
│
└──────────── ⎕FDROP
32
│ │ │ │ │ │
│
│ │ │ │ │ │
└──────────────── ⎕FRENAME
128
│ │ │ │ │ │
│ │ │ │ │ └──────────────────── ⎕FRDCI
512
│ │ │ │ └─────────────────────── ⎕FRESIZE
1024
│ │ │ └────────────────────────── ⎕FHOLD
2048
│ │ └───────────────────────────── ⎕FRDAC
4096
│ └──────────────────────────────── ⎕FSTAC
8192
└─────────────────────────────────── ⎕FHIST
16384
For example, if bits 1, 4 and 6 are set and all other relevant bits are zero only
⎕FREAD, ⎕FAPPEND and ⎕FDROP are permitted. A convenient way to set up the
mask is to sum the access codes associated with each operation.
For example, the value 41 (1+8+32) authorises ⎕FREAD, ⎕FAPPEND and ⎕FDROP.
A value of ¯1 (all bits set) permits all operations. Thus by subtracting the access
codes of operations to be forbidden, it is possible to permit all but certain types of
access. For example, a value of ¯133 (¯1- 4+128) permits all operations except
⎕FERASE and ⎕FRENAME. Note that the value of unused bits is ignored. Any nonzero permission code allows ⎕FSTIE and ⎕FSIZE. ⎕FCREATE, ⎕FUNTIE, ⎕FLIB,
⎕FNAMES and ⎕FNUMS are not subject to access control. Passnumbers may also be
used to establish different levels of access for the same user.
When the user attempts to tie a file using ⎕FTIE or ⎕FSTIE a row of the access
matrix is selected to control this and subsequent operations.
If the user is the owner, and the owner's user ID does not appear in the access matrix,
the value (⎕AI[1] ¯1 0) is conceptually appended to the access matrix. This
ensures that the owner has full access rights unless they are explicitly restricted.
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The chosen row is the first row in which the value in column 1 of the access matrix
matches the user ID and the value in column 3 matches the supplied passnumber
which is taken to be zero if omitted.
If there is no match of user ID and passnumber in the access matrix (including implicitly added rows) then no access is granted and the tie fails with a FILE ACCESS
ERROR.
Once the applicable row of the access matrix is selected, it is used to verify all subsequent file operations. The passnumber used to tie the file MUST be used for every
subsequent operation. Secondly, the appropriate bit in the permission code corresponding to the file operation in question must be set. If either of these conditions
is broken, the operation will fail with FILE ACCESS ERROR.
If the access matrix is changed while a user has the file tied, the change takes immediate effect. When the user next attempts to access the file, the applicable row in the
access matrix will be reselected subject to the supplied passnumber being the same as
that used to tie the file. If access with that password is rescinded the operation will
fail with FILE ACCESS ERROR.
When a file is created using ⎕FCREATE, the access matrix is empty. At this stage, the
owner has full access with passnumber 0, but no access with a non-zero passnumber.
Other users have no access permissions. Thus only the owner may initialise the
access matrix.

User 0
If a user has an aplnid of 0, the access matrix and supplied passnumbers are ignored.
This user is granted full and unrestricted access rights to all component files, subject
only to underlying operating system restrictions.

General File Operations
⎕FLIB gives a list of component files in a given directory. ⎕FNAMES and ⎕FNUMS
give a list of the names and tie numbers of tied files. These general operations which
apply to more than one file are not subject to access controls.
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Component File System Functions
See Language Reference for full details of the syntax of these system functions.
General
⎕FAVAIL

Report file system availability

File Operations
⎕FCREATE

Create a file

⎕FTIE

Tie an existing file (exclusive)

⎕FSTIE

Tie an existing file (shared)

⎕FUNTIE

Untie file(s)

⎕FCOPY

Copy a file

⎕FERASE

Erase a file

⎕FRENAME

Rename a file

File information
⎕FHIST

Report file events

⎕FNUMS

Report tie numbers of tied files

⎕FNAMES

Report names of tied files

⎕FLIB

Report names of component files

⎕FPROPS

Report file properties

⎕FSIZE

Report size of file

Writing to the file
⎕FAPPEND

Append a component to the file

⎕FREPLACE

Replace an existing component

Reading from a file
⎕FREAD

Read one or more components

⎕FRDCI

Read component information
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Manipulating a file
⎕FDROP

Drop a block of components

⎕FRESIZE

Change file size (forces a compaction)

⎕FCHK

Check and repair a file

Access manipulation
⎕FSTAC

Set file access matrix

⎕FRDAC

Read file access matrix

Control multi-user access
⎕FHOLD

Hold file(s) - see later section for details

Using the Component File System
Let us suppose that you have written an APL system that builds a personnel database,
containing the name, age and place of birth of each employee. Let us assume that you
have created a variable DATA, which is a nested vector with each element containing
a person's name, age and place of birth:
DISPLAY 2↑DATA
.→-------------------------------------------------------.
| .→----------------------. .→-------------------------. |
| | .→-------.
.→----. | | .→------.
.→--------. | |
| | |Jonathan| 42 |Wales| | | |Pauline| 21 |Isleworth| | |
| | '--------'
'-----' | | '-------'
'---------' | |
| '∊----------------------' '∊-------------------------' |
'∊-------------------------------------------------------'

Then the following APL expressions can be used to access the database:

Example 1:
Show record 2
DISPLAY 2⊃DATA
.→-------------------------.
| .→------.
.→--------. |
| |Pauline| 21 |Isleworth| |
| '-------'
'---------' |
'∊-------------------------'

Example 2:
How many people in the database?
123

⍴DATA
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Example 3:
Update Pauline's age
(2 2⊃DATA)←16

Example 4:
Add a new record to the database
DATA ,← ⊂'Maurice' 18 'London'
Now let's build a component file to hold our personnel database.
Create a new file, giving the file name, and the number you wish to use to identify it
(the file tie number):
'COMPFILE' ⎕FCREATE 1
If the file already exists, or you have already used this tie number, then APL will
respond with the appropriate error message.
Now write the data to the file. We could write a function that loops to do this, but it
is neater to take advantage of the fact that our data is a nested vector, and use each
(¨).
DATA ⎕FAPPEND¨ 1
Now we'll try our previous examples using this file.

Example 1:
Show record 2
DISPLAY ⎕FREAD 1 2
.→-------------------------.
| .→------.
.→--------. |
| |Pauline| 21 |Isleworth| |
| '-------'
'---------' |
'∊-------------------------'

Example 2:
How many people in our database?
⎕FSIZE 1
⍝ First component, next
1 125 10324 4294967295 ⍝ component, file size,
⍝ maximum file size
¯1+2⊃⎕FSIZE 1

⍝ Number of data items

The fourth element of ⎕FSIZE indicates the file size limit. Dyalog APL does not
impose a file size limit, although your operating system may do so, but the concept is
retained in order to make this version of Component Files compatible with others.
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Example 3:
Update Pauline's age
REC ← ⎕FREAD 1 2
REC[2] ← 18
REC ⎕FREPLACE 1 2

⍝ Read second component
⍝ Change age
⍝ And replace component

Example 4:
Add a new record
('Janet' 25 'Basingstoke') ⎕FAPPEND 1

Example 5:
Rename our file
'PERSONNEL' ⎕FRENAME 1

Example 6:
Tie an existing file; give file name and have the interpreter allocate the next available tie number.
2

'SALARIES' ⎕FTIE 0

Example 7:
Give everyone access to the PERSONNEL file
(1 3⍴0 ¯1 0)⎕FSTAC 1

Example 8:
Set different permissions on SALARIES.
AM ← 1 3⍴1 ¯1 0
AM⍪← 102 1 0
AM⍪← 210 2073 0

⍝ Owner ID 1 has full access
⍝ User ID 102 has READ only
⍝ User ID 210 has
⍝ READ+APPEND+REPLACE+HOLD

AM ⎕FSTAC 2

⍝ Store access matrix

Example 9:
Report on file names and associated numbers
⎕FNAMES,⎕FNUMS
PERSONNEL 1
SALARIES
2
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Example 10:
Untie all files
⎕FUNTIE ⎕FNUMS

Programming Techniques
Controlling Multi-User Access
Obviously, Dyalog APL contains mechanisms that prevent data getting mixed up if
two users update a file at the same time. However, it is the programmer's responsibility to control the logic of multi-user updates.
For example, suppose two people are updating our database at the same time. The
first checks to see if there is an entry for 'Geoff', sees that there isn't so adds a new
record. Meanwhile, the second user is checking for the same thing, and so also adds a
record for 'Geoff'. Each user would be running code similar to that shown below:
[1]
[2]
[3]
[4]
[5]
[6]

∇

∇

UPDATE;DATA;NAMES
⍝ Using the component file
'PERSONNEL' ⎕FSTIE 1
NAMES←⊃∘⎕FREAD ¨ 1,¨⍳¯1+2⊃⎕FSIZE 1
→END×⍳(⊂'Geoff')∊NAMES
('Geoff' 41 'Hounslow')⎕FAPPEND 1
END:⎕FUNTIE 1

The system function ⎕FHOLD provides the means for the user to temporarily prevent
other co-operating users from accessing one or more files. This is necessary to allow a
single logical update, perhaps involving more than one record or more than one file,
to be completed without interference from another user.
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The code above is replaced by that below:
∇ UPDATE;DATA;NAMES
[1] ⍝ Using the component file
[2] 'PERSONNEL' ⎕FSTIE 1
[3] ⎕FHOLD 1
[4] NAMES←⊃∘⎕FREAD ¨ 1,¨⍳¯1+2⊃⎕FSIZE 1
[5] →END×⍳(⊂'Geoff')∊NAMES
[6] ('Geoff' 41 'Hounslow')⎕FAPPEND 1
[7] END:⎕FUNTIE 1 ⋄ ⎕FHOLD ⍳0
∇
Successive ⎕FHOLDs on a file executed by different users are queued by Dyalog
APL; once the first ⎕FHOLD is released, the next on the queue holds the file.
⎕FHOLDs are released by return to immediate execution, by ⎕FHOLD ⍬, or by erasing the external variable.
It is easy to misunderstand the effect of ⎕FHOLD. It is NOT a file locking mechanism
that prevents other users from accessing the file. It only works if the tasks that wish to
access the file co-operate by queuing for access by issuing ⎕FHOLDs. It would be
very inefficient to issue a ⎕FHOLD on a file then allow the user to interactively edit
the data with the hold in operation. What happens if he goes to lunch? Any other
user who wants to access the file and cooperates by issuing a ⎕FHOLD would have to
wait in the queue for 3 hours until the first user returns, finishes his update and his
⎕FHOLD is released. It is usually more efficient (as well as more friendly) to issue
⎕FHOLDs around a small piece of critical code.
Suppose we had a control file associated with our personnel data base. This control
file could be an external variable, or a component file. In both cases, the concept is
the same; only the commands needed to access the file are different. In this example,
we will use a component file:
'CONTROL'⎕FCREATE 1
(1 3⍴0 ¯1 0) ⎕FSTAC 1
⍬ ⎕FAPPEND 1
⎕FUNTIE 1

⍝
⍝
⍝
⍝

Create control file
Allow everyone access
Set component 1 to empty
And untie it
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Now we'll allow our man that likes long lunch breaks to edit the file, but will control
the hold in a more efficient way:
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[8]
[9]
[10]
[11]
[12]
[13]
[14]
[15]
[16]
[17]
[18]
[19]
[20]
[21]
[22]
[23]
[26]
[27]
[28]

∇

∇

EDIT;CMP;CV
⍝ Share-tie the control file
'CONTROL' ⎕FSTIE 1
⍝ Share-tie the data file
'PERSONNEL' ⎕FSTIE 2
⍝ Find out which component the user wants to edit
ASK:CMP←ASK∆WHICH∆RECORD
⍝ Hold the control file
⎕FHOLD 1
⍝ Read the control vector
CV←⎕FREAD 1 1
⍝ Make control vector as big as the data file
CV←(¯1+2⊃⎕FSIZE 2)↑CV
⍝ Look at flag for this component
→(FREE,INUSE)[1+CMP⊃CV]
⍝ In use - tell user and release hold
INUSE:'Record in use' ⋄ ⎕FHOLD ⍬ ⋄ →ASK
⍝ Ok to use - flag in-use and release hold
FREE:CV[CMP]←1 ⋄ CV ⎕FREPLACE 1 1⋄ ⎕FHOLD ⍬
⍝ Let user edit the record
EDIT∆RECORD RECORD
⍝ When he's finished, clear the control vector
⎕FHOLD 1
CV←⎕FREAD 1 1 ⋄CV[CMP]←0 ⋄ CV ⎕FREPLACE 1 1
⎕FHOLD ⍬
⍝ And repeat
→ASK

Component 1 of our CONTROL file acts as a control vector. Its length is set equal to
the number of components in the PERSONNEL file, and an element is set to 1 if a
user wishes to access the corresponding data component. Only the control file is ever
subject to a ⎕FHOLD, and then only for a split-second, with no user inter-action
being performed whilst the hold is active.
When the first user runs the function, the relevant entry in the control vector will be
set to 1. If a second user accesses the database at the same time, he will have to wait
briefly whilst the control vector is updated. If he wants the same component as the
first user, he will be told that it is in use, and will be given the opportunity to edit
something else.
This simple mechanism allows us to lock the components of our file, rather the than
entire file. You can set up more informative control vectors than the one above; for
example, you could easily put the user name into the control vector and this would
enable you to tell the next user who is editing the component he is interested in.
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File Design
Our personnel database could be termed a record oriented system. All the information relating to one person is easily obtained, and information relating to a new
person is easily added, but if we wish to find the oldest person, we have to read ALL
the records in the file.
It is sometimes more useful to have separate components, perhaps stored on separate
files, that hold indexes of the data fields that you may wish to search on. For example, suppose we know that we always want to access our personnel database by
name. Then it would make sense to hold an index component of names:
⍝ Extract name field from each data record
'PERSONNEL' ⎕FSTIE 1
NAMES←⊃∘⎕FREAD¨1,¨⍳¯1+2⊃⎕FSIZE 2
⍝ Create index file, and append NAMES
'INDEX' ⎕FCREATE 2
NAMES ⎕FAPPEND 2
Then if we want to find Pauline's data record:
NAMES←⎕FREAD 2,1
CMP←NAMES⍳⊂'Pauline'
DATA←⎕FREAD 1,CMP

⍝ Read index of names
⍝ Search for Pauline
⍝ Read relevant record

There are many different ways to structure data files; you must design a structure that
is the most efficient for your application.

Internal Structure
If you are going to make a lot of use of APL files in your systems, it is useful for you
to have a rough idea of how Dyalog APL organises and manages the disk area used
by such files.
The internal structure of external variables and component files is the same, and the
examples given below apply to both.
Consider a component file with 3 components:
'TEMP' ⎕FCREATE 1
'One' 'Two' 'Three' ⎕FAPPEND¨1
Dyalog APL will write these components onto contiguous areas of disk:
.-.
.-.
.-.
|1|
|2|
|3|
.-----.-----.-------.
| One | Two | Three |
--------------------.
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Replace the second component with something the same size:
'Six' ⎕FREPLACE 1 2
This will fit into the area currently used by component 2.
.-.
.-.
.-.
|1|
|2|
|3|
.-----.-----.-------.
| One | Six | Three |
--------------------.
If your system uses fixed length records, then the size of your components never
change, and the internal structure of the file remains static.
However, suppose we start replacing larger data objects:
'Bigger One' ⎕FREPLACE 1 1
This will not fit into the area currently assigned to component 1, so it is appended to
the end of the file. Dyalog APL maintains internal tables which contain the location
of each component; hence, even though the components may not be physically
stored in order, they can always be accessed in order.
.-.
.-.
.-.
|2|
|3|
|1|
.-----.-----.-------.------------.
|⎕⎕⎕⎕⎕| Six | Three | Bigger One |
---------------------------------.
The area that was occupied by component 1 now becomes free.
Now we'll replace component 3 with something bigger:
'BigThree' ⎕FREPLACE 1 3
Component 3 is appended to the end of the file, and the area that was used before
becomes free:
.-.
.-.
.-.
|2|
|1|
|3|
.-----.------------------.------------.----------.
|⎕⎕⎕⎕⎕| Six |⎕⎕⎕⎕⎕⎕⎕⎕⎕⎕⎕⎕| Bigger One | BigThree |
-------------------------------------------------.
Dyalog APL keeps tables of the size and location of the free areas, as well as the
actual location of your data. Now we'll replace component 2 with something bigger:
'BigTwo' ⎕FREPLACE 1 2
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Free areas are used whenever possible, and contiguous holes are amalgamated.
.-.
.-.
.-.
|2|
|1|
|3|
.-----------.------------.------------.----------.
|⎕⎕⎕⎕⎕⎕⎕⎕⎕⎕⎕|BigTwo|⎕⎕⎕⎕⎕| Bigger One | BigThree |
-------------------------------------------------.
You can see that if you are continually updating your file with larger data objects,
then the file structure can become fragmented. At any one time, the disk area occupied by your file will be greater than the area necessary to hold your data. However,
free areas are constantly being reused, so that the amount of unused space in the file
will seldom exceed 30%.
Whenever you issue a monadic ⎕FRESIZE command on a component file, Dyalog
APL COMPACTS the file; that is, it restructures it by reordering the components and
by amalgamating the free areas at the end of the file. It then truncates the file and
releases the disk space back to the operating system (note that some versions of
UNIX do not allow the space to be released). For a large file with many components,
this process may take a significant time.

Error Conditions
FILE SYSTEM NOT AVAILABLE
In a PC network, or in a single-processor Unix environment, if the FSCB file is missing or inaccessible (restricted access permissions) the report FILE SYSTEM NOT
AVAILABLE (Error code 28) will be given. The same error will occur under NFS if
the aplfscb "daemon" is not running.
FILE SYSTEM TIES USED UP
The FSCB file has a limited capacity and when that capacity is reached the report
FILE SYSTEM TIES USED UP (Error code 30) will be given.
FILE TIED
A FILE TIED error is reported if you attempt to tie a file which another user has
exclusively tied. However, it is possible to get spurious FILE TIED errors in a network for the following reason.
If an APL session has component files tied or has External Variables associated, and
terminates abnormally, the FSCB will continue to record the file ties, even though
the session is no longer running. To prevent another user (or even the same application restarted) from getting spurious FILE TIED errors, APL checks whether the
process flagged as having a file tied is actually running. If not, the entry is cleared
and the new tie honoured.
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In a networked environment, it is not possible for a process running on one node to
check the status of a process running on another. If a node with component files tied
crashes, its file ties will remain (incorrectly) recorded in the FSCB until either that
node itself attempts to re-tie the files or until the FSCB is re-initialised.

Limitations
File Tie Quota
The File Tie Quota is the maximum number of files that a user may tie concurrently.
Dyalog APL itself allows a maximum of 256 under Unix and Windows, although in
either case your installation may impose a lower limit. When an attempt is made to
exceed this limit, the report FILE TIE QUOTA (Error code 31) is given. On a UNIX
system, there is a system-wide and a per-user limit on the number of open file descriptors. On many systems, the per-user limit is 20, and the system-wide limit about 100.
Both limits are usually parameters specified when Unix is installed. Under Windows,
the maximum number of open files permitted is specified by the "FILES=" statement in CONFIG.SYS.

File Name Quota
Dyalog APL records the names of each user's tied files in a buffer of 40960 bytes.
When this buffer is full, the report FILE NAME QUOTA USED UP (Error code 32)
will be given. This is only likely to occur if long pathnames are used to identify files.

The Effect of Buffering
Disk drives are fairly slow devices, so most operating systems take advantage of a
facility called buffering. This is shown in simple terms below:
.------------------.
| Operating System |
.--------.
.---------.
| instruction to
|-->| BUFFER |--->| File on |
| write large data |
---------.
| disk
|
| object to a file |
----------.
-------------------.
When you issue a write to a disk area, the data is not necessarily sent straight to the
disk. Sometimes it is written to an internal buffer (or cache), which is usually held in
(fast) main memory. When the buffer is full, the contents are passed to the disk. This
means that at any one time, you could have data in the buffer, as well as on the disk.
If you machine goes down whilst in this state, you could have a partially updated file
on the disk. In these circumstances, the operating system generally recovers your file
automatically.
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If this facility is exploited, it offers very fast file updating. For systems that are I/O
bound, this is a very important consideration. However, the disadvantage is that
whilst it may appear that a write operation has completed successfully, part of the
data may still be residing in the buffer, waiting to be flushed out to the disk. It is
usually possible to force the buffer to empty; see your operating system manuals for
details (UNIX automatically invokes the sync() command every few seconds to
flush its internal buffers).
Dyalog APL exploits this facility, employing buffers internal to APL as well as making use of the system buffers. Of course, these techniques cannot be used when the
file is shared with other users; obviously, the updates must be written immediately to
the disk. However, if the file is exclusively tied, then several layers of buffers are
employed to ensure that file access is as fast as possible.
You can ensure that the contents of all internal buffers are flushed to disk by issuing
⎕FUNTIE ⍬ at any time.

Integrity and Security
The structure of component files, the asynchronous nature of the buffering performed
by APL, by the Operating System, and by the external device sub-system, introduces
the potential danger that a component file might become damaged. To prevent this
happening, the component file system includes optional journaling and check-sum
features. These are optional because the additional security these features provide
comes at the cost of reduced performance. You can choose the level of security that is
appropriate for your application.
When journaling is enabled (see ⎕FPROPS), files are updated using a journal which
effectively prevents system or network failures from causing file damage.
Additional security is provided by the check sum facility which enables component
files to be repaired using the system function ⎕FCHK.
Level 1 journaling protects a component file from damage caused by an abnormal termination of the APL process. This could occur if the process is deliberately or accidentally terminated by the user or by the Operating System, or by an error in Dyalog
APL.
Level 2 journaling provides protection not just against the possibility that the APL
process terminates abnormally, but that the Operating System itself fails. However, a
damaged component file must be explicitly repaired using the system function
⎕FCHK which will repair any damaged components by rolling them back to their previous states.
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Level 3 provides the same level of protection as Level 2, but following the abnormal
termination of either APL or the Operating System, the rollback of an incomplete
update will be automatic and no explicit repair will be needed.
Higher levels of Journaling inevitably reduce the performance of component file
updates.
For further information, see ⎕FPROPS and ⎕FCHK.

Operating System Commands
APL files are treated as normal data files by the operating system, and may be manipulated by any of the standard operating system commands.
Do not use operating system commands to copy, erase or move component files that
are tied and in use by an APL session.
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Chapter 4:
Error Trapping

Error Trapping Concepts
The purpose of this section is to show some of the ways in which the ideas of error
trapping can be used to great effect to change the flow of control in a system.
Most APLs have error trapping facilities in one form or another, but this section discusses the facilities available to a Dyalog APL programmer.
First, we must have an idea of what is meant by error trapping. We are all used to
entering some duff APL code, and seeing a (sometimes) rather obscure, esoteric error
message echoed back:
10÷0
DOMAIN ERROR
10÷0
^
Now, these sorts of error messages are fine for us clever APL programmers, but meaningless to most of our users. We need to find a way to bypass the default action of
APL, so that we can take an action of our own.
Every error message reported by Dyalog APL has a corresponding error number (for a
list of error codes and message, see ⎕TRAP, Language Reference). Many of these error
numbers plus messages are common across all versions of APL. We can see that the
code for DOMAIN ERROR is 11, whilst LENGTH ERROR has code 5.
Dyalog APL provides two distinct but related mechanisms for the trapping and control of errors. The first is based on the control structure :Trap ... :EndTrap,
and the second, on the system variable ⎕TRAP. The control structure is easier to
administer and so is recommended for normal use, while the system variable provides
slightly finer control and may be necessary for specialist applications.
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Last Error number and Diagnostic Message
Dyalog APL keeps a note of the last error that occurred, and provides this information through system functions: ⎕EN, ⎕EM and ⎕DM.
10÷0
DOMAIN ERROR
10÷0
^
Error Number for last occurring error:
11

⎕EN

Error Message associated with code 11:
⎕EM 11
DOMAIN ERROR
⎕DM (Diagnostic Message) is a 3 element nested vector containing error message,
expression and caret:
⎕DM
DOMAIN ERROR

10÷0

^

Use function DISPLAY to show structure:
DISPLAY ⎕DM
┌→─────────────────────────────────────┐
│ ┌→───────────┐ ┌→─────────┐ ┌→─────┐ │
│ │DOMAIN ERROR│ │
10÷0│ │
∧│ │
│ └────────────┘ └──────────┘ └──────┘ │
└∊─────────────────────────────────────┘
Mix (↑) of this vector produces a matrix that displays the same as the error message
produced by APL:
↑⎕DM
DOMAIN ERROR
10÷0
^
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Error Trapping Control Structure
You can embed a number of lines of code in a :Trap control structure within a
defined function.
[1]
[2]
[3]
[4]
[5]
[6]

...
:Trap 0
...
...
:EndTrap
...

Now, whenever any error occurs in one of the enclosed lines, or in a function called
from one of the lines, processing stops immediately and control is transferred to the
line following the :EndTrap. The 0 argument to :Trap, in this case represents any
error. To trap only specific errors, you could use a vector of error numbers:
[2]

:Trap 11 2 3

Notice that in this case, no extra lines are executed after an error. Control is passed to
line [6] either when an error has occurred, or if all the lines have been executed
without error. If you want to execute some code only after an error, you could re-code
the example like this:
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[8]
[9]

...
:Trap 0
...
...
:Else
...
...
:EndTrap
...

Now, if an error occurs in lines [3-4], (or in a function called from those lines), control will be passed immediately to the line following the :Else statement. On the
other hand, if all the lines between :Trap and :Else complete successfully, control will pass out of the control structure to (in this case) line [9].
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The final refinement is that specific error cases can be accommodated using :Case
[List] constructs in the same manner as the :Select control structure.
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[8]
[9]
[10]

:Trap 17+⍳21
⍝ Component file errors.
tie←name ⎕ftie 0
⍝ Try to tie file
'OK'
:Case 22
'Can''t find ',name
:CaseList 25+⍳13
'Resource Problem'
:Else
'Unexpected Problem'
:EndTrap

Note that :Trap can be used in conjunction with ⎕SIGNAL described below.
Traps can be nested. In the following example, code in the inner trap structure
attempts to tie a component file, and if unsuccessful, tries to create one. In either case,
the tie number is then passed to function ProcessFile. If an error other than 22
(FILE NAME ERROR) occurs in the inner trap structure, or an error occurs in function ProcessFile (or any of its called function), control passes to line immediately to line [9].
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[8]
[9]
[10]

:Trap 0
:Trap 22
tie←name ⎕ftie 0
:Else
tie←name ⎕fcreate 0
:EndTrap
ProcessFile tie
:Else
'Unexpected Error'
:EndTrap
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Trap System Variable: ⎕TRAP
The second way of trapping errors is to use the system variable: ⎕TRAP.
⎕TRAP, can be assigned a nested vector of trap specifications. Each trap specification is itself a nested vector, of length 3, with each element defined as:
list of error
numbers

The error numbers we are interested in.

action code

Either 'E' (Execute) or 'C' (Cut Back). There are
others, but they are seldom used.

action to be taken

APL expression, usually a branch statement or a call to
an APL function.

So a single trap specification may be set up as:
⎕TRAP←5 'E' 'ACTION1'
and a multiple trap specification as:
⎕TRAP←(5 'E' 'ACTION1')((1 2 3) 'C' 'ACTION2')
The action code E tells APL that you want your action to be taken in the function in
which the error occurred, whereas the code C indicates that you want your action to
be taken in the function where the ⎕TRAP was localised. If necessary, APL must first
travel back up the execution stack (cut-back) until it reaches that function.

Example Traps
These action codes are best illustrated by example.

Dividing by Zero
Let's try setting a ⎕TRAP on DOMAIN ERROR:
MSG←'''Please give a non-zero right arg'''
⎕TRAP←11 'E' MSG
When we enter:
10÷0
APL executes the expression, and notes that it causes an error number 11. Before issuing the standard error, it scans its ⎕TRAP table, to see if you were interested enough
in that error to set a trap; you were, so APL executes the action specified by you:
10÷0
Please give non-zero right arg
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Let's reset our ⎕TRAP:
⎕TRAP←0⍴⎕TRAP

⍝ No traps now set

and write a defined function to take the place of the primitive function ÷:
∇ R←A DIV B
[1]
R←A÷B
[2] ∇
Then run it:
10 DIV 0
DOMAIN ERROR
DIV[1] R←A÷B
^
Let's edit our function, and include a localised ⎕TRAP:
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[8]
[9]

∇ R←A DIV B;⎕TRAP
⍝ Set the trap
⎕TRAP←11 'E' '→ERR1'
⍝ Do the work; if it results in error 11,
⍝ execute the trap
R←A÷B
⍝ All OK if we got to here, so exit
→0
⍝ Will get here only if error 11 occurred
ERR1:'Please give a non-zero right arg'
∇

Running the function with good and bad arguments has the desired effect:
5

10 DIV 2

10 DIV 0
Please give a non-zero right arg
⎕TRAP is a variable like any other, and since it is localised in DIV, it is only effective in DIV and any other functions that may be called by DIV. So....
10÷0
DOMAIN ERROR
10÷0
^
still gives an error, since there is no trap set in the global environment.
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Other Errors
What happens to our function if we run it with other duff arguments:
1 2 3 DIV 4 5
LENGTH ERROR
DIV [4] R←A÷B
^
Here is an error that we have taken no account of.
Change DIV to take this new error into account:
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[8]
[9]
[10]
[11]

∇ R←A DIV B;⎕TRAP
⍝ Set the trap
⎕TRAP←(11 'E' '→ERR1')(5 'E' '→ERR2')
⍝ Do the work; if it results in error 11,
⍝ execute the trap
R←A ÷ B
⍝ All OK if we got to here, so exit
→0
⍝ Will get here only if error 11 occurred
ERR1:'Please give a non-zero right arg'⋄→0
⍝ Will get here only if error 5 occurred
ERR2:'Arguments must be same length'
∇
)RESET

1 2 3 DIV 4 5
Arguments must be the same length
But here's yet another problem that we didn't think of:
(2 3⍴⍳6) DIV (2 3 4⍴⍳24)
RANK ERROR
DIV [4] R←A÷B
^
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Global Traps
Often when we are writing a system, we can't think of everything that may go wrong
ahead of time; so we need a way of catching "everything else that I may not have
thought of". The error number used for "everything else" is zero:
)RESET
Set a global trap:
⎕TRAP ← 0 'E' ' ''Invalid arguments'' '
And run the function:
(2 3⍴⍳6) DIV (2 3 4⍴⍳24)
Invalid arguments
In this case, when APL executed line 4 of our function DIV, it encountered an error
number 4 (RANK ERROR). It searched the local trap table, found nothing relating to
error 4, so searched further up the stack to see if the error was mentioned anywhere
else. It found an entry with an associated Execute code, so executed the appropriate
action AT THE POINT THAT THE ERROR OCCURRED. Let's see what's in the
stack:
)SI
DIV[4]*
↑⎕DM
RANK ERROR
DIV[4] R←A÷B
^
So although our action has been taken, execution has stopped where it normally
would after a RANK ERROR.

Dangers
We must be careful when we set global traps; let's call the non-existent function
BUG whenever we get an unexpected error:
)RESET
⎕TRAP ← 0 'E' 'BUG'
(2 3⍴⍳6) DIV (2 3 4⍴⍳24)
Nothing happens, since APL traps a RANK ERROR on line 4 of DIV, so executes the
trap statement, which causes a VALUE ERROR, which activates the trap action,
which causes a VALUE ERROR, which .... etc. etc. If we had also chosen to trap on
1000 (ALL INTERRUPTS), then we'd be in trouble!
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Let's define a function BUG:
∇ BUG
[1] ⍝ Called whenever there is an unexpected error
[2]
'*** UNEXPECTED ERROR OCCURRED IN: ',⊃1↓⎕SI
[3]
'*** PLEASE CALL YOUR SYSTEM ADMINISTRATOR'
[4]
'*** WORKSPACE SAVED AS BUG.',⊃1↓⎕SI
[5]
⍝ Tidy up ... reset ⎕LX, untie files ... etc
[6]
⎕SAVE 'BUG.',⊃1↓⎕SI
[7]
'*** LOGGING YOU OFF THE SYSTEM'
[8]
⎕OFF
∇
Now, whenever we run our system and an unexpected error occurs, our BUG function
will be called.
10 DIV 0
Please give non-zero right arg
(2 3⍴⍳6) DIV (2 3 4⍴⍳12)
***
***
***
***

UNEXPECTED ERROR OCCURRED IN: DIV
PLEASE CALL YOUR SYSTEM ADMINISTRATOR'
WORKSPACE SAVED AS BUG.DIV
LOGGING YOU OFF THE SYSTEM'

The system administrator can then load BUG.DIV, look at the SI stack, discover the
problem, and fix it.

Looking out for Specific Problems
In many cases, you can of course achieve the same effect of a trap by using APL code
to detect the problem before it happens. Consider the function TIE∆FILE, which
checks to see if a file already exists before it tries to access it:
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[8]
[9]
[10]
[11]
[12]
[13]
[14]

∇ R←TIE∆FILE FILE;FILES
⍝ Tie file FILE with next available tie number
⍝
⍝ All files in my directory
FILES←⎕FLIB 'mydir'
⍝ Remove trailing blanks
FILES←dbr¨↓FILES
⍝ Required file in list?
→ERR×⍳~(⊂FILE)∊FILES
⍝ Tie file with next number
FILE ⎕FTIE R←1+⌈/0,⎕FNUMS
⍝ ... and exit
→0
⍝ Error message
ERR:R←'File does not exist'
∇
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This function executes the same code whether the file name is right or wrong, and it
could take a while to get all the file names in your directory. It would be neater, and
more efficient to take action ONLY when the file name is wrong:
∇
[1] ⍝
[2] ⍝
[3] ⍝
[4]
[5] ⍝
[6]
[7] ⍝
[8]
[9] ⍝
[10]

R←TIE∆FILE FILE;⎕TRAP
Tie file FILE with next available tie number
Set trap
⎕TRAP←22 'E' '→ERR'
Tie file with next number
FILE ⎕FTIE R←1+⌈/0,⎕FNUMS
... and exit if OK
→0
Error message
ERR:R←'File does not exist'

Cut-Back versus Execute
Let us consider the effect of using Cut-Back instead of Execute. Consider the system
illustrated below, in which the function REPORT gives the user the option of 4
reports to be generated:
REPORT
|
.-------------------------.
|
|
|
|
REP1
REP2
REP3
REP4
|
.----.----.
|
|
|
... DIV ...
where REPORT looks something like this:
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[8]
[9]
[10]
[11]
[12]
[13]
[14]
[15]
[16]

∇

⍝
⍝
⍝
⍝
⍝

REPORT;OPTIONS;OPTION;⎕TRAP
Driver functions for report sub-system. If an
unexpected error occurs, take action in the
function where the error occurred

Set global trap
⎕TRAP←0 'E' 'BUG'
⍝ Available options
OPTIONS←'REP1' 'REP2' 'REP3' 'REP4'
⍝ Ask user to choose
LOOP:→END×⍳0=⍴OPTION←MENU OPTIONS
⍝ Execute relevant function
⍎OPTION
⍝ Repeat until EXIT
→LOOP
⍝ Now end
END:
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Suppose the user chooses REP3, and an unexpected error occurs in DIV. The good
news is that the System Administrator gets a snapshot copy of the workspace that he
can play about with:
)LOAD BUG.DIV
saved ......

⍝ Load workspace

)SI
DIV[4]*
REP3[6]
⍎
REPORT[7]

⍝ Where did error occur?

↑⎕DM
RANK ERROR
DIV[4] R←A÷B
^
∇
[0]R←A DIV B
.........

⍝ What happened?

⍝ Edit function on top of stack

The bad news is, our user is locked out of the whole system, even though it may only
be REP3 that has a problem. We can get around this by making use of the CUTBACK action code.
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[8]
[9]
[10]
[11]
[12]
[13]
[14]
[15]
[16]
[17]
[18]
[19]
[20]
[21]
[22]
[23]
[24]

∇ REPORT;OPTIONS;OPTION;⎕TRAP
⍝ Driver functions for report sub-system. If an
⍝ unexpected error occurs, cut the stack back
⍝ to this function, then take action
⍝
⍝ Set global trap
⎕TRAP←0 'C' '→ERR'
⍝ Available options
OPTIONS←'REP1' 'REP2' 'REP3' 'REP4'
⍝ Ask user to choose
LOOP:→END×⍳0=⍴OPTION←MENU OPTIONS
⍝ Execute relevant function
⍎OPTION
⍝ Repeat until EXIT
→LOOP
⍝ Tell user ...
ERR:MESSAGE'Unexpected error in',OPTION
⍝ ... what's happening
MESSAGE'Removing from list'
⍝ Remove option from list
OPTIONS←OPTIONS~⊂OPTION
⍝ And repeat
→LOOP
⍝ End
END:
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Suppose the user runs this version of REPORT and chooses REP3. When the
unexpected error occurs in DIV, APL will check its trap specifications, and see that
the relevant trap was set in REPORT with a cut-back code. APL therefore cuts back
the stack to the function in which the trap was localised, THEN takes the specified
action. Looking at the SI stack above, we can see that APL must jump out of DIV,
then REP3, then ⍎, to return to line 7 of REPORT; THEN it takes the specified
action.

Signalling Events
It would be useful to be able to employ the idea of cutting back the stack and taking
an alternative route through the code, when a condition other than an APL error
occurs. To achieve this, we must be able to trap on errors other than APL errors, and
we must be able to define these errors to APL. We do the former by using error codes
in the range 500 to 999, and the latter by using ⎕SIGNAL.
Consider our system; ideally, when an unexpected error occurs, we want to save a
snapshot copy of our workspace (execute BUG in place), then immediately jump back
to REPORT and reduce our options. We can achieve this by changing our functions a
little, and using ⎕SIGNAL:
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[8]
[9]
[10]
[11]
[12]
[13]
[14]
[15]
[16]
[17]
[18]
[19]
[20]
[21]
[22]
[23]
[24]

∇ REPORT;OPTIONS;OPTION;⎕TRAP
⍝ Driver functions for report sub-system. If an
⍝ unexpected error occurs, make a snapshot copy
⍝ of the workspace, then cutback the stack to
⍝ this function, reduce the option list & resume
⍝ Set global trap
⎕TRAP←(500 'C' '→ERR')(0 'E' 'BUG')
⍝ Available options
OPTIONS←'REP1' 'REP2' 'REP3' 'REP4'
⍝ Ask user to choose
LOOP:→END×⍳0=⍴OPTION←MENU OPTIONS
⍝ Execute relevant function
⍎OPTION
⍝ Repeat until EXIT
→LOOP
⍝ Tell user ...
ERR:MESSAGE'Unexpected error in',OPTION
⍝ ... what's happening
MESSAGE'Removing from list'
⍝ Remove option from list
OPTIONS←OPTIONS~⊂OPTION
⍝ And repeat
→LOOP
⍝ End
END:
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∇ BUG
[1] ⍝ Called whenever there is an unexpected error
[2]
'*** UNEXPECTED ERROR OCCURRED IN: ',⊃1↓⎕SI
[3]
'*** PLEASE CALL YOUR SYSTEM ADMINISTRATOR'
[4]
'*** WORKSPACE SAVED AS BUG.',⊃1↓⎕SI
[5]
⍝ Tidy up ... reset ⎕LX, untie files ... etc
[6]
⎕SAVE 'BUG.',⊃1↓⎕SI
[7]
'*** RETURNING TO DRIVER FOR RESELECTION'
[8]
⎕SIGNAL 500
∇
Now when the unexpected error occurs, the first trap specification catches it, and the
BUG function is executed in place. Instead of logging the user off as before, an
error 500 is signalled to APL. APL checks its trap specifications, sees that 500
has been set in REPORT as a cut-back, so cuts back to REPORT before branching to
ERR.

Flow Control
Error handling, which employs a combination of all the system functions and variables described, allows us to dynamically alter the flow of control through our system, as well as allow us to handle errors gracefully. It is a very powerful facility,
which is simple to use, but is often neglected.
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Browse .Net Assembly dialog box 195
Build runtime application 40
C

.
.NET Classes
exploring 194
A
ActiveX control 46
ActiveXControl object 167
aedit User Command 97
APL files 273
APL fonts 268
APL_CODE_E_MAGNITUDE 11
APL_COMPLEX_AS_V12 12
APL_EXTERN_DECF 13
APL_FAST_FCHK 13
APL_FCREATE_PROPS_C 12
APL_FCREATE_PROPS_J 12
aplcore 14, 17, 54
aplcorename parameter 14, 54
aplk parameter 14, 133
aplkeys parameter 14, 133
aplnid parameter 14, 275
APLScript compiler 42-43
aplt parameter 15, 134
apltrans parameter 15, 134
aplunicd.ini 47-48
Array Editor 33, 97, 122
assemblies
exploring 194
auto_pw parameter 15, 92, 142
AutoComplete 90
registry entries 31
AutoFormat parameter 15, 147
AutoIndent parameter 15, 147
auxiliary processors 35
B
bridge dll 42-45, 47

CancelKey (AutoComplete) parameter 150
charts
registry entries 31
class constructor 198
Classes
browsing 178
Classic Dyalog mode 241
multiple trace windows 249
single trace window 250
Classic Edition 10, 14, 23, 28, 109, 115, 125
ClassicMode parameter 16, 18-19, 26-27, 146,
215
CloseAll system operation 110
CMD_POSTFIX parameter 16
CMD_PREFIX parameter 16
collapsing outlines 223, 228, 233
colour selection dialog 157
colours
registry entries 31
colourscheme parameter 128
Cols (AutoComplete) parameter 150
COM server
in-process 45
out-of-process 45
command line 8
command processor 35-36
CommandFolder parameter 153
CommonKey (AuotComplete) parameter 150
CompleteKey (AutoComplete) parameter 150
component files 274
access control 275
buffering 288
file design 285
internal structure 285
multi-user access 282
configuration dialog 127
.net framework tab 156
autocomplete tab 149
general tab 127
help/dmx tab 137
input tab 133
keyboard shortcuts tab 135
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log tab 143
object syntax tab 154
output tab 134
session tab 141
trace/edit tab 145
unicode input tab 130
user commands tab 153
windows tab 138
workspace tab 136
configuration parameters 9
configuring the session 267
confirm_abort parameter 16, 147
confirm_close parameter 16, 146
confirm_fix parameter 16, 146
confirm_session_delete parameter 16
Constructors folder 198
context menu 88
COPY system command 55
Create (session event) 264
Create bound file dialog 107
CreateAplcoreOnSyserror parameter 17
CreateAplCoreonSyserror parameter 58
creating executables 38
CurObj (session property) 65, 265
CurPos (session property) 265
Current Object 65
CurSpace (session property) 265
D
Debugging Threads 254
default_div parameter 17, 142
default_io parameter 17, 142
default_ml parameter 17, 142
default_pp parameter 17, 142
default_pw parameter 18
default_rl parameter 18, 142
default_rtl parameter 18, 142
default_wx parameter 18, 114, 142, 155
DefaultHelpCollection parameter 17, 137
delay parameter 128
division method 17
DMXOUTPUTONERROR parameter 18, 137
DockableEditWindows parameter 18, 146
Docking 83
DoubleClickEdit parameter 18, 147

Dyalog APL DLL 51
classes, instances and cloning 51
workspace management 52
dyalog dll 42-43
dyalog parameter 10, 14, 19
dyalog.chm 19
dyalog.exe.config 156
dyalog32 dll 49
DyalogEmailAddress parameter 19
DyalogHelpDir parameter 19
DyalogInstallDir parameter 19
dyalognet dll 42-45, 47
dyalogprovider dll 42-43
DyalogWebSite parameter 19
E
edit window geometry 19
edit_cols parameter 19, 139, 212, 215
edit_first_x parameter 19, 215
edit_first_y parameter 19, 139, 215
edit_offset_x parameter 20, 139, 212, 216
edit_offset_y parameter 20, 139, 212, 216
edit_rows parameter 19, 139, 212, 215
editor
class treeview 223, 234
collapsing outlines 223
edit menu 220
editing classes 232
expanding outlines 223
file menu 218-219
function line numbers 223
invoking 211
outlining 223, 227
refactor menu 222
sections 235
toolbar 217
using 225
view menu 222
windows menu 224
EditorState parameter 20
Enabled (AutoComplete) parameter 149
endsection statement 229, 235
Enums 193
environment variables 9-10
ErrorOnExternalException parameter 20
Event (session property) 266
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Event Sets 192
event viewer
registry entries 31
executing expressions 91
execution (tracing) 247
exit codes 9, 14
expanding outlines 223, 228, 233
Export menu item 38
external variables
sharing 37
F
fchk system function 289
File (session property) 266
file extensions 1
file_stack_size parameter 128
files
registry entries 32
find and replace dialogs 238
Find Objects Tool 202
Font (session property) 266
function line numbers 223

InitialKeyboardLayout 21
InitialKeyboardLayout parameter 131
InitialKeyboardLayoutInUse parameter 21,
131
InitialKeyboardLayoutShowAll parameter 21,
131
Input (session property) 265
input codes 76
input line 89
input translate table 14
input_size parameter 21, 144
interface with Windows 35
Interoperability 4
interrupt 66
K
keyboard layout
line-drawing 74
traditional 73
unified 71
keyboard shortcuts 63, 75
registry entries 33
KeyboardInputDelay parameter 149

G
GetEnvironment method 10
global assembly cache 44-45, 47
greet_bitmap parameter 20

L

Handle (session property) 265
HintObj (session property) 266
History (AutoComplete) parameter 150
history_size parameter 20, 144
HistorySize (AutoComplete) parameter 150
hot keys
syntax colouring 159

language bar 90
registry entries 33
line-drawing characters 74
line numbers 223, 225
lines_on_functions parameter 22, 128
localdyalogdir parameter 22
Log (session property) 265
log_file parameter 144
log_file_inuse parameter 144
log_size parameter 22, 144
logfile parameter 22
logfileinuse parameter 22

I

M

ILDASM 194
IME Configuration 67
index origin 17
inifile parameter 10, 21, 128

mapchars parameter 23
maxws parameter 23, 34, 52-53, 136
Metadata 194, 196
Methods folder 200

H
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Microsoft Document Explorer 17
migration level 17
mouse
using in session 64

Properties folder 199
PropertyExposeRoot parameter 24, 114, 155
PropertyExposeSE parameter 25, 114, 155
Q

N
Net asembly 46
Net Classes 194
Net Metadata 183
New method 198

qcmd_timeout parameter 25
QUADNA workspace 49
R

Object CoClasses 187
Object Properties
COM Properties tab 209
Monitor tab 208
Net Properties tab 210
Properties tab 206
Value tab 207
Objects 189
OLEClient object 183, 186
OLEServer object 167
outlining 223, 227
output translate table 15
OverstrikesPopup parameter 24, 132

random link 18
registry entries
run-time installation 49
ResolveOverstrikes parameter 25, 132
response time limit 18
return code 9
Rows (AutoComplete) parameter 149
run-time
applications 42
bound 44
stand-alone 43
workspace based 44
run-time applications 40
run-time dll 42-44, 46-47
run-time exe 42-45, 49
RunAsService parameter 25

P

S

page width 18, 92
PassExceptionsToOpSys parameter 24, 58
pfkey_size parameter 24, 144
Popup (session property) 266
Posn (session property) 266
PrefixSize (AutoComplete) parameter 149
print configuration dialog 160
header/footer Tab 163
margins tab 162
printer tab 166
setup tab 160
print precision 17
printing
registry entries 33
private 198
programfolder parameter 24

SALT 151
registry entries 33
SaveContinueOnExit parameter 25
SaveLogOnExit parameter 25
SaveSessionOnExit parameter 25
section statement 229, 235
Serial parameter 26
session
configuring 63, 267
file menu 104
help menu 117
options menu 114
popup menu 118
session menu 111
status bar 125
status field styles 125

O
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threads menu 116
tools menu 115
value tips 93
session action menu 112
session colour scheme 80
session log 82, 89
session log menu 112
session menubar 104
action menu 112
edit menu 109
file Menu 104
help menu 117
log menu 112
options menu 114
session menu 111
threads menu 116
tools menu 115
view menu 110
windows menu 110
session object 26, 63, 82, 111
session statusfields 126
session toolbars 120
edit tools 123
object tools 122
session tools 124
tools tools 123
workspace tools 121
session_file parameter 26, 64, 82, 142, 264
SessionOnTop parameter 26, 146
SharpPlot Graphics Tools 100
Show trace stack on error 240
ShowFiles (AutoComplete) parameter 150
ShowStatusOnError parameter 26
SingleTrace parameter 26-27, 146
Size (session property) 266
sm_cols parameter 26, 140
sm_rows parameter 26, 140
SPICE 151, 272
sqapl.dll 47-48
sqapl.err 47-48
sqapl.ini 47-48
State (session property) 267
Status window 83, 167
StatusOnEdit parameter 26, 146
syntax colouring 158
system error codes 55
system error dialog 24, 54, 56
system exceptions 55
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system operations 64, 111, 269
T
TabStops parameter 15, 26, 147
Threads Tool 251
TipObj (session property) 267
trace tools 243
trace window geometry 27
trace_cols parameter 27
trace_first_x parameter 27, 139
trace_first_y parameter 27, 139
Trace_level_warn parameter 27, 146
trace_offset_x parameter 27, 139
trace_offset_y parameter 27, 139
Trace_on_error parameter 27, 146, 240
trace_rows parameter 27
tracer
automatic trace 240
break-points 248
Classic Dyalog mode 241
controlling execution 247
invoking 240
naked trace 240
tracing an expression 240
TraceStopMonitor parameter 28
trap control structure 293
trap system variable 295
treeview 223, 234
Type Libraries 175, 183
U
underscored characters 71
Unicode and Classic Editions 2
Unicode Edition 10, 21, 24-25, 28, 125
UnicodeToClipboard parameter 28, 147
URLHighlight parameter 128
UseDefaultHelpCollection parameter 28, 137
User Commands 272
aedit 97
UTIL workspace 37
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V
value tips 93
colourscheme parameter 128
delay parameter 128
registry entries 33
valuetips
registry entries 33
Version
binding version information 108
Version information
for a bound executable 41
view menu
editor 222
session) 110
W
WantsSpecialKeys parameter 28
window expose 18, 155
windowrects
registryentries 33
workspace explorer
registry entries 31
workspace integrity check 54
workspace size 23, 34, 52
WorkspaceLoaded (session event) 264
wspath parameter 28, 36, 49, 136
X
XPLookAndFeel parameter 28, 128
XPLookAndFeelDocker parameter 29, 128
XVAR function 37
Y
year 2000 compliance 29
yy_window parameter 29
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